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Glossary

The following definitions apply specifically to printers.

automatic roll paper cutter
The built-in paper cutter, which automatically cuts images printed continuously 
on roll paper.

Background Printing
When background printing is on, the computer can be used for other operations 
while printing a document. When it is off, the computer will suspend all other 
operations while printing a document, but print data will be sent to the printer 
more quickly.

banding
The horizontal lines that sometimes appear when printing graphics. See also 
“MicroWeave”.

Bluetooth
A wireless technology that enables different devices to communicate without the 
need for cable connections.

Borderless printing
A printing mode that allows you to print without margins on all four sides of the 
paper.

brightness
The lightness or darkness of an image.

CMYK
Cyan (blue-green), magenta, yellow, and black. These colored inks are used to 
create the printed colors in the subtractive system.

Collate
A setting that has the printer print copies of multiple-page documents in 
complete sets rather than print copies of the document page by page.

color matching
Generic term for methods of processing color data so that colors displayed on a 
computer screen closely match colors in printouts. A variety of color-matching 
software or systems are used for different occasions. See also “ColorSync” and 
“ICM (Image Color Matching)”.
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ColorSync
Macintosh software that is designed to help you achieve the color matching. See 
also “color matching”.

Contrast
A setting that maximizes or minimizes the difference between the bright and dark 
parts of an image.

default
A value or setting that takes effect when the equipment is turned on, reset, or 
initialized.

DMA
Direct Memory Access. A data transfer feature that bypasses a computer’s CPU 
and allows direct communication between a computer and peripheral devices 
(like printers), and between one peripheral device and another.

Double-Sided Printing
A printing mode that allows you to print on both sides of the paper.

dpi
Dots per inch. The dpi measures the resolution. See also “resolution”.

drive
A memory device, such as a hard disk, CD-ROM, or floppy disk drive. In 
Windows, a letter is assigned to each drive for easy management.

driver
Software that sends instructions to a computer peripheral to tell it what to do. 
For example, your printer driver accepts print data from your word processor 
application and sends instructions to the printer on how to print this data. 
Together, the printer driver and printer utilities are referred to as "printer 
software". See also “printer software”.

economy printing
Printing in which images are printed with fewer dots to save ink.

Edge Smoothing
Improves the print quality of low-resolution images by smoothing jagged edges 
and lines. This setting has no effect on high-resolution images or on text.

EPSON MonitorIV
A utility for Macintosh that allows you to manage print jobs that are in a print 
queue. This utility also shows the status of the job currently being printed. (See 
“print queue”)
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EPSON StatusMonitor
A utility for Macintosh that monitors the printer status. If the StatusMonitor 
detects a printer error, it will inform you with an error message.

EPSON Status Monitor 3
A utility for Windows that provides printer status information, such as the 
amount of ink remaining, and checks for printer errors.

Finest Detail
This printer software setting automatically makes your printouts sharper and 
clearer, especially for text. Be aware that this may increase the time required for 
printing.

Fit to Page printing
A printing mode that automatically enlarges or reduces the size of your 
document to fit the paper size selected in the printer software.

font
A set of type characters of one style and size.

Gamma
A setting that controls image contrast by modifying the mid-tones and mid-level 
grays.

grayscale
A scale of shades of gray from black to white. Grayscale is used to represent colors 
when printing with black ink only.

Head Cleaning utility
A utility that cleans the print head, allowing the print head nozzles to deliver ink 
properly.

high speed printing
Printing in which the print head prints images in both directions as it moves back 
and forth. This provides faster printing.

ICM (Image Color Matching)
The color matching method used by Windows. See also “color matching”

ink cartridge
Contains the ink that your printer uses to print.

ink jet
A method of printing in which each letter or symbol is formed by precisely 
spraying ink onto paper.
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Ink Levels
A graphic display of the amount of ink remaining in each cartridge.

interface
The connection between the computer and the printer. See also “parallel interface” 
and “USB interface”.

interface cable
The cable that connects the computer to the printer.

local printer
The printer connected to the computer’s port directly by an interface cable.

margins
The space around the edge of the paper outside of the printable area. See also 
“printable area”

media
Materials upon which data is printed, such as plain paper, envelopes, special 
paper, and transparency film.

MicroWeave
Printing in which images are printed in finer increments to reduce the possibility 
of banding. See also “banding”.

Mirror Image
This printer software setting flips your printout, left to right. 

monochrome
Printing which uses only one color of ink, usually black.

Nozzle Check utility
A utility that checks the print head nozzles to see if they are clogged and need to 
be cleaned.

nozzles
Fine tubes in the print head through which ink is sprayed onto the page. Print 
quality may decline if the print head nozzles are clogged.

operation check
A method for checking the operation of the printer. When you perform a printer 
operation check, the printer prints some information codes followed by a nozzle 
check pattern.
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Orientation
Settings that determine the orientation of your printout. Select between Portrait 
(tall) or Landscape (wide).

Pages Per Sheet printing
A printing mode that allows you to print two or four pages on a single sheet of 
paper.

parallel interface
An interface that is used for one-to-one connection between a computer and a 
printer. See also “interface”.

PhotoEnhance
A printing mode that provides a variety of image correction settings that you can 
apply to your photos before printing.

port
An interface channel through which data is transmitted between devices.

Poster Printing
A printing mode that allows you to enlarge a single document page to cover 4, 
9, or 16 printed sheets of paper and put them together to make a poster.

printable area
The area of a page on which the printer can print. It is smaller than the physical 
size of the page due to margins.

printer driver
See “driver”.

printer software
The printer software which comes with your printer includes a printer driver and 
printer utilities. The printer driver lets you choose from a wide variety of settings 
to get the best results from your printer. The printer utilities help you check the 
printer and keep it in top operating condition. See also “driver” and “utilities”.

printer utilities
See “utilities”.

Print Head Alignment utility
A utility that aligns the print head so images will print clearly. Used when printed 
images are blurry, or when misaligned vertical lines or horizontal bands appear 
in the printout.
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PRINT Image Matching
This system enables stunning printing to be achieved easily through the 
combination of a digital camera loaded with the PRINT Image Matching function 
and a printer that supports such matching. Print commands are attached to photo 
data during digital camera photography and the printer adheres to these 
commands to print photos with the color match that optimally fulfills the 
objectives of the digitally composed shots.

Print Preview
A setting that allows you to see how your document will look before actually 
printing it.

print queue
A waiting line in which print jobs that are sent to the printer via network are 
stored until they can be printed.

Profiles
Standards that allow different devices to operate with one another using 
Bluetooth wireless technology. Profiles are defined by the uses and features they 
allow devices to perform, such as printing or scanning from a computer. To share 
this information, the devices must be compatible with the same profile.

Quality Type settings
A number of print quality settings that are available in the printer software.

Reduce/Enlarge Document
A printing mode that adjusts the printed size of your document.

reset
To return a printer to its defaults by turning the printer off and then quickly back 
on.

resolution
The number of dots used to represent an image, expressed as (horizontal dots) ×  
(vertical dots).

Reverse Order
A setting that allows you to print your documents in reverse order, starting with 
the last page.

RGB
Red, green, and blue. These colors, in phosphors irradiated by a cathode ray tube 
(CRT) monitor's electron gun, creates the screen colors with additive mixture.

Rotate 180°
A setting that rotates the page to be printed 180 degrees.
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Saturation
A setting that modifies the vividness of color. The lower the saturation, the duller 
the colors. The higher the saturation, the more vivid the colors.

spool
The first step in printing, in which the printer software converts the print data 
into codes that your printer understands. This data is then sent directly to the 
printer or to the print server.

spool manager
The software that converts print data into codes that your printer understands. 
See also “spool”.

sRGB
The color management method used to maintain color consistency between 
devices which adhere to the sRGB standard.

Status Monitor
The software that allows you to check the printer’s status.

USB interface
Universal Serial Bus interface. Enables the user to connect up to 127 peripheral 
devices (such as keyboards, pointing devices, and printers) to the computer 
through a single, general-purpose port. USB hubs allow you to add additional 
ports. See also “interface”.

utilities
Software that allows you to monitor and maintain your printer. Together, utilities 
and the printer driver are referred to as "printer software". See also “printer 
software”.

Watermark printing
A printing mode that allows you to print text or an image as a watermark on your 
printout.
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How to Print

Introduction

This section guides you through the procedures for different 
kinds of printing.

“Printing Text and Web Pages”

Explains how to print documents and images on various sizes or 
kinds of single-sheet paper.
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“Printing Photos”

Explains how to print photos on various sizes or kinds of 
single-sheet paper.

“Printing on Envelopes”

Explains how to print on envelopes.
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Printing Text and Web Pages

Handling single sheets of paper

Refer to the section below for details on loading single sheets of 
paper.

“Loading Single Sheets of Paper”

When using special media, refer to the section below.

“Using Special Media”

Driver settings for Windows

1. Open the file you want to print.

2. Access the printer driver.

“Accessing the Printer Software for Windows”
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3. Click the Main tab, then make the Quality Option setting. See 
the following section for details on the Quality Option 
settings.
& See “Quality Option”

4. Make the appropriate Type setting.

“Media Type Settings”

5. Make the appropriate Size setting. You can also define a 
custom paper size. For details, see the following section.

“Making User Defined Paper Sizes for Windows”

6. Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.

7. Click OK to close the printer driver settings dialog box.

8. Print your data.
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Driver settings for Mac OS 8.6 to 9.x

1. Open the file you want to print.

2. Access the Page Setup dialog box.

“Accessing the Printer Software for Mac OS 8.6 to 9.x”

3. Make the appropriate Paper Size setting. You can also define 
a custom paper size. For details, see the following section.

“Making User Defined Paper Sizes for Mac OS 8.6 to 9.x”

4. Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.

5. Click OK to save the settings and close the Page Setup dialog 
box.

6. Access the Print dialog box.

“Accessing the Printer Software for Mac OS 8.6 to 9.x”

7. Make the appropriate Media Type setting.

“Media Type Settings”
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8. Click Print to start printing.

Driver settings for Mac OS X

1. Open the file you want to print.

2. Access the Page Setup dialog box.

“Accessing the Printer Software for Mac OS X”

3. Make the appropriate Format for setting. When printing with 
standard margins, select Stylus C84.

4. Make the appropriate Paper Size and Orientation settings.

5. Click OK to close the Page Setup dialog box.
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6. Access the Print dialog box.

“Accessing the Printer Software for Mac OS X”

7. Make the Printer setting so that it matches the Format for 
setting you made in the Page Setup dialog box in step 3. Then 
make the Copies & Pages settings.

Note:
❏ Always match the Format for setting in the Page Setup dialog 

box and the Printer setting in the Print dialog box. Otherwise 
the data may not be printed correctly.

❏ The Copies & Pages settings available are a standard feature of 
Mac OS X. See your operating system’s documentation for 
details.

8. Select Print Settings from the pop-up menu.

9. Make the appropriate Media Type, Color, and Mode settings.
& See “Print Settings”

“Media Type Settings”
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10. Click Print to start printing.

Printing Photos

Handling single sheets of paper

Refer to the section below for details on loading single sheets of 
paper.
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“Loading Single Sheets of Paper”

When using special media, refer to the section below.

“Using Special Media”

Driver settings for Windows

1. Open the file you want to print.

2. Access the printer driver.

“Accessing the Printer Software for Windows”

3. Click the Main tab, then make the Quality Option setting. See 
the following section for details on the Quality Option 
settings.
& See “Quality Option”

4. Make the appropriate Type setting.

“Media Type Settings”

5. Make the appropriate Size setting. You can also define a 
custom paper size. For details, see the following section.

“Making User Defined Paper Sizes for Windows”
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6. Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.

7. Click OK to close the printer driver settings dialog box.

8. Print your data.

Driver settings for Mac OS 8.6 to 9.x

1. Open the file you want to print.

2. Access the Page Setup dialog box.

“Accessing the Printer Software for Mac OS 8.6 to 9.x”

3. Make the appropriate Paper Size setting. You can also define 
a custom paper size. For details, see the following section.

“Making User Defined Paper Sizes for Mac OS 8.6 to 9.x”
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4. Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.

5. Click OK to save the settings and close the Page Setup dialog 
box.

6. Access the Print dialog box.

“Accessing the Printer Software for Mac OS 8.6 to 9.x”

7. Make the appropriate Media Type setting.

“Media Type Settings”

8. Click Print to start printing.

Driver settings for Mac OS X

1. Open the file you want to print.
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2. Access the Page Setup dialog box.

“Accessing the Printer Software for Mac OS X”

3. Make the appropriate Format for setting. When printing with 
standard margins, select Stylus C84.

4. Make the appropriate Paper Size and Orientation settings.

5. Click OK to close the Page Setup dialog box.

6. Access the Print dialog box.

“Accessing the Printer Software for Mac OS X”

7. Make the Printer setting so that it matches the Format for 
setting you made in the Page Setup dialog box in step 3. Then 
make the Copies & Pages settings.

Note:
❏ Always match the Format for setting in the Page Setup dialog 

box and the Printer setting in the Print dialog box. Otherwise 
the data may not be printed correctly.
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❏ The Copies & Pages settings available are a standard feature of 
Mac OS X. See your operating system’s documentation for 
details.

8. Select Print Settings from the pop-up menu.

9. Make the appropriate Media Type, Color, and Mode settings.
& See “Print Settings”

“Media Type Settings”
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10. Click Print to start printing.

Printing on Envelopes

Handling envelopes

Refer to the section below for loading envelopes.

“Loading Envelopes”
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Refer to the section below for the printable area.
& See “Printable area”

Driver settings for Windows

1. Access the printer driver.

“Accessing the Printer Software for Windows”

2. Click the Main tab, then make the Quality Option setting. See 
the following section for details on the Quality Option 
settings.
& See “Quality Option”

3. Select Plain Paper / Bright White Paper as the Type setting.

4. Select the appropriate envelope size from the available Size 
settings. You can also define a custom paper size. For details, 
see the following section.

“Making User Defined Paper Sizes for Windows”
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5. Select Landscape as the Orientation setting.

6. Click OK to close the printer driver settings dialog box.

7. Print your data.

Note:
The Economy setting that is offered under Paper & Quality 
Options in the Advanced menu is not enabled when printing 
envelopes.

Driver settings for Mac OS 8.6 to 9.x

1. Access the Page Setup dialog box.

“Accessing the Printer Software for Mac OS 8.6 to 9.x”

2. Select the appropriate envelope size from the available Paper 
Size settings. You can also define a custom paper size. For 
details, see the following section.
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“Making User Defined Paper Sizes for Mac OS 8.6 to 9.x”

3. Select Landscape as the Orientation setting.

4. Click OK to save the settings and close the Page Setup dialog 
box.

5. Access the Print dialog box.

“Accessing the Printer Software for Mac OS 8.6 to 9.x”

6. Select Plain Paper/Bright White Paper as the Media Type 
setting.

7. Click Print to start printing.
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Note:
The Economy Custom mode and the Economy setting that is 
offered under Print Quality in the Advanced dialog box are not 
enabled when printing envelopes.

Driver settings for Mac OS X

1. Access the Page Setup dialog box.

“Accessing the Printer Software for Mac OS X”

2. Select Stylus C84 as the Format for setting.

3. Select the appropriate envelope size as the Paper Size setting.

4. Select Landscape as the Orientation setting.

5. Click OK to close the Page Setup dialog box.

6. Access the Print dialog box.

“Accessing the Printer Software for Mac OS X”

7. Select Stylus C84 as the Printer setting, then make the Copies 
& Pages settings.
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Note:
❏ Always match the Format for setting in the Page Setup dialog 

box and the Printer setting in the Print dialog box. Otherwise 
the data may not be printed correctly.

❏ The Copies & Pages settings available are a standard feature of 
Mac OS X. See your operating system’s documentation for 
details.

8. Select Print Settings from the pop-up menu.

9. Select Plain Paper/Bright White Paper as the Media Type 
setting, then make the appropriate Color and Mode settings.
& See “Print Settings”
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10. Click Print to start printing.
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Various Printing Options

Introduction to Various Printing Options

This printer provides you with a variety of different printing 
options. You can print in various formats, and you can print using 
many different types of paper.

The sections that follow the introduction explain procedures for 
each type of printing. Click the title of each printing option to see 
more details.

“Borderless Printing”

Lets you print without margins on all four sides of the paper.

“Double-Sided Printing”

Lets you print on both sides of the paper.
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Note:
This feature is not available with Mac OS X.

“Fit to Page Printing”

Lets you automatically enlarge or reduce the size of your 
document to fit the paper size selected in the printer software.

Note:
This feature is not available with Mac OS X.
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“Pages Per Sheet Printing”

Lets you print two or four pages on a single sheet of paper.

“Poster Printing”

Lets you enlarge material on a single document page to cover 4, 
9, or 16 printed sheets of paper, and then make a poster.

Note:
This feature is not available with Mac OS X.

“Watermark Printing”

Lets you print text or an image as a watermark on your printout.

Note:
This feature is not available with Mac OS X.
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For example, you can put “Confidential” on an important 
document.

Borderless Printing

This printer allows you to print without margins on all four sides 
of the paper. Follow the steps described below for Borderless 
printing.
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Note:
❏ Using EPSON PhotoQuicker included on the CD-ROM is the 

easiest and quickest way to create borderless photos with this printer. 
EPSON PhotoQuicker also includes a number of features that help 
you create outstanding photos. For more details, double-click the 
ESC84 Software Guide icon on the desktop to view Photo Print 
Software Setup.

❏ EPSON PhotoQuicker is not available for Windows NT 4.0 or Mac 
OS X.

❏ This feature is not available for all media and driver settings.

Compatible media

You can use the following media with this feature:

Note:
❏ Printing with this feature takes longer than with normal printing.

❏ Print quality may decline in the top and bottom areas of the printout, 
or the area may be smeared when printing on media other than those 
listed above. Print a single sheet to check the quality before printing 
large jobs.

DURABrite Photo Paper A4, 100 ×  150 mm

DURABrite Ink Glossy Photo Paper Letter, 4 ×  6"

Photo Paper A4, Letter, 4 ×  6", 100 ×  150 mm

Matte Paper - Heavyweight A4, Letter, 8 ×  10"

Premium Semigloss Photo Paper A4, Letter
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Preparing the print data

Because this option enlarges the image to a size slightly larger 
than the paper size, the portion of the image that extends beyond 
the edges of the paper will not be printed.

When creating data in an application for print, you need to adjust 
the data to the size of the paper. If your application has margin 
settings, make sure they are set to zero before printing.

Loading paper

After you have selected the media, load it into the printer. Refer 
to the following section for details.

“Loading Single Sheets of Paper”

Driver settings for Windows

After you have loaded the media, change your printer driver 
settings for Borderless printing.

1. Access the printer driver.

“Accessing the Printer Software for Windows”

2. Click the Main tab, then make the Quality Option setting. See 
the following section for details on the Quality Option 
settings.
& See “Quality Option”

3. Select the Borderless check box.

4. Make the appropriate Type setting.

“Media Type Settings”
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5. Make the appropriate Size setting.

6. Click OK to close the printer driver settings dialog box.

After finishing all steps above, start printing. Print one test copy 
and examine the results before printing an entire job.

Note:
You can control the amount of the image that extends beyond the edges 
of the paper during borderless printing. When the Borderless check box 
is selected on the Main menu, the Borderless Expansion slider 
becomes available on the Page Layout menu.

Driver settings for Mac OS 8.6 to 9.x

After you have loaded the media, change your printer driver 
settings for Borderless printing.

1. Access the Page Setup dialog box.
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“Accessing the Printer Software for Mac OS 8.6 to 9.x”

2. Make the appropriate Paper Size setting.

3. Select the Borderless check box.

4. Click OK to save the settings and close the Page Setup dialog 
box.

5. Access the Print dialog box.

“Accessing the Printer Software for Mac OS 8.6 to 9.x”

6. Make the appropriate Media Type setting.

“Media Type Settings”

7. Click Print to start printing.

Note:
❏ Print one test copy and examine the results before printing an entire 

job.
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❏ You can control the amount of the image that extends beyond the 
edges of the paper during borderless printing. When the Borderless 
check box is selected on the Page Setup dialog box, the Borderless 
Expansion slider becomes available.

Driver settings for Mac OS X

After you have loaded the media, change your printer driver 
settings for Borderless printing.

1. Access the Page Setup dialog box.

“Accessing the Printer Software for Mac OS X”

2. Select Stylus C84 (Sheet Feeder - Borderless) as the Format 
for setting.

3. Make the appropriate Paper Size and Orientation settings.
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4. Click OK to close the Page Setup dialog box.

5. Access the Print dialog box.

“Accessing the Printer Software for Mac OS X”

6. Select Stylus C84 (Sheet Feeder - Borderless) as the Print 
setting, then make the Copies & Pages settings.

Note:
❏ The Copies & Pages settings available are a standard feature of 

Mac OS X. See your operating system’s documentation for 
details.
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❏ Always match the Format for setting in the Page Setup dialog 
box and the Printer setting in the Print dialog box. Otherwise 
the data may not be printed correctly.

7. Select Print Settings from the pop-up menu.

8. Make the appropriate Media Type, Color, and Mode settings.
& See “Print Settings”

“Media Type Settings”

9. Click Print to start printing.

Note:
❏ Print one test copy and examine the results before printing an entire 

job.

❏ You can control the amount of the image that extends beyond the 
edges of the paper during borderless printing.
& See “Expansion”
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Double-Sided Printing

There are two types of double-sided printing available. Standard 
double-sided printing allows you to print the odd-numbered 
pages first. Once these pages are printed, they can be reloaded to 
print the even-numbered pages onto the opposite side of the 
paper.

Folded Booklet double-sided printing allows you to make 
single-fold booklets. To create it, the pages that appear on the 
outside (after the page is folded) are printed first. The pages that 
will appear inside the booklet can then be printed after the paper 
is reloaded into the printer as shown in the illustration below.
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✽: Binding edge

A booklet can be created by printing pages 1 and 4 on the first 
sheet of paper, pages 5 and 8 on the second sheet of paper, and 
pages 9 and 12 on the third sheet of paper. After these sheets are 
reloaded into the sheet feeder, you can then print pages 2 and 3 
on the back of the first sheet of paper, pages 6 and 7 on the back 
of the second sheet of paper, and pages 10 and 11 on the back of 
the third sheet of paper. The resulting pages can then be folded 
and bound together into a booklet.

Note:
❏ This feature is not available with Mac OS X.

❏ This feature is not available when selecting the Borderless check 
box on the Main menu (Windows) or in the Page Setup dialog box 
(Macintosh).

❏ This feature is not available when the printer is accessed over a 
network or is used as a shared printer.

Single-fold booklet
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❏ Depending on the media type, stacks of up to 30 sheets can be loaded 
into the sheet feeder during double-sided printing.

❏ Only use media types that are suitable for double-sided printing. 
Otherwise, the printout quality may deteriorate.

❏ Depending on the media type and the amount of ink used to print 
text and images, ink may bleed through to the other side of the paper.

❏ The surface of the paper may be smeared during double-sided 
printing.

Standard double-sided printing for Windows

Follow the steps below to print odd- and even-numbered pages 
onto opposite sides of the sheet.

1. Access the printer driver.

“Accessing the Printer Software for Windows”

2. Click the Main tab, then make the Quality Option setting. See 
the following section for details on the Quality Option 
settings.
& See “Quality Option”

3. Make the appropriate Type setting.

“Media Type Settings”
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4. Make the appropriate Size setting.

5. Click the Page Layout tab, then select the Double-Sided 
Printing check box.

6. Click Margins to open the Margins dialog box.
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7. Specify the edge of the paper where the binding will be 
placed. You can choose Left, Top, or Right.

8. Choose cm or inch as the Unit setting. Then, specify the width 
of the binding margin. You can enter any width from 3 mm 
to 30 mm, or from 0.12 inches to 1.18 inches.

Note:
The actual binding margin may be different from the specified 
settings depending on your application. Experiment with a few 
sheets to examine actual results before printing the entire job.

9. Click OK to return to the Page Layout menu. Then, click OK 
to save your settings.

10. Load paper into the sheet feeder, then send the print job from 
your application. Instructions for generating the 
even-numbered pages will be displayed while the 
odd-numbered pages are printed.

“Loading Single Sheets of Paper”
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11. Follow the on-screen instructions to reload the paper.

Note:
❏ The paper may curl during printing due to the amount of ink 

used. Should this occur, slightly curl the sheets in the opposite 
direction before reloading them into the printer.

❏ Align the sheet stack by tapping its edges against a hard, flat 
surface before reloading the stack into the printer.

❏ Follow the instructions provided when reloading the printouts. 
Paper jams or improperly placed binding margins may occur if 
the printouts are not reloaded correctly. 

❏ If a paper jam occurs, refer to the following.
& See “Paper Does Not Feed Correctly”

12. Once the paper is reloaded, click Resume to print the 
even-numbered pages.

Standard double-sided printing for Macintosh

Follow the steps below to print odd- and even-numbered pages 
onto opposite sides of the sheet.

1. Access the Page Setup dialog box.
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“Accessing the Printer Software for Mac OS 8.6 to 9.x”

2. Make the appropriate Paper Size setting.

3. Select the Double-Sided Printing check box.

4. Click Margins.

5. Specify the edge of the paper where the binding will be 
placed. You can choose Left, Top, or Right.

6. Specify the width of the binding margin in the text box. You 
can enter any width from 0.12 inch to 1.18 inch or from 0.3 cm 
to 3.0 cm.

Note:
The actual binding margin may be different from the specified 
settings depending on your application. Experiment with a few 
sheets to examine actual results before printing the entire job.
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7. Click OK to return to the Page Setup dialog box. Then, click 
OK to save your settings and close the dialog box.

8. Access the Print dialog box.

“Accessing the Printer Software for Mac OS 8.6 to 9.x”

9. Make the appropriate Media Type setting.

“Media Type Settings”

10. Load paper into the sheet feeder, then click Print to start 
printing. Instructions for generating the even-numbered 
pages will be displayed while the odd-numbered pages are 
printed.

“Loading Single Sheets of Paper”
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11. Follow the on-screen instructions to reload the paper.

Note:
❏ The paper may curl during printing due to the amount of ink 

used. Should this occur, slightly curl the sheets in the opposite 
direction before reloading them into the printer.

❏ Align the sheet stack by tapping its edges against a hard, flat 
surface before reloading the stack into the printer.

❏ Follow the instructions provided when reloading the printouts. 
Paper jams or improperly placed binding margins may occur if 
the printouts are not reloaded correctly.

❏ If a paper jam occurs, refer to the following.
& See “Paper Does Not Feed Correctly”

12. Once the paper is reloaded, click Resume to print the 
even-numbered pages.

Folded Booklet double-sided printing for 
Windows

Use the following steps to create a folded booklet as described in 
the beginning of this section.
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1. Access the printer driver.

“Accessing the Printer Software for Windows”

2. Click the Main tab, then make the Quality Option setting. See 
the following section for details on the Quality Option 
settings.
& See “Quality Option”

3. Make the appropriate Type setting.

“Media Type Settings”

4. Make the appropriate Size setting.

5. Click the Page Layout tab and select the Double-Sided 
Printing check box. Then, select the Folded Booklet check 
box.
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6. Click Margins to open the Margins dialog box.

7. Specify the edge of the paper where the binding will be 
placed. You can choose Left, Top, or Right.

Note:
When Portrait is selected as the Orientation setting on the Main 
menu, the Left or Right binding positions are available. The Top 
binding position is available when Landscape is selected as the 
Orientation setting.
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8. Choose cm or inch as the Unit setting. Specify the width of 
the binding margin. You can enter any width from 3 mm to 
30 mm, or from 0.12 inches to 1.18 inches. The specified 
margin width will be used on both sides of the fold. For 
example, if a 10-mm margin is specified, a 20-mm margin will 
be inserted (a margin of 10 mm will be placed on each side of 
the fold).

✽: Folding edge

✽✽: Margin

Portrait Landscape
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9. Click OK to return to the Page Layout menu. Then, click OK 
to save your settings.

10. Load paper into the sheet feeder, then send the print job from 
your application. Instructions for printing the inside pages 
will be displayed while the outside pages are printed.

“Loading Single Sheets of Paper”

11. Follow the on-screen instructions to reload the paper.

Note:
❏ The paper may curl during printing due to the amount of ink 

used. Should this occur, slightly curl the sheets in the opposite 
direction before reloading them into the printer.

❏ Align the sheet stack by tapping its edges against a hard, flat 
surface before reloading the stack into the printer.

❏ Follow the instructions provided when reloading the printouts. 
Paper jams or improperly placed binding margins may occur if 
the printouts are not reloaded correctly.

❏ If a paper jam occurs, refer to the following.
& See “Paper Does Not Feed Correctly”

12. Once the paper is reloaded, click Resume to print the inside 
pages.
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13. Once printing is complete, fold the sheets and bind them 
together using a stapler or other binding method.

Folded Booklet double-sided printing for 
Macintosh

Use the following steps to create a folded booklet as described in 
the beginning of this section.

1. Access the Page Setup dialog box.

“Accessing the Printer Software for Mac OS 8.6 to 9.x”

2. Make the appropriate Paper Size setting.

3. Select the Double-Sided Printing check box. Then, select the 
Folded Booklet check box.

4. Click Margins.

5. Specify the edge of the paper where the binding will be 
placed. You can choose Left, Top, or Right.
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Note:
When Portrait is selected as the Orientation setting in the Page 
Setup dialog box, the Left or Right binding positions are available. 
The Top binding position is supported when Landscape is 
selected as the Orientation setting.

6. Specify the width of the binding margin in the text box. You 
can enter any width from 0.12 inch to 1.18 inch or from 0.3 cm 
to 3.0 cm.The specified margin width will be used on both 
sides of the fold. For example, if a 0.1-cm margin is specified, 
a 0.2-cm margin will be inserted (a margin of 10 mm will be 
placed on each side of the fold).

✽: Folding edge

✽✽: Margin

Portrait Landscape
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7. Click OK to return to the Page Setup dialog box. Then, click 
OK to save your settings and close the dialog box.

8. Access the Print dialog box.

“Accessing the Printer Software for Mac OS 8.6 to 9.x”

9. Make the appropriate Media Type setting.

“Media Type Settings”

10. Load paper into the sheet feeder, then click Print to start 
printing. Instructions for printing the inside pages will be 
displayed while the outside pages are printed. 

“Loading Single Sheets of Paper”
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11. Follow the on-screen instructions to reload the paper.

Note:
❏ The paper may curl during printing due to the amount of ink 

used. Should this occur, slightly curl the sheets in the opposite 
direction before reloading them into the printer.

❏ Align the sheet stack by tapping its edges against a hard, flat 
surface before reloading the stack into the printer.

❏ Follow the instructions provided when reloading the printouts. 
Paper jams or improperly placed binding margins may occur if 
the printouts are not reloaded correctly.

❏ If a paper jam occurs, refer to the following.
& See “Paper Does Not Feed Correctly”

12. Once the paper is reloaded, click Resume to print the inside 
pages.

13. Once printing is complete, fold the sheets and bind them 
together using a stapler or other binding method.
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Fit to Page Printing

You can use the Fit to Page printing function when you want to 
print, for example, an A4 size document on another size paper.

Fit to Page printing automatically fits images or text you want to 
print to the paper size you select in the printer software, or it 
allows you to manually resize the image.

Note:
❏ This feature is not available with Mac OS X.

❏ This feature is not available when selecting the Borderless check 
box on the Main menu (Windows) or in the Page Setup dialog box 
(Macintosh).

Loading paper

Load paper into your printer.

“Loading Single Sheets of Paper”

Driver settings for Windows

1. Access the printer driver.

“Accessing the Printer Software for Windows”
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2. Click the Main tab, then make the Quality Option setting. See 
the following section for details on the Quality Option 
settings.
& See “Quality Option”

3. Make the appropriate Type setting.

“Media Type Settings”

4. Make the appropriate Size setting.

5. Click the Page Layout tab, then select the Reduce/Enlarge 
Document check box. You can select the following settings 
to change the size of your document.

By Output Paper 
Size

Proportionally enlarges or reduces the size of 
your document to make it fit the paper size 
selected in the By Output Paper Size list.

By Percentage Allows you to manually reduce or enlarge an 
image. Click the arrows to select a percentage 
between 10 and 400.
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6. Select the paper size loaded in your printer from the 
drop-down list when selecting By Output Paper Size, or use 
the arrows to choose a percentage when selecting By 
Percentage.

7. Click OK to close the printer driver settings dialog box.

After finishing all steps above, start printing.

Driver settings for Mac OS 8.6 to 9.x

1. Access the Page Setup dialog box.

“Accessing the Printer Software for Mac OS 8.6 to 9.x”

2. Make the appropriate Paper Size setting.
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3. Click OK to save the settings and close the Page Setup dialog 
box.

4. Access the Print dialog box.

“Accessing the Printer Software for Mac OS 8.6 to 9.x”

5. Make the appropriate Media Type setting.

“Media Type Settings”

6. Click the  Layout icon button.

7. Select the Fit to Page check box.

8. Select the paper size loaded in your printer from the Output 
Paper Size list.
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9. Click OK to save the settings and close the Layout dialog box.

10. Click Print to start printing.

Pages Per Sheet Printing

Pages Per Sheet printing allows you to print two or four pages on 
single sheets of paper.

Note:
This feature is not available when selecting the Borderless check box 
on the Main menu (Windows) or in the Page Setup dialog box (Mac OS 
8.6 to 9.x).
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Loading paper

Load paper into your printer.

“Loading Single Sheets of Paper”

Driver settings for Windows

1. Access the printer driver.

“Accessing the Printer Software for Windows”

2. Click the Main tab, then make the Quality Option setting. See 
the following section for details on the Quality Option 
settings.
& See “Quality Option”

3. Make the appropriate Type setting.

“Media Type Settings”
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4. Make the appropriate Size setting.

5. Click the Page Layout tab, select Multi-Page, then select 
Pages Per Sheet.
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6. Make the following settings for Pages Per Sheet printing.

7. Click OK to close the printer driver settings dialog box.

After finishing all of the steps above, start printing.

Driver settings for Mac OS 8.6 to 9.x

1. Access the Page Setup dialog box. 

“Accessing the Printer Software for Mac OS 8.6 to 9.x”

2. Make the appropriate Paper Size setting.

3. Click OK to save the settings and close the Page Setup dialog 
box.

4. Access the Print dialog box.

2, 4 Prints two or four pages of your document on a 
single piece of paper.

Print Page 
Borders

Prints frames around the pages printed on each 
sheet.

Page Order Allows you to specify the order in which the 
pages will be printed on the sheet of paper. 
Some settings may be unavailable, depending 
on the Orientation setting on the Main menu.
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“Accessing the Printer Software for Mac OS 8.6 to 9.x”

5. Make the appropriate Media Type setting.

“Media Type Settings”

6. Click the  Layout icon button.

7. Select the Multi-Page check box in the Layout dialog box, 
then select Pages per Sheet.

8. Make the following settings for Pages Per Sheet printing.

2 Pages, 
4 Pages

Prints two or four pages of your document on a 
single piece of paper.
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9. Click OK to save the settings and close the Layout dialog box.

10. Click Print to start printing.

Driver settings for Mac OS X

1. Access the Page Setup dialog box. 

“Accessing the Printer Software for Mac OS X”

2. Select Stylus C84 as the Format for setting.

3. Make the appropriate Paper Size and Orientation settings.

4. Click OK to close the Page Setup dialog box.

Page Order Allows you to specify the order in which the 
pages will be printed on the sheet of paper. 
Some settings may be unavailable, depending 
on the Orientation setting in the Page Setup 
dialog box.

Print page 
frames

Prints frames around the pages printed on each 
sheet.



67

R4CD000_UK
html.bk Rev. E
VARI.FM A5 size
6/10/03

RProof Sign-off:
S.Kodama CRE Kawakami
M.Otsuka
editorname

5. Open the Print dialog box.

“Accessing the Printer Software for Mac OS X”

6. Select Stylus C84 as the Printer setting, then make the Copies 
& Pages settings.

Note:
❏ Always match the Format for setting in the Page Setup dialog 

box and the Printer setting in the Print dialog box. Otherwise 
the data may not be printed correctly.

❏ The Copies & Pages settings available are a standard feature of 
Mac OS X. See your operating system’s documentation for 
details.

7. Select Layout from the pop-up menu.

8. Make the following settings.

Pages per 
Sheet

Prints multiple pages of your document on a single 
piece of paper. You can choose from 1, 2, 4, 6, 9, 
or 16.

Layout 
Direction

Allows you to specify the order in which the pages 
will be printed on the sheet of paper.
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Note:
The Layout settings available are a standard feature of Mac OS X. 
See your operating system’s documentation for details.

9. Select Print Settings from the pop-up menu.

10. Make the appropriate Media Type, Color, and Mode settings.
& See “Print Settings”

“Media Type Settings”

Border Prints a border around the pages printed on each 
sheet. You can choose from None, Single hairline, 
Single thin line, Double hairline, or Double thin line.
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11. Click Print to start printing.

Poster Printing

Poster printing allows you to print poster-size images by 
enlarging one page to cover several sheets of paper.

Note:
❏ This feature is not available with Mac OS X.

❏ This feature is not available when selecting the Borderless check 
box on the Main menu (Windows) or in the Page Setup dialog box 
(Macintosh).
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Loading paper

Load paper into your printer.

“Loading Single Sheets of Paper”

Driver settings for Windows

1. Access the printer driver.

“Accessing the Printer Software for Windows”

2. Click the Main tab, then make the Quality Option setting. See 
the following section for details on the Quality Option 
settings.
& See “Quality Option”

3. Make the appropriate Type setting.

“Media Type Settings”
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4. Make the appropriate Size setting.
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5. Click the Page Layout tab, select Multi-Page, then select 
Poster Printing. Click the up or down arrow to select 2x2, 3x3, 
or 4x4.
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6. Click Settings to adjust the way your poster will print. The 
Poster Settings dialog box opens.

7. Make the following settings.

Note:
If you want to print only a few of the panels without printing the 
entire poster, click the panels that you do not wish to print.

8. Click OK to close the Poster Settings dialog box.

After finishing all of the steps above, start printing.

Print Cutting 
Guides

Select this check box to turn the cutting guide 
options on.

Overlapping 
Alignment Marks

Slightly overlaps the panels and prints alignment 
markers so that the panels can be aligned more 
precisely.

Trim Lines Prints border lines on the panels to guide you 
when trimming the pages.
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Driver settings for Mac OS 8.6 to 9.x

1. Access the Page Setup dialog box. 

“Accessing the Printer Software for Mac OS 8.6 to 9.x”

2. Make the appropriate Paper Size setting.

3. Click OK to save the settings and close the Page Setup dialog 
box.

4. Access the Print dialog box.

“Accessing the Printer Software for Mac OS 8.6 to 9.x”

5. Make the appropriate Media Type setting.

“Media Type Settings”

6. Click the  Layout icon button.
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7. Select the Multi-Page check box in the Layout dialog box, 
then select Poster.

8. Make the following settings.

Note:
If you want to print only a few of the panels without printing the 
entire poster, click Panel Selection, click the panels that you do 
not wish to print, then click OK.

9. Click OK to save the settings and close the Layout dialog box.

1 page covers xx 
sheets

Specifies how many printed sheets of 
paper the enlarged document page will 
cover. You can choose from 4, 9, or 16 
sheets.

Overlapping 
Alignment Marks

Slightly overlaps the panels and prints 
alignment markers so that the panels can 
be aligned more precisely.

Trim Lines Prints border lines on the panels to guide 
you when trimming the pages.

Panel Selection Click the panels you do not need to print, 
then click the OK button to print the 
remaining panels.
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10. Click Print to start printing.

How to make a poster from your printouts

Here is an example of how to make a poster with 2x2 selected 
under Poster Printing and Overlapping Alignment Marks 
selected as the print cutting guide. Refer to the accompanying 
illustrations as well.

1. Cut off the margin of Sheet 1 along a vertical line through the 
center of the top and bottom cross marks, as shown in the 
illustration below.
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2. Place the edge of Sheet 1 on top of Sheet 2 and align the cross 
marks, then temporarily tape the two sheets together from the 
back side.

3. Cut the taped sheets in two along a vertical line through the 
alignment markers (this time, a line to the left of the cross 
marks), as shown in the illustration below.

4. Align the edges of the paper together using the alignment 
markers and tape them from the back side of the paper.

5. Repeat the instructions from step 1 to step 4 to tape Sheets 3 
and 4 together.
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6. Repeat the instructions from step 1 to step 4 to tape the top 
and bottom faces of the paper.

7. Cut off the remaining margins.

w
Warning:
Be careful when using sharp tools.



79

R4CD000_UK
html.bk Rev. E
VARI.FM A5 size
6/10/03

RProof Sign-off:
S.Kodama CRE Kawakami
M.Otsuka
editorname

Watermark Printing

Watermark printing allows you to print a text-based or an 
image-based watermark on your document.

Note:
❏ This feature is not available with Mac OS X.

❏ This feature is not available when selecting the Borderless check 
box on the Main menu (Windows) or in the Page Setup dialog box 
(Macintosh).

Loading paper

Load paper into the printer.

“Loading Single Sheets of Paper”

Printing the watermark for Windows

1. Access the printer driver software.

“Accessing the Printer Software for Windows”
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2. Click the Main tab, then make the Quality Option setting. See 
the following section for details on the Quality Option 
settings.
& See “Quality Option”

3. Make the appropriate Type setting.

“Media Type Settings”

4. Make the appropriate Size setting.
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5. Click the Page Layout tab, choose the desired watermark 
from the Watermark list, then click Settings.

6. Specify the necessary settings for the watermark. You can 
change the position and size of the watermark by dragging 
the image within the preview window at the left of the dialog 
box.

7. Click OK to return to the Page Layout menu.
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8. Click OK to close the printer driver settings dialog box.

9. Print the data from your application.

Printing the watermark for Mac OS 8.6 to 9.x

1. Access the Page Setup dialog box.

“Accessing the Printer Software for Mac OS 8.6 to 9.x”

2. Make the appropriate Paper Size setting.

3. Click OK to save the settings and close the Page Setup dialog 
box.

4. Access the Print dialog box.

“Accessing the Printer Software for Mac OS 8.6 to 9.x”

5. Make the appropriate Media Type setting.

“Media Type Settings”
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6. Click the  Layout icon button.

7. Select the Watermark check box in the Layout dialog box, 
then choose the desired watermark from the Name list.

8. Specify the necessary settings for the watermark. You can 
change the position and size of the watermark by dragging 
the image within the preview window at the left of the dialog 
box.
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9. Click OK to save the settings and close the Layout dialog box.

10. Click Print to start printing.

Creating your own watermark for Windows

You can add your own text-based or image-based watermarks to 
the watermark list.
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1. Click Add/Del under Watermark on the Page Layout menu. 
The following dialog box appears.

2. To use an image file as a watermark, select BMP. Click Browse 
to specify the bitmap file you want to use, then click OK. Type 
a name for your watermark in the Name text box, then click 
Save.

To create a text-based watermark, select Text. Type your text 
in the Text text box. The text that you enter will also be used 
as the watermark name. If you want to change the watermark 
name, type a new name in the Name text box, then click Save.

3. Click OK to return to the Page Layout menu.
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4. Click Settings. The following dialog box appears.

5. Make sure that the appropriate watermark is selected in the 
Watermark list, then make Color, Position, Density, Size, 
Font, Font Style, and Angle settings. (For details, see online 
help.) Your settings are reflected in the display at the left side 
of the dialog box.

6. When you finish making settings, click OK.

Creating your own watermark for Mac OS 8.6 to 
9.x

You can add your own text-based or image-based watermarks to 
the watermark list.
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1. Click Add/Del beside the Name list. The following dialog box 
appears.

2. To use an image file as a watermark, click Add PICT. Specify 
the desired image file, then click Open.

To create a text-based watermark, click Add Text. Type the 
text in the Text text box, select a font and a text style, then click 
OK.
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3. The image file name or the watermark text appears in the 
Mark Name list in the Watermark dialog box. To change the 
name of an image watermark, select it from the list, then type 
a new name. When a text watermark is selected in the Name 
list, you can edit the text or change the font and text style by 
clicking Edit Text.

4. Click OK to add your watermark to the Name list in the 
Layout dialog box.
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Printer Software Settings

For Windows

Printer Software Introduction

Printer driver menus

The printer software that comes with your printer includes a 
printer driver and printer utilities. The printer driver lets you 
choose from a wide variety of settings to get the best results from 
your printer. The printer utilities help you check the printer and 
keep it in top operating condition.

For details on each printer driver setting and utility, see the 
following.
& See “Making Settings on the Main Menu”
& See “Making Settings on the Page Layout Menu”
& See “Making Settings on the Maintenance Menu”

Accessing the printer driver

For information on accessing the printer software, see the 
following.

“Accessing the Printer Software for Windows”

Note:
The specific features available in the printer software vary depending on 
the version of Windows that you are using.
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Getting more information

Online help provides more information about the printer 
software.
& See “Getting Information Through Online Help”

Making Settings on the Main Menu

You can make Quality Option, Paper Options, Print Options, 
Orientation, and Advanced settings, and also check the ink levels 
on the Main menu. Refer to the appropriate section below.

Making the Basic settings
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Quality Option

You can select one of the following quality types.

Paper Options

Draft For economical, high-speed printing.

Text For medium-quality, standard text printing.

Text & Image For high-quality, standard text and graphics printing.

Photo For high-quality photographic printing.

Best Photo For top-quality photographic printing.

User Defined 
(your unique 
name)

Print using custom settings.
(This option appears when custom settings have been 
set in the Advanced menu.)

Borderless Select this check box when you want to print without 
margins. With this feature, you can print to all four edges 
of the paper.
& See “Borderless Printing”

Type Select the Type setting that matches the media loaded in 
the printer.

The Type setting determines what other settings are 
available, so you should always make this setting first.

To find out what media type you are using, find your media 
in the Media Type Settings list.

“Media Type Settings”
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Print Options

PhotoEnhance

This mode applies image correction settings specially designed 
for scanned or digitally captured photos.

Reverse Order

Lets you print your documents in reverse order, starting with the 
last page.

Print Preview

Lets you see a preview of your document before printing.

Size Select the paper size that you want to use. You can also 
add a custom paper size. To add your own paper size 
setting, see the following.

“Making User Defined Paper Sizes for 
Windows”
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When you send a print job to the printer, the Print Preview 
window opens, allowing you to make changes before printing.

The Print Preview toolbar contains several icon buttons to 
perform the following functions.

Icon Button name Function

Drag ’n’ Drop Click this button to select and move 
watermarks.

Zoom Click this button to enlarge or reduce the 
size of the previewed page.

Fit To Screen Click this button to scale the previewed 
page so that it fits the size of the window. 
This is convenient when you want to see 
the entire page at one time.

Maximum 
Zoom

Click this button to display the previewed 
page at the maximum possible zoom 
ratio.

Printable Area 
On/Off

Click this button to display or hide the 
borderlines which indicate the printable 
area. The printer cannot print anything 
which is outside of this area.
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You can also manipulate the document being previewed in the 
following ways:

❏ Select and preview individual pages.

❏ Reduce or enlarge the size of the preview window.

❏ Magnify the previewed document. Click Magnify on the 
View menu to open the Magnify window, which magnifies 
the area of the previewed document that is outlined by the 
red box. By dragging the red box, you can change which part 
of the document is magnified.

❏ View the individual pages that comprise a poster. The Poster 
window opens automatically when you send a print job while 
Poster Printing is selected under Multi-Page on the Page 
Layout menu. From this window, you can view the individual 
panels that make up a poster. You can also open this dialog 
box by clicking Poster on the View menu.

❏ Apply watermarks. The watermark that you select will be 
displayed on the previewed image.
& See “Watermark Printing”

Watermark Click this button to open the Watermark 
dialog box, where you can add 
watermarks to the document and 
change any of the current watermark 
settings.

Reset 
Watermark 
Settings

Click this button to return all watermark 
settings to what they were when the 
EPSON Print Preview dialog box was first 
opened.

Previous Page Click this button to display the page 
before the one currently being 
previewed.

Next Page Click this button to display the next page 
in the document.
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❏ Specify which pages of the document you would like to print. 
To add or remove a page, click the page icon in the list at the 
left side of the preview window, and then add or remove it 
using the commands on the Print Options menu.

After you have previewed the document, click Print to print the 
document, or click Cancel to cancel printing.

Orientation

Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.

Show Settings

When you click Show Settings, the Current Setting window 
appears. To hide the window, click Hide Settings on the Main 
menu or Close in the Current Setting window.

Reset Defaults

Click the Reset Defaults button to return the settings to their 
factory default values.
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Advanced

Shows the Advanced menu.

Making the Advanced settings

The settings in the Advanced dialog box give you complete 
control over your printing environment. Use these settings to 
experiment with new printing ideas or to fine-tune a range of 
print settings to meet your individual needs. Once you are 
satisfied with your new settings, you can give them a name and 
add them to the Custom Settings.

Note:
❏ Advanced settings are recommended for experienced users only. 

Incorrect settings can reduce print speed or quality.

❏ The figures in this procedure are taken from Windows XP. The 
Windows Me, 98, 95, 2000, and NT 4.0 figures may differ slightly.

❏ Some settings may not be available, depending on the Paper Source, 
Media Type, Color, and Print Quality settings that you make.

❏ The PhotoEnhance feature only affects images, not text or graphs. 
For example, if Monochrome is chosen from the Tone list 
(available when PhotoEnhance is selected), only the images in a 
document will be printed in monochrome. Any colored text or 
graphs in the same document will be printed in color.
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To open the Advanced menu, click Advanced on the Main 
menu. If the following Note dialog box appears, click Continue.
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Paper & Quality Options

Orientation

Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.

Print Options

Borderless Select this check box when you want to print without 
margins. With this feature, you can print to all four 
edges of the paper.
& See “Borderless Printing”

Type Select the Type setting that matches the media 
loaded in the printer.

To find out what media type you are using, find your 
media in the Media Type Settings list.

“Media Type Settings”

Note:
The availability of the Print Quality setting depends on 
the Media Type setting. Therefore, make the Media 
Type setting before you set the Print Quality.

Print Quality Select the print quality from the list.

Size Select the paper size that you want to use. You can 
also add a custom paper size. To add your own paper 
size setting, see the following.

“Making User Defined Paper Sizes 
for Windows”

Reverse order Lets you print your documents in reverse order, starting 
with the last page.
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Color Management

Color Controls

For use with the color matching and image enhancement methods 
provided by the printer driver. When you select Color Controls, 
additional settings appear under Color Management, allowing 
you to select a Color Mode setting and adjust the color 
enhancement sliders.

Fast Feed Increases the speed at which paper is fed into the 
printer. Fast Feed mode speeds up printing, but also 
increases printing noise.

High Speed Activates bidirectional printing so your printer prints 
both left-to-right and right-to-left. High Speed mode 
speeds up printing, but decreases print quality.

Black Ink Only Prints your printout in black and white or grayscale.

Super 
MicroWeave

Gives you slightly more detail, but print times will be 
longer. You can select when selecting Photo RPM from 
the Print Quality list under Paper & Quality Option.

Edge 
Smoothing

Improves the print quality of low-resolution images by 
smoothing jagged edges and lines. This setting has no 
effect on high-resolution images or on text.

Print Preview Shows a preview of your document before printing.

Gamma To control image contrast by modifying the midtones 
and mid-level grays.

Color Mode EPSON Vivid: Based on your data, enhances color 
balance for optimum print results. This setting is 
recommended for most print jobs.

Charts and Graphs: Intensifies the colors and lightens 
the midtones and highlights of an image. Use this 
setting for charts and graphs.

Slide Bars The Color Enhancement slide bars adjust the options 
in a range of -25% to +25%. For details on each option, 
see the printer driver help.
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PhotoEnhance

This mode provides a variety of image correction settings that you 
can apply to your photos before printing. PhotoEnhance does not 
affect your original data.

Note:
❏ This mode is only available when printing 16-, 24-, or 32-bit color 

data.

❏ Printing with PhotoEnhance selected may increase the time 
required for printing, depending on your computer system and the 
amount of data contained in your image.

Tone:

You can select from the following settings.

Effect:

You can select from the following settings.

Normal Applies EPSON standard tone adjustment to your 
document.

Hard Prints in high contrast, which sharpens the printed 
image.

Vivid Intensifies the colors and lightens the midtones and 
highlights of an image.

Sepia Applies a sepia tone to your photos.

Monochrome Prints the image in black and white only.

None Makes no tone adjustment to your document.

Sharpness Sharpens the overall image, particularly the outlines.

Soft Focus Makes your photos look as if they were taken with a 
soft-focus lens.

Canvas Makes the image look like a picture painted on canvas.
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Selecting PhotoEnhance also makes the Digital Camera 
Correction check box available. Select this check box when you 
are printing photos taken with a digital camera to give your 
printed images the smooth, natural appearance of photographs 
taken with a film camera.

ICM

This method automatically adjusts printout colors to match the 
colors on your screen. ICM stands for Image Color Matching.

Selecting ICM also makes the No Color Adjustment check box 
available. This setting is generally not recommended, because it 
does not allow the printer driver to enhance or adjust the color in 
any way. Only use this setting when you create a new color profile 
or if the other Mode settings do not produce satisfactory results.

Save Settings

To save your Advanced settings in the Custom Settings list, click 
Save Setting. The Custom Settings dialog box appears.

Parchment Makes the image look as if it was printed on parchment.

None Applies no effect to your document.
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Type a unique name for your settings in the Name text box, then 
click Save. The name can contain a total of up to 16 letters and 
numerals. You can also use up to eight, double-byte characters; 
however, they may not be displayed correctly on the screen 
depending on your operating system settings. Your custom 
setting will be added to the Custom Settings list on the Advanced 
menu. You can save up to 10 custom settings.

After saving it, the latest custom setting will be selected on the 
Advanced menu as well as under Quality Option on the Basic 
menu. To change to another custom setting, simply select it from 
the Custom Settings list on the Advanced menu, or click the icon 
with the current custom setting’s name under Quality Option on 
the Basic menu and select the custom setting you want from the 
list that appears.

If you change a setting while one of your custom settings is 
selected in the Custom Settings list, the selection in the list returns 
to Custom Settings and the user-defined choice under Quality 
Option on the Basic menu changes to User. The custom setting 
that was previously selected is not affected by the change and 
remains in the list. To return to your custom setting, simply 
reselect it from the Custom Settings list on the Advanced menu, 
or click the User icon under Quality Option on the Basic menu and 
select it from the list that appears.

To delete a setting from the Custom Settings list, select it in the 
Custom Settings dialog box, then click Delete. If the deleted 
custom setting was active when deleted or if it was the only 
custom setting, the Custom Settings list selection returns to 
Custom Settings and the user-defined choice under Quality 
Option on the Basic menu changes to User. To activate a 
remaining custom setting, simply select it from the Custom 
Settings list on the Advanced menu, or click the User icon under 
Quality Option on the Basic menu and select the custom setting 
you want from the list that appears.
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Show this screen first

Shows the Advanced menu first when accessing the Main menu 
in the printer software.

Reset Defaults

Click the Reset Defaults button to return the settings to their 
factory default values.

Basic

Shows the Basic menu.

Making Settings on the Page Layout Menu
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More Options

Adjust the printing data as follows.

Reduce/Enlarge Document

Adjust the size of your document to fit the size page you want to 
print on.
& See “Fit to Page Printing”

Copies

Select the number of copies that you want to print.

You can select from the following settings.

Multi-Page

Select this check box to make the Pages Per Sheet and Poster 
Printing settings available.

Rotate 180° Prints the pages rotated 180 degrees.

Mirror Image Prints an image as it would appear in a mirror. (Text and 
graphics appear backwards.)

Reverse Order Prints your documents in reverse order, starting with the 
last page.

Collate Print one complete document set at a time.

Pages Per Sheet Print two or four pages of your document on one sheet 
of paper.
& See “Pages Per Sheet Printing”

Poster Printing A single document page can be enlarged to cover 4, 
9, or 16 printed sheets of paper.
& See “Poster Printing”
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Borderless

When the Borderless check box is selected on the Main menu, the 
Borderless Expansion slider becomes available. Using the slider, 
you can control the amount of the image that extends beyond the 
edges of the paper during borderless printing.

For most print jobs, selecting Max is recommended in order to 
eliminate margins on all sides of the paper.

Moving the slider towards Min decreases the amount of the image 
that extends beyond the edges of the paper; however, as this 
amount decreases, margins may begin to appear on one or more 
sides of the paper.

Watermark

You can print a text or image watermark on your printout.
& See “Watermark Printing”

Double-Sided Printing

Two types of double-sided printing are available. Standard 
double-sided printing allows you to print the odd-numbered 
pages first. Once these pages are printed, they can be reloaded to 
print the even-numbered pages onto the opposite side of the 
paper. Folded Booklet double-sided printing allows you to make 
single-fold booklets.
& See “Double-Sided Printing”

Making Settings on the Maintenance Menu

EPSON printer utilities allow you to check the current printer 
status and maintain certain features of your printer from your 
computer.
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To use the utilities, click the Maintenance tab in the printer 
software, then click the button for the utility that you want to use. 
Refer to the section below to access the printer software.

“Accessing the Printer Software for Windows”

Note:
❏ The letter in parentheses after the utility name indicates the shortcut 

key for that utility. After selecting the menu, press Alt and the letter 
on the keyboard to open that utility.

❏ Do not use the Nozzle Check, Head Cleaning, or Print Head 
Alignment utilities if your printer is connected to your computer 
through a network.

Refer to the appropriate section below.
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EPSON Status Monitor 3

EPSON Status Monitor 3 provides you with printer status 
information, such as the amount of ink remaining, and checks for 
printer errors.

This utility is only available when both of the following conditions 
are met:

❏ The printer is connected directly to the host computer via the 
parallel or USB port.

❏ Your system is configured to support bidirectional 
communication.

Nozzle Check

The Nozzle Check utility checks the print head nozzles for 
clogging. Check the nozzles if you notice print quality has 
declined and after cleaning to confirm that the print head nozzles 
have been cleared. If the nozzle check indicates that the print head 
needs cleaning, you can access the Head Cleaning utility directly 
from the Nozzle Check utility.
& See “Checking the Print Head Nozzles”

Head Cleaning

The Head Cleaning utility cleans the print head. You may need 
to clean the print head if you notice that print quality has declined. 
Use the Nozzle Check utility first to confirm that the print head 
needs to be cleaned. You can access the Nozzle Check utility 
directly from the Head Cleaning utility.
& See “Cleaning the Print Head”
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Print Head Alignment

The Print Head Alignment utility can be used to improve the print 
quality of your documents. The print head alignment may need 
to be adjusted if vertical lines appear out of alignment or if white, 
black, dark, or light banding appears in your documents. Use this 
utility to realign the print head.
& See “Aligning the Print Head”

Ink Cartridge Replacement

The Ink Cartridge Replacement utility guides you through 
replacing an ink cartridge before ink has run out. To use the 
utility, click the Ink Cartridge Replacement button in the Utility 
dialog box and follow the instructions. 

To replace an ink cartridge using the printer’s control panel, see 
the following.
& See “Using the printer’s control panel buttons”.
To replace an empty ink cartridge, see the following.
& See “Using the printer's control panel buttons”.
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Speed & Progress

You can make settings related to print speed and progress in this 
dialog box.

The following are the available settings:

Note:
The specific features available in the printer software vary depending on 
the printer model and version of Windows that you are using.

High Speed Copies

To print multiple copies of your document faster, select High 
Speed Copies. This speeds up printing by using your hard disk 
space as a cache when printing multiple copies of your document.

Show Progress Meter

To display the progress meter every time you print, select Show 
Progress Meter.
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EPSON Printer Port (Windows Me, 98, and 95)

For printer models that use the parallel port, you can speed up 
the data transfer rate by selecting EPSON Printer Port.

Parallel port users can further increase print speed by enabling 
DMA transfer.
& See “Enabling DMA transfer”

Always spool RAW datatype (for Windows XP, 2000, and 
NT 4.0)

Select this check box to have Windows NT based clients spool 
documents using the RAW format instead of the EMF (metafile) 
format (Windows NT based applications use the EMF format by 
default).

Try using this option if documents spooled in EMF format do not 
print correctly.

Spooling RAW datatype requires less resources than EMF, so 
some problems (“Insufficient memory/disk space to print”, 
“Slow print speed”, etc.) can be solved by selecting the Always 
spool RAW datatype check box.

Note:
When spooling RAW datatype, print progress as displayed by the 
progress meter may differ from actual print progress.
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Monitoring Preferences

Click this button to open the Monitoring Preferences dialog box, 
where you can make settings for EPSON Status Monitor 3. 

You can make the following settings.

Select 
Notification

Displays the current error notification settings.

Select the check boxes of the error types for which you 
want to receive notification.

Note:
Click the Default button to revert all Select Notification 
settings to their default settings.

Select 
Shortcut Icon 

Select the Shortcut Icon check box and choose an icon 
type to have a shortcut icon placed in your Windows 
taskbar. You can click the shortcut icon in the taskbar to 
open EPSON Status Monitor 3 or right-click the icon to 
access some of the printer utilities.
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Getting Information Through Online Help

Your printer software has an extensive online help feature that 
provides you with instructions on printing, making printer driver 
settings, and using printer utilities.

Refer to the appropriate section below.

Accessing help from your application

Choose Print or Print Setup from the File menu. Then, click 
Printer, Setup, Options, or Properties. (Depending on your 
application, you may need to click any one or a combination of 
these buttons.)

You can get specific help with any item on a menu by 
right-clicking the item, then clicking the What’s This? command.

You can also view a detailed explanation of a setting or option by 
clicking the  button on the top right of the printer driver 
window, then clicking the item.

Accessing help from the Windows Start menu

1. For Windows XP, click Start, Control Panel, then 
double-click Printers and Faxes. (If the Control Panel is in 
Category View, click Printers and Other Hardware, then 
click Printers and Faxes.)

Allow 
monitoring of 
shared 
printers

Select this check box to allow monitoring of a shared 
printer by other computers.
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For Windows Me, 98, 95, 2000, and NT 4.0, click Start, point 
to Settings, then click Printers.

2. For Windows XP, 2000, select your printer, then click Printing 
Preferences on the File menu.

For Windows Me, 98, and 95, select your printer, then click 
Properties on the File menu.

For Windows NT 4.0, select your printer, then click 
Document Defaults on the File menu.

The printer software opens.

You can get specific help related to any item on a menu by 
right-clicking the item, then clicking the What’s This? command.

You can also view a detailed explanation of a setting or option by 
clicking the  button on the top right of the printer driver 
window, then clicking the item.



114

R4CD000_UK
html.bk Rev. E
SOFTW.FM A5 size
6/10/03

L Proof Sign-off:
S.Kodama CRE Kawakami
M.Otsuka
editorname



115

R4CD000_UK
html.bk Rev. E
SOFTM.FM A5 size
6/10/03

RProof Sign-off:
S.Kodama CRE Kawakami
M.Otsuka
editorname

For Mac OS 8.6 to 9.x

Printer Software Introduction

Printer driver dialog box

The printer software that comes with your printer includes a 
printer driver and printer utilities. The printer driver lets you 
choose from a wide variety of settings to get the best results from 
your printer. The printer utilities help you check the printer and 
keep it in top operating condition.

The printer driver dialog boxes are listed below.
& See “Page Setup Dialog Box”
& See “Print Dialog Box”
& See “Layout Dialog Box”
& See “Printer Utilities”

Accessing the printer driver

For information on accessing the printer software, see the 
following.

“Accessing the Printer Software for Mac OS 8.6 to 9.x”

In addition to the printer software information in this guide, you 
can get more details by clicking the help icon in any of the dialog 
boxes in the printer software.

Getting more information

Online help provides more information about the printer 
software.
& See “Getting Information Through Online Help”
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Page Setup Dialog Box

Paper Size Select the paper size that you want to use. You can 
also add a custom paper size. To add your own 
paper size setting, see the following.

“Defining a custom paper size”
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Borderless Check this box when you want to print without 
margins.

This feature prints to all four edges of the paper.

Expansion button:
When the Borderless check box is selected, the 
Expansion button becomes available. Click the 
Expansion button to open the Borderless Expansion 
dialog box, where you can control the amount of 
the image that extends beyond the edges of the 
paper during borderless printing.

Borderless Expansion slider:
Using the slider on the Borderless Expansion dialog 
box, you can control the amount of the image that 
extends beyond the edges of the paper during 
borderless printing.

For most print jobs, selecting Max is recommended 
in order to eliminate margins on all sides of the 
paper. Moving the slider towards Min decreases the 
amount of the image that extends beyond the 
edges of the paper; however, as this amount 
decreases, margins may begin to appear on one or 
more sides of the paper.
& See “Borderless Printing”

Orientation Select Portrait (tall) or Landscape (wide) to change 
the orientation of your printout. 

Rotate by 180 degrees: Prints the pages rotated 180 
degrees.

Double-Sided 
Printing

Select the Double-Sided Printing check box to print 
on both sides of the paper. Select the Folded Booklet 
check box to make single-fold booklets.
& See “Double-Sided Printing”

Reduce or Enlarge Use this setting to reduce or enlarge the print size of 
your document between 25% and 400%.
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Print Dialog Box

Basic settings

Copies

Enter the number of copies that you want to print in the Copies 
text box.

Pages

Choose All or Range. If you select Range, enter the appropriate 
range of pages in the Range text boxes.

Media Type

Determines what other settings are available, so you should 
always make this setting first.

Select the Media Type setting that matches the paper that is 
loaded in the printer. To find out what media type you are using, 
find your media in the Media Type Settings list.

“Media Type Settings”
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Color

Mode

The Mode settings give you three levels of control over the printer 
software, as explained below.

Automatic mode

When Automatic is selected, the printer software takes care of 
all detailed settings based on the current Media Type and Color 
settings.

Note:
Depending on the media selected in the Media Type list (while 
Automatic is selected), a slider appears to the right of the Mode options, 
which lets you choose Quality, Speed, or a level in between. Select 
Quality when print quality is more important than speed.

Black Print in black and white or grayscale.

Color Print in color.

Automatic Provides the quickest and easiest way to start 
printing.
& See “Automatic mode” 

PhotoEnhance Lets you choose from a variety of image-correction 
settings specially designed for photos.
& See “PhotoEnhance mode” 

Custom Lets you choose from a list of your personalized 
settings suited to the kind of document that you want 
to print. When Custom is selected, the Advanced 
button is available, allowing you to access the 
Advanced dialog box.
& See “Custom mode”
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PhotoEnhance mode

The PhotoEnhance mode provides a variety of image-correction 
settings that you can apply to your photos before printing. 
PhotoEnhance does not affect your original data.

Note:
❏ This mode is only available when printing 32-bit color data.

❏ Printing with PhotoEnhance selected may increase the time 
required for printing, depending on your computer system and the 
amount of data contained in your image.

Tone:

You can choose from the following settings.

Selecting PhotoEnhance also makes the Digital Camera 
Correction check box available. Select this check box when you 
are printing photos taken with a digital camera to give your 
printed images the smooth, natural appearance of photographs 
taken with a film camera.

Custom mode

Custom Settings

You can select your personalized settings from the list.

Standard Provides standard image correction for most photos. 
Try this first.

People Best for photos of people.

Nature Best for outdoor scenery, such as mountains, skies, 
and oceans.

Soft Focus Makes your photos look as if they were taken with a 
soft-focus lens.

Sepia Applies a sepia tone to your photos.
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Advanced Settings

You can create and save your own custom settings.
& See “Advanced settings”

When you select a custom setting, other settings, such as Print 
Quality and Color Management, are made automatically. 
Changes to these settings are reflected in the display at the left 
side of the Print dialog box.

Follow the steps below to select a custom setting.

1. Confirm that the Media Type and Color settings in the Print 
dialog box are correct.

2. Select Custom. This makes the Custom Settings list available 
to the right of the Mode settings.

3. From the Custom Settings list, select the most appropriate 
setting for the type of document or image that you want to 
print.

Advanced settings

The settings in the Advanced dialog box give you complete 
control over your printing environment. Use these settings to 
experiment with new printing ideas or to fine-tune a range of 
print settings to meet your individual needs. Once you are 
satisfied with your new settings, you can give them a name and 
add them to the Custom Settings list in the Print dialog box.
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To open the Advanced dialog box, select Custom and click 
Advanced.

Note:
❏ The PhotoEnhance feature only affects images, not text or graphs. 

For example, if Monochrome is selected from the Tone list 
(available when PhotoEnhance4 is selected), only the images in 
a document will be printed in monochrome. Any colored text or 
graphs in the same document will be printed in color.

❏ Some settings may not be available, depending on the Media Type, 
Color, and Print Quality settings that you make.

Media Type

Determines what other settings are available, so you should 
always make this setting first.

Select the Media Type setting that matches the paper that is 
loaded in the printer. To find out what media type you are using, 
find your media in the Media Type Settings list.

“Media Type Settings”
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Color

Print Quality

Select the desired setting from the Print Quality list.

Note:
The availability of the Print Quality setting depends on the Media Type 
setting. Therefore, make the Media Type setting before you set the Print 
Quality.

Super MicroWeave

Gives you slightly more detail, but print times will be longer. You 
can select when selecting Photo RPM from the Print Quality list 
under Paper & Quality Option.

High Speed

This setting activates bidirectional printing so your printer prints 
both left-to-right and right-to-left. High Speed mode speeds up 
printing, but decreases print quality.

Mirror Image

Prints an image as it would appear in a mirror. Text and graphics 
appear reversed.

Edge Smoothing

Improves the print quality of low-resolution images by 
smoothing jagged edges and lines. This setting has no effect on 
high-resolution images or on text.

Black Print in black and white or grayscale.

Color Print in color.
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Fast Feed

Increases the speed at which paper is fed into the printer. Fast 
Feed mode speeds up printing, but also increases printing noise.

Color Management

Color Controls

For use with the color matching and image enhancement methods 
provided by the printer driver. When you select Color Controls, 
additional settings appear under Color Management, allowing 
you to select a Mode setting and to adjust the color enhancement 
sliders.

PhotoEnhance4

This mode provides a variety of image correction settings that you 
can apply to your photos before printing. PhotoEnhance does not 
affect your original data.

Gamma To control image contrast by modifying the midtones 
and mid-level grays.

Note:
This option appears only when Color Controls is 
selected.

Mode EPSON Vivid: Based on your data, enhances color 
balance for optimum print results. This setting is 
recommended for most print jobs.

Charts and Graphs: Intensifies the colors and lightens 
the midtones and highlights of an image. Use this 
setting for presentation graphics, such as charts and 
graphs.

Slide Bars The Color Adjustment slide bars adjust the options in a 
range of -25% to +25%. For details on each option, see 
the printer driver help.
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Note:
❏ This mode is only available when printing 16-, 24-, or 32-bit color 

data.

❏ Printing with PhotoEnhance4 selected may increase the time 
required for printing, depending on your computer system and the 
amount of data contained in your image.

Tone:

You can select from the following settings.

Effect:

You can select from the following settings.

Normal Applies EPSON standard tone adjustment to your 
document.

Hard Prints in high contrast, which sharpens the printed 
image.

Vivid Intensifies the colors and lightens the midtones and 
highlights of an image. Use this setting for presentation 
graphics, such as charts and graphs.

Sepia Applies a sepia tone to your photos.

Monochrome Prints the image in black and white only.

Sharpness Sharpens the overall image, particularly the outlines.

Soft Focus Makes your photos look as if they were taken with a 
soft-focus lens.

Canvas Makes the image look like a picture painted on 
canvas.

Parchment Makes the image look as if it was printed on 
parchment.
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Selecting PhotoEnhance4 also makes the Digital Camera 
Correction check box available. Select this check box when you 
are printing photos taken with a digital camera to give your 
printed images the smooth, natural appearance of photographs 
taken with a film camera.

ColorSync

This mode automatically adjusts the printout colors to match the 
colors on your monitor. Selecting ColorSync displays the 
following two menus.

Profile:

Matches the printout colors to the colors displayed on your 
monitor according to the information stored in the selected 
profile. EPSON Standard is a custom-designed profile that works 
with your printer.

Rendering Intent:

You can select from the following settings.

No Color Adjustment

This setting prints without any color adjustment.

Perceptual The most commonly used option for reproducing 
photographs.

Saturation The best option for reproducing vivid images. Use this 
setting for presentation graphics, such as charts and 
graphics.

Colorimetric The best option when exact matching of colors is 
most important. This mode automatically adjusts the 
printout colors to match the colors on your monitor. 
Use this setting for printouts like a company logo.
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Save Settings

To save your Advanced settings in the Custom Settings list, click 
Save Settings in the Advanced dialog box. The Custom Settings 
dialog box appears.

Type a unique name for your settings in the Name text box, then 
click Save. The name can contain a total of up to 16 letters and 
numerals. You can also use up to eight, double-byte characters; 
however, they may not be displayed correctly on the screen 
depending on your operating system settings. Your custom 
setting will be added to the Custom Settings list, and the latest 
custom setting will be selected. You can save up to 100 custom 
settings.

To delete a setting from the Custom Settings list, select it in the 
Custom Settings dialog box and click Delete.

Using your saved settings

To use your saved settings, select Custom as the Mode setting in 
the Print dialog box, then select your setting in the Custom 
Settings list.

If you change the Media Type, Color, or other settings on the 
Advanced menu and then click OK while one of your custom 
settings is selected in the Custom Settings list on the Basic menu, 
the selection shown in the list returns to Custom Settings. The 
custom setting that was previously selected is not affected by the 
change and remains in the list. To return to your custom setting, 
simply reselect it from the Custom Settings list.
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If you delete a custom setting that was active when deleted or if 
it was the only custom setting, the Custom Settings list selection 
on the Basic menu returns to Custom Settings. To activate a 
remaining custom setting, simply select it from the Custom 
Settings list.

Setting the print time

You can specify the time when you want the printer to begin 
printing your document. Follow the steps below.

1. Click the  Background Printing icon button in the Print 
dialog box.

2. Make the appropriate Background Printing setting.

3. Select Urgent, Normal, Print at, or Hold as the Print Time 
setting.

If you select Print at, use the arrows beside the date and time 
boxes to specify the date and time when you want the 
document to be printed.

Note:
Make sure that the computer and printer are turned on at the date 
and time you specify.
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4. Click OK. The Background Printing dialog box closes.

5. In the Print dialog box, make sure that your print settings are 
as you want them, then click Print.

Note:
You can check or change the priority of print jobs using the EPSON 
MonitorIV utility.
& See “Using EPSON MonitorIV”

Previewing your printout

The Preview feature allows you to see how your document will 
look before actually printing it. Follow these steps to preview 
your document.

1. Make your printer driver settings.

2. Click the  Preview icon button in the Print dialog box. The 
Print button changes into the Preview button.

Note:
Use the  Preview icon button to cycle through the  Print, 

Preview, and Save File modes. Click the icon button to select 
the mode that you want, and click the button to the right of the icon 
to use the mode you have selected.
& See “Saving spool data as a file”
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3. Click the Preview button. The Preview dialog box opens and 
displays a preview of your document.

The Preview dialog box contains several icon buttons that you 
can use to perform the following functions.

Icon Button name Function

Edit 
Watermark

Click to select, move, and resize 
watermarks.

Zoom Click to enlarge or reduce the size of 
the previewed page.

Show/Hide 
Printable Area

Click to display or hide the borderlines 
which indicate the printable area. 
The printer cannot print anything that 
is outside of this area.

Show/Hide 
Watermark 
Settings

Click to open the Watermark Edit 
dialog box, where you can add 
watermarks to the document and 
change any of the current 
watermark settings.
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4. If you are satisfied with the previewed image, click Print.

If you are not satisfied with the appearance of the image, click 
Cancel. The Preview and Print dialog boxes close with the 
current print settings preserved. Open the Print dialog box 
again to make additional changes to the print settings.

Saving spool data as a file

You can save spool data as a file using the  Save File icon button 
in the Print dialog box. This feature lets you use the saved spool 
data to print the document at a later time simply by 
double-clicking the saved file. Follow the steps below.

Note:
Use the  Preview icon button to cycle through the  Print, 

Preview, and  Save File modes. Click the icon button to select the 
mode you want, and click the button to the right of the icon to use the 
mode you have selected.

1. Make your printer driver settings.

2. Click the  Preview icon button in the Print dialog box 
repeatedly until the Print button changes into the SaveFile 
button.

Add page Click to add or remove selected 
pages from the list of pages to be 
printed.

Remove page
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3. Click the SaveFile button. The following dialog box appears.

4. Select the location where you want to save the file, then type 
a file name in the Save As text box and click Save.

5. When you want to print the document, double-click the file 
to open EPSON MonitorIV, make sure that the correct 
document is selected, then click the  Resume button to send 
the data to the printer.
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Layout Dialog Box

You can modify the page layout of your document using the 
printer driver settings located in the Layout dialog box. To open 
this dialog box, click Print on the File menu of your application, 
then click the  Layout icon button in the Print dialog box.

Fit to Page Enlarges or reduces the size of the image to make it fit 
a selected paper size. Select the Fit to Page check 
box, and then select the paper size in the Output 
Paper Size list.
& See “Fit to Page Printing”

Watermark Prints a text or image as a watermark on your printout.
& See “Watermark Printing”
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Printer Utilities

EPSON printer utilities allow you to check the current printer 
status and maintain certain features of your printer from your 
computer.

To use the utilities, click the  Utility icon button in the Print or 
Page Setup dialog box, then click the button for the utility that 
you want to use.

Multi-Page Allows you to choose between the Pages per Sheet 
and Poster settings.

Pages per Sheet

Select this setting to print two or four pages of your 
document on one sheet of paper.
& See “Pages Per Sheet Printing”

Poster

A single document page can be enlarged to cover 4, 
9, or 16 printed sheets of paper. Select Poster to print 
a poster-size image.
& See “Poster Printing”

Print order Select Collate to print one complete document set at 
a time. Select Reverse Order to print your documents 
in reverse order, starting with the last page.
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EPSON 
StatusMonitor

Monitors the printer status. If it detects a printer error, 
it will inform you with an error message.

You can also use this utility to check how much ink 
is remaining before printing.

To use the EPSON StatusMonitor, click the 
EPSON StatusMonitor button.
& See “Using EPSON StatusMonitor”

Nozzle Check Checks the print head nozzles for clogging. Check 
the nozzles if you notice print quality has declined 
and after cleaning to confirm that the print head 
nozzles have been cleared. If the nozzle check 
indicates that the print head needs cleaning, you 
can access the Head Cleaning utility directly from 
the Nozzle Check utility.
& See “Checking the Print Head Nozzles”

Head Cleaning Cleans the print head. You may need to clean the 
print head if you notice print quality has declined. 
Use the Nozzle Check utility first to confirm that the 
print head needs to be cleaned.
& See “Cleaning the Print Head”

Print Head 
Alignment

The Print Head Alignment utility can be used to 
improve the print quality of your documents. The 
print head alignment may need to be adjusted if 
vertical lines appear out of alignment or if white, 
black, dark, or light banding appears in your 
documents. Follow the on-screen instructions for 
using this utility.
& See “Aligning the Print Head”

Configuration Click this button to open the Configuration dialog 
box, where you can change the method by which 
the EPSON Status Monitor utility notifies you when the 
printer status changes.
& See “Using the Configuration Settings dialog box”
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Getting Information Through Online Help

Your printer software has an extensive online help feature that 
provides you with instructions on printing, making printer driver 
settings, and using the printer utilities.

To access online help, choose Print or Page Setup from the File 
menu of your application. Then, click the  Help icon button.
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For Mac OS X

Printer Software Introduction

Printer driver dialog boxes

The printer software that comes with your printer includes a 
printer driver and printer utilities. The printer driver lets you 
choose from a wide variety of settings to get the best results from 
your printer. The printer utilities help you check the printer and 
keep it in top operating condition. Following dialog boxes are 
available.
& See “Page Setup Dialog Box”
& See “Print Dialog Box”
& See “EPSON Printer Utility”

Accessing the printer software

For information on accessing the printer software, see the 
following.

“Accessing the Printer Software for Mac OS X”

Getting more information

You can also get information by clicking the Help button when 
Print Settings or Color Management is selected in the Print 
dialog box. For the other setting, see your operating system’s 
documentation.
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Page Setup Dialog Box

Note: 
Page Setup dialog box is a standard feature of Mac OS X. See your 
operating system’s documentation for details.

Page Setup dialog box settings

Allows you to make the appropriate settings, Format for, Paper 
Size, Orientation and Scale settings that you want to use for 
printing.

Settings Page Attributes Displays the page setup 
settings.

Summary Displays the list of current 
setting items.

Format for Stylus C84 Prints with standard margins.

Stylus C84
(Sheet 
Feeder-Borderless)

Prints without margins.
& See “Borderless Printing”

Paper Size Select the paper size that you want to use.
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& See “Printable area”

Note:
Always match the Format for setting in the Page Setup dialog box and 
the Printer setting in the Print dialog box. Otherwise the data may not 
be printed correctly.

Print Dialog Box

Note:
Print dialog box is the standard feature of Mac OS X. See your operating 
system’s documentation for details.

Orientation Select the printing orientation.

Scale Input the scale to reduce or enlarge the size of your data.
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Print dialog box settings

Allows you to make the appropriate Printer and Presets settings 
that you want to use for printing.

& See “Printable area”

Note:
Always match the Format for setting in the Page Setup dialog box and 
the Printer setting in the Print dialog box. Otherwise the data may not 
be printed correctly.

Copies & Pages

Allows you to make the appropriate Copies, Collated, Pages 
settings that you want to use for printing.

Note:
Copies & Pages is the standard feature of Mac OS X. See your operating 
system’s documentation for details.

Layout 

Allows you to make the appropriate Pages per Sheet, Layout 
Direction, and Border settings that you want to use for printing.

Note:
Layout is the standard feature of Mac OS X. See your operating system’s 
documentation for details.

Printer Stylus C84 Prints with standard margins.

Stylus C84
(Sheet 
Feeder-Borderless)

Prints without margins.
& See “Borderless Printing”

Presets Standard Prints with the current settings.

Custom Prints with the custom saved 
settings.
& See “Save Custom Setting”
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Output Options

Clear the Save as file check box when you want to print.

Note:
Output Options is the standard feature of Mac OS X. See your operating 
system’s documentation for details.

Print Settings

Media Type

Determines what other settings are available in the Print dialog 
box, so you should always make this setting first. Select the Media 
Type setting that matched the paper that is loaded in the printer. 
To find what media type you are using, find your media in the 
Media Type Setting list.

“Media Type Settings”
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Note:
For the latest information on available media, visit our regional customer 
support web site.
& See “Contacting Customer Support”

Color

Automatic mode

Provides the quickest and easiest way to start printing. The 
printer software takes care of all detailed settings based on the 
current Media Type and Color settings.

Note:
Depending on the media selected in the Media Type list (while 
Automatic is selected), a slider appears to the right of the Mode options, 
which lets you choose Quality or Speed level. Select Quality when print 
quality is more important than speed.

Advanced mode

Selecting Advanced as the Mode setting gives you complete 
control over your printing environment. Use these settings to 
experiment with new printing ideas or to fine-tune a range of 
print settings to meet your individual needs.

Print Quality

Select the printing quality that you want to use for printing.

Super MicroWeave

Gives you slightly more detail, but print times will be longer. You 
can select when selecting Photo RPM from the Print Quality list.

Black Prints in black and white or grayscale.

Color Prints in color.
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High Speed

Activates bidirectional printing so your printer prints both 
left-to-right and right-to-left. High Speed mode speeds up 
printing, but decreases print quality.

Mirror Image

Prints an image as it would appear in a mirror. Text and graphics 
appear reversed.

Fast Feed

Increases the speed at which paper is fed into the printer. Fast 
Feed mode speeds up printing, but also increases printing noise.

Note:
Some settings may not be available, depending on the Media Type, Color, 
and Print Quality settings that you make.
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Color Management

Selecting Color Management from the pop-up menu gives you 
control over the color matching and adjustment methods 
provided with the printer driver. Use these settings to experiment 
with new printing ideas or to fine-tune a range of print settings 
to meet your individual needs. Once you are satisfied with your 
new settings, you can add them to the Custom Settings list in the 
Print dialog box.
& See “Save Custom Setting”

Color Controls

Select this setting to use the color matching and adjustment 
methods provided with the printer driver.

Gamma

To control image contrast by modifying the midtones and 
mid-level grays.
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Mode

Slide bars

The color enhancement slide bars adjust the indicated options in 
a range of -25% to +25%. Drag the slide bar to the right or left with 
your mouse to adjust the settings. You can also type a value from 
-25% to +25% in the boxes next to the slide bars.

ColorSync

Automatically adjusts the printout colors to match the colors on 
your monitor.

No Color Adjustment 

Prints without any color adjustment.

Expansion

Using the slider, you can control the amount of the image that 
extends beyond the edges of the paper during borderless printing.

For most print jobs, selecting Max is recommended in order to 
eliminate margins on all sides of the paper. Moving the slider 
towards Min decreases the amount of the image that extends 
beyond the edges of the paper; however, as this amount 
decreases, margins may begin to appear on one or more sides of 
the paper.

EPSON Vivid Based on your data, enhances color balance for 
optimum print results. This setting is recommended for 
most print jobs.

Charts and 
Graphs

Intensifies the colors and lightens the midtones and 
highlights of an image. Use this setting for 
presentation graphics, such as charts and graphs.
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Summary

Displays the list of current setting items.

Note:
Summary is the standard feature of Mac OS X. See your operating 
system’s documentation for details.

Save Custom Setting

Saves the current settings as the Custom setting on the Presets.

Note:
Save Custom Setting is the standard feature of Mac OS X. See your 
operating system’s documentation for details.

Preview Button

Allows you to see how your document will look before actually 
printing it.

Note:
Preview button is the standard feature of Mac OS X. See your operating 
system’s documentation for details.
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EPSON Printer Utility

EPSON printer utility functions

EPSON printer utilities allow you to check the current printer 
status and perform certain maintenance procedures from your 
computer.

EPSON 
StatusMonitor

Monitors the printer status. If it detects a printer 
error, it will inform you with an error message.

You can also use this utility to check how much ink 
is remaining before printing.

To use the EPSON StatusMonitor, click the EPSON 
StatusMonitor button.
& See “Using EPSON StatusMonitor”
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Nozzle Check Checks the print head nozzles for clogging. Check 
the nozzles if you notice print quality has declined 
and after cleaning, to confirm that the print head 
nozzles have been cleared. If the nozzle check 
indicates that the print head needs cleaning, you 
can access the Head Cleaning utility directly from 
the Nozzle Check utility.
& See “Checking the Print Head Nozzles”

Head Cleaning The Head Cleaning utility cleans the print head. 
You may need to clean the print head if you notice 
print quality has declined. Use the Nozzle Check 
utility first to confirm that the print head needs to 
be cleaned.
& See “Cleaning the Print Head”

Print Head 
Alignment

The Print Head Alignment utility can be used to 
improve the print quality of your documents. The 
print head alignment may need to be adjusted if 
vertical lines appear out of alignment or if white, 
black, dark, or light banding appears in your 
documents. Follow the on-screen instructions for 
using this utility.
& See “Aligning the Print Head”
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Replacing Ink Cartridges

Replacing an Empty Ink Cartridge

This printer uses ink cartridges equipped with IC chips. The IC 
chip accurately monitors the amount of ink used by each 
cartridge, so even if a cartridge is removed and later reinserted, 
all of its ink can be used. However, some ink is consumed each 
time the cartridge is inserted because the printer automatically 
checks reliability.

You can replace an ink cartridge using the printer’s control panel 
or using the EPSON Status Monitor utility. Refer to the 
appropriate section below for instructions.

w
Warning:
❏ Keep ink cartridges out of the reach of children. Do not allow 

children to drink from or otherwise handle the cartridges.

❏ Be careful when you handle the used ink cartridges, as there 
may be some ink around the ink supply port. If ink gets on 
your skin, wash the area thoroughly with soap and water. If 
ink gets into your eyes, flush them immediately with water. 
If discomfort or vision problems continue after a thorough 
flushing, see a doctor immediately.
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c
Caution:
❏ EPSON recommends the use of genuine EPSON ink 

cartridges. Other products not manufactured by EPSON 
may cause printer damage that is not covered by EPSON's 
warranties.

❏ Leave the old cartridge installed in the printer until you have 
obtained a replacement; otherwise, ink remaining in the print 
head nozzles may dry out.

❏ Do not refill the ink cartridges. The printer calculates the 
amount of ink remaining using an IC chip on the ink 
cartridge. Even if the cartridge is refilled, the amount of ink 
remaining will not be recalculated by the IC chip and the 
amount of ink available for use will not change.

Note:
❏ You cannot continue printing with one ink cartridge empty, even if 

the other cartridges still contains ink. Before printing, replace the 
empty cartridge.

❏ In addition to the ink used during document printing, ink is 
consumed during the print head cleaning operation, during the 
self-cleaning cycle (performed when the printer is turned on), and 
during ink charging when the ink cartridge is installed in the 
printer.

For more information about ink cartridges, see the Safety 
Instructions.

Using the printer's control panel buttons

The printer’s lights will inform you when it is time to obtain a 
replacement ink cartridge and when it is time to replace an empty 
cartridge.
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This table describes the status of the lights on your printer and 
the required actions you need to take.

To replace an ink cartridge using the H ink button, follow the steps 
below.

Note:
The illustrations show replacement of the black ink cartridge. Replace 
the ink cartridge appropriate to your situation.

1. Make sure that the printer is on. The P power light should be 
on, but not flashing.

2. Lower the output tray, and then open the printer cover.

3. Press the H ink button. The print head moves to the ink 
cartridge check position and the P power light begins to flash. 
The ink cartridge indicated by the _ mark is either empty or 
low.

Note:
❏ If an ink cartridge is low, you may continue to use it until it is 

empty. To confirm the level of ink remaining in each cartridge, 
see the following.
& See “Using EPSON Status Monitor 3” for Windows
& See “Using EPSON StatusMonitor” for Macintosh

Lights Action

Obtain a replacement black ink cartridge (T0431, 
T0441), cyan ink cartridge (T0442, T0452), magenta ink 
cartridge (T0443, T0453), or yellow ink cartridge (T0444, 
T0454).

Replace the empty ink cartridge.
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❏ Do not press the H ink button for more than three seconds. 
Otherwise the printer starts cleaning the print head.

c
Caution:
Do not move the print head by hand, as this may damage the 
printer. Always press the H ink button to move it.

4. Press the H ink button.
If more than one ink cartridge is empty or low, the print head 
moves to the _ mark. This occurs each time the H ink button 
is pressed until all empty or low ink cartridges have been 
indicated.
Once all of the empty or low ink cartridges have been 
indicated, the print head moves to the ink cartridge 
replacement position when the H ink button is pressed.
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5. For best results, shake the ink cartridge four or five times 
before opening the package.

6. Remove the new ink cartridge from the package.
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c
Caution:
❏ Be careful not to break the hooks on the side of the ink 

cartridge when you remove it from the package.

❏ Do not remove or tear the label on the cartridge; 
otherwise, ink will leak.

❏ Do not touch the green IC chip on the side of the 
cartridge. This can damage the ink cartridge.

❏ If an ink cartridge is temporarily removed from the 
printer, be sure to protect the ink supply port of the ink 
cartridge from dirt and dust; store it in the same 
environment as the printer. Store ink cartridge with its 
label facing upward. Do not store cartridge upside down. 
Note that there is a valve in the ink supply port, making 
covers or plugs unnecessary, but care is needed to 
prevent the ink from staining items that the cartridge 
touches. Do not touch the ink supply port or surrounding 
area.

❏ Be sure to always install an ink cartridge into the printer 
immediately following the removal of the current ink 
cartridge. If the ink cartridge is not installed promptly, 
the print head may dry out, rendering it unable to print.
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7. Open the cartridge cover. Pinch the sides of the ink cartridge 
that you want to replace. Lift the cartridge out of the printer 
and dispose of it properly. Do not take the used cartridge 
apart or try to refill it.

w
Warning:
If ink gets on your hands, wash them thoroughly with soap 
and water. If ink gets into your eyes, flush them immediately 
with water. If discomfort or vision problems continue after a 
thorough flushing, see a doctor immediately.

8. Place the ink cartridge vertically into the cartridge holder. 
Then, push the ink cartridge down until it clicks into place.
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9. When you are finished replacing the cartridge, close the 
cartridge cover and the printer cover.

10. Press the H ink button. The printer moves the print head and 
begins charging the ink delivery system. This process takes 
about one minute to complete. When the ink charging process 
is finished, the printer returns the print head to its home 
position. The P power light stop flashing and remains on, and 
the H ink out light goes out.

c
Caution: 
The P power light continues to flash while the printer 
performs the ink charging operation. Never turn off the 
printer while this light is flashing. Doing so can result in 
incomplete charging of ink.

Note:
If the ink end error occurs after the print head moves to its home 
position, the ink cartridge may not be installed properly. Press the 
H ink button again, and reinstall the ink cartridge until it clicks into 
place.



157

R4CD000_UK
html.bk Rev. E
INK.FM A5 size
6/10/03

RProof Sign-off:
S.Kodama CRE Kawakami
M.Otsuka
editorname

Using the EPSON Status Monitor

You can monitor the remaining ink levels from your computer 
and view on-screen instructions for replacing a low or empty ink 
cartridge using EPSON Status Monitor 3 (Windows) or 
EPSON StatusMonitor (Macintosh).

When an ink cartridge is low or empty, click How to in the EPSON 
Status Monitor window. Follow the on-screen instructions to 
replace the cartridge.

For more information on using EPSON Status Monitor, see the 
section below.
& See “Using EPSON Status Monitor 3” for Windows
& See “Using EPSON StatusMonitor” for Macintosh

Replacing an Ink Cartridge

In some circumstances, you may need to replace an ink cartridge 
before it is empty.

If the H ink out light is flashing or is on, replace the empty ink 
cartridge as described in the section below.
& See “Replacing an Empty Ink Cartridge”

To replace an ink cartridge before the H ink out light flashes or the 
EPSON Status Monitor notifies you that the cartridge is empty, 
follow the instructions in this section.

You can replace an ink cartridge using the printer’s control panel 
or using the printer utilities (for Windows).
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w
Warning:
❏ Keep ink cartridges out of the reach of children. Do not allow 

children to drink from or otherwise handle the cartridges.

❏ Be careful when you handle the used ink cartridges, as there 
may be some ink around the ink supply port. If ink gets on 
your skin, wash the area thoroughly with soap and water. If 
ink gets into your eyes, flush them immediately with water. 
If discomfort or vision problems remain after a thorough 
flushing, see a doctor immediately.

c
Caution:
❏ EPSON recommends the use of genuine EPSON ink 

cartridges. Other products not manufactured by EPSON 
may cause damage to your printer not covered by EPSON’s 
warranties.

❏ Leave the old cartridge installed in the printer until you have 
obtained a replacement; otherwise, ink remaining in the print 
head nozzles may dry out.

❏ Do not refill the ink cartridges. The printer calculates the 
amount of ink remaining using an IC chip on the ink 
cartridge. Even if the cartridge is refilled, the amount of ink 
remaining will not be recalculated by the IC chip and the 
amount of ink available for use will not change.

Note:
❏ You cannot continue printing with one ink cartridge empty, even if 

the other cartridge still contains ink. Before printing, replace the 
empty cartridge.

❏ In addition to the ink used during document printing, ink is 
consumed during the print head cleaning operation, during the 
self-cleaning cycle which is performed when the printer is turned 
on, and during ink charging when the ink cartridge is installed in 
the printer.
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Using the printer’s control panel buttons

c
Caution:
Do not remove the cartridge from the printer until you are ready 
to replace it with another.

Note:
The illustrations show replacement of the black ink cartridge. Replace 
the ink cartridge appropriate to your situation.

1. Make sure that the printer is on. The P power light should be 
on, but not flashing.

2. For best results, shake the ink cartridge four or five times 
before opening the package.

3. Remove the new ink cartridge from the package.
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c
Caution:
❏ Be careful not to break the hooks on the side of the ink 

cartridge when you remove it from the package.

❏ Do not remove or tear the label on the cartridge; 
otherwise, ink will leak.

❏ Do not touch the green IC chip on the side of the 
cartridge. This can damage the ink cartridge.

❏ If an ink cartridge is temporarily removed from the 
printer, be sure to protect the ink supply port of the ink 
cartridge from dirt and dust; store it in the same 
environment as the printer. Store ink cartridge with its 
label facing upward. Do not store cartridge upside down. 
Note that there is a valve in the ink supply port, making 
covers or plugs unnecessary, but care is needed to 
prevent the ink from staining items that the cartridge 
touches. Do not touch the ink supply port or surrounding 
area.

❏ Be sure to always install an ink cartridge into the printer 
immediately following the removal of the current ink 
cartridge. If the ink cartridge is not installed promptly, 
the print head may dry out, rendering it unable to print.

4. Lower the output tray, then open the printer cover.
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5. Press the H ink button. The print head moves to the ink 
cartridge replacement position, and the P power light begins 
to flash.

Note:
Do not press the H ink button over three seconds. Otherwise the 
printer starts cleaning the print head.

c
Caution:
Do not move the print head by hand, as this may damage the 
printer. Always press the H ink button to move it.

6. Open the cartridge cover. Pinch the sides of the ink cartridge 
that you want to replace, then lift the cartridge out of the 
printer and dispose of it properly.
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w
Warning:
If ink gets on your hands, wash them thoroughly with soap 
and water. If ink gets into your eyes, flush them immediately 
with water. If discomfort or vision problems continue after a 
thorough flushing, see a doctor immediately.

7. Place the ink cartridge vertically into the cartridge holder. 
Push the ink cartridge down until it clicks into place.

8. When you are finished replacing the cartridge, close the 
cartridge cover and the printer cover.
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9. Press the H ink button. The print head moves and the ink 
delivery system begins to charge. This process takes about one 
minute to complete. When the ink charging process is 
finished, the printer returns the print head to its home 
position. The P power light stops flashing and remains on, 
and the H ink out light goes out.

c
Caution:
The P power light continues to flash while the printer 
performs the ink charging operation. Never turn off the 
printer while this light is flashing. Doing so can result in 
incomplete charging of ink.

Note:
If the ink end error occurs after the print head moves to its home 
position, the ink cartridge may not be installed properly. Press the 
H ink button again, and reinstall the ink cartridge until it clicks into 
place.

Using the Printer Utilities (for Windows)

You can view on-screen instructions for replacing an ink cartridge 
using the printer utilities.

When you need to replace an ink cartridge before it is low or 
empty, click the button on the Maintenance tab.
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For more information on using the printer utilities, see the section 
below.
& See “Making Settings on the Maintenance Menu”

Checking the Ink Supply

For Windows

You can check the amount of ink remaining in the ink cartridges 
using EPSON Status Monitor 3 or the progress meter. Refer to the 
appropriate section below for details.

EPSON Status Monitor 3

Access EPSON Status Monitor 3 in one of the following ways.

❏ Double-click the printer-shaped shortcut icon on your 
Windows taskbar. To add a shortcut icon to the taskbar, see 
the section below.
& See “Monitoring Preferences”

❏ Open the printer software, click the Maintenance tab, then 
click the EPSON Status Monitor 3 button.



165

R4CD000_UK
html.bk Rev. E
INK.FM A5 size
6/10/03

RProof Sign-off:
S.Kodama CRE Kawakami
M.Otsuka
editorname

A graphic displays the remaining amount of ink.

Note:
If any of the ink cartridges installed in the printer is broken, incompatible 
with the printer model, or improperly installed, 
EPSON Status Monitor 3 will not display an accurate calculation for 
the amount of ink remaining in any of the ink cartridges. Be sure to 
replace or reinstall any ink cartridge indicated by 
EPSON Status Monitor 3.
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Progress meter

The progress meter dialog box appears automatically when you 
send a print job to the printer. You can check the remaining 
amount of ink from this dialog box.

For Macintosh

You can check the amount of ink remaining in the ink cartridges 
using EPSON StatusMonitor. Follow the steps below.

For Mac OS 8.6 to 9.x

1. Access the Print or Page Setup dialog box

“Accessing the Printer Software for Mac OS 8.6 to 9.x”

2. Click the Utility icon button, then click the 
EPSON StatusMonitor button in the Utility dialog box.
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A graphic displaying the remaining amount of ink appears.

Note:
❏ The graphic displays the amount of ink that was remaining 

when EPSON StatusMonitor was first opened. To update the 
ink-level information, click Update.

❏ If any one of the ink cartridges that are installed in the printer 
is broken, incompatible to the printer model, or is installed 
improperly, the EPSON StatusMonitor will not display an 
accurate calculation for the amount of ink remaining in any of 
the ink cartridges. Be sure to replace or reinstall any ink 
cartridge when indicated by the EPSON StatusMonitor.

For users of Mac OS X

1. Double-click Macintosh HD (the default hard disk name), 
double-click the Applications folder, then double-click the 
EPSON Printer Utility icon. The Printer List window appears.

2. Select your printer, then click OK. The EPSON Printer Utility 
dialog box appears.
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3. Click the EPSON StatusMonitor button. The 
EPSON StatusMonitor dialog box appears.

Note:
❏ The graphic displays the amount of ink that remained when 

EPSON StatusMonitor was first opened. To update the ink-level 
information, click Update.

❏ If any one of the ink cartridges that are installed in the printer is 
broken, incompatible to the printer model, or is installed improperly, 
the EPSON StatusMonitor will not display an accurate calculation 
for the amount of ink remaining in any of the ink cartridges. Be sure 
to replace or reinstall any ink cartridge when indicated by the 
EPSON StatusMonitor.
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Improving Print Quality

Checking the Printer Status

For Windows

Using the progress meter

When you send a print job to the printer, the progress meter 
appears, as shown in the illustration below.

The progress meter indicates the progress of the current print job 
and provides printer status information when bidirectional 
communication between the printer and the computer is 
established. This meter also displays error messages as well as 
helpful tips for better printing. Refer to the appropriate section 
below.
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Epson Printing Tips

Tips for getting the most out of your EPSON printer software 
appear in the text box at the bottom of the progress meter window. 
A new tip appears every 30 seconds. For more details on the tip 
displayed in the window, click the Details button.

Error messages

If a problem occurs during printing, an error message appears in 
the text box at the top of the progress meter window. For more 
detailed information, click Technical Support to access the 
online Reference Guide.

When the ink runs low or out, a How to button appears below 
the text box. Click How to, and EPSON Status Monitor 3 will lead 
you step-by-step through the cartridge replacement procedure.
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Using EPSON Spool Manager

EPSON Spool Manager is similar to Windows Print Manager. If 
it receives two or more print jobs at one time, it holds them in the 
order that they were received (with printers on a network, this 
may be called a print queue). When a print job reaches the top of 
the line, EPSON Spool Manager sends the job to the printer. From 
the spool manager, you can view print status information about 
the print jobs that have been sent to your printer. You can also 
cancel, pause, and resume selected print jobs.

Note:
EPSON Spool Manager is not available with Windows XP, 2000, and 
NT 4.0.

After you send a print job, an EPSON Stylus C84 button appears 
on the taskbar. Click this button to open EPSON Spool Manager.

Using EPSON Status Monitor 3

EPSON Status Monitor 3 displays detailed information on the 
printer status.

Note:
Before using EPSON Status Monitor 3, be sure to read its README 
file. To open this file, click Start, point to Programs (for Windows Me, 
98, 95, 2000, and NT 4.0) or All Programs (for Windows XP), point 
to EPSON or EPSON Printers, then click EPSON Stylus C84 
Readme.
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Accessing EPSON Status Monitor 3

There are two ways to access EPSON Status Monitor 3:

❏ Double-click the printer-shaped shortcut icon on the 
Windows taskbar.
& See “Monitoring Preferences”

❏ Open the printer software, click the Utility tab, then click the 
EPSON Status Monitor 3 button.

When you access EPSON Status Monitor 3, the following window 
appears.

Viewing information in EPSON Status Monitor 3

EPSON Status Monitor 3 provides the following information:

❏ Current Status:
EPSON Status Monitor 3 provides you with detailed printer 
status information, a graphic display, and status messages. If 
the ink runs low or out, the How to button appears in the 
EPSON Status Monitor 3 window. Clicking How to displays 
ink cartridge replacement instructions and moves the print 
head to the ink cartridge replacement position.
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❏ Ink Levels:
EPSON Status Monitor 3 provides a graphic display of the 
amount of ink remaining and an estimate of the number of 
pages that can be printed before ink runs out.

❏ Ink Cartridge Information: 
You can view information about the installed ink cartridges 
by clicking Information.

❏ Technical Support
You can access the online Reference Guide from 
EPSON Status Monitor 3. If you encounter a problem, click 
Technical Support in the EPSON Status Monitor 3 window.

For Macintosh

Using EPSON StatusMonitor

EPSON StatusMonitor monitors the printer. If it detects a printer 
error, it will inform you with an error message.

When the ink runs low or out, a How to button appears. Click 
How to, and EPSON StatusMonitor will lead you step by step 
through the ink cartridge replacement procedure.
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You can also use this utility to check ink levels before printing. 
When open, EPSON StatusMonitor displays the amount of ink 
remaining at the time it was opened. To update the ink level 
information, click Update.

Accessing EPSON StatusMonitor

Follow the steps below to access EPSON StatusMonitor.

For Mac OS 8.6 to 9.x

1. Access the Print dialog box.

“Accessing the Printer Software for Mac OS 8.6 to 9.x”

2. Click the StatusMonitor icon button, or click the Utility 
icon button then the EPSON StatusMonitor button in the 
Utility dialog box. The EPSON StatusMonitor dialog box 
appears.

For Mac OS X

1. Access the EPSON Printer Utility dialog box.

“Accessing the Printer Software for Mac OS X”
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2. Select your printer, then click OK. The EPSON Printer Utility 
dialog box appears.

3. Click the EPSON StatusMonitor button. The 
EPSON StatusMonitor dialog box appears.

Using the Configuration Settings dialog box

To change the way that the EPSON StatusMonitor utility 
monitors your printer, or to change the way that your printer 
handles print jobs, follow the steps below.

Note:
This feature is not available with Mac OS X.

1. Click Print or Page Setup on the File menu of your 
application.

2. Click the Utility icon button.
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3. Click Configuration. The Configuration Settings dialog box 
appears.

In the Configuration Settings dialog box, you can make the 
following settings.

Error notification Choose the way EPSON StatusMonitor notifies 
you in case of an error.

Warning Choose the way EPSON StatusMonitor notifies 
you of a warning message.

Temporary Spool folder Specify the folder in which print data will be 
temporarily stored.

Temporary High Speed 
Copies folder

Specify the folder in which multiple-copy print 
data will be temporarily stored.

Data will be sent to the 
printer after being stored 
on your disk.

Select this check box to prevent horizontal 
banding in printouts that contain images, by 
temporarily storing image data on the 
computer’s hard drive. The computer will then 
send the image data to the printer as a whole 
rather than as rectangular bands.

Check for errors before 
starting to print.

Select this check box to have the printer 
check for errors before starting to print.

Check the ink level 
before starting to print.

Select this check box to have the printer 
check the ink levels before starting to print.
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Using EPSON MonitorIV

After you send a print job to the printer, you can use the EPSON 
MonitorIV utility to check, cancel, or change the priority of print 
jobs that are queued for printing. This utility also shows the status 
of the job currently being printed.

Note:
This feature is not available with Mac OS X.

Accessing EPSON MonitorIV

To access EPSON MonitorIV, follow these steps.

1. First, turn on Background Printing in the Chooser or in the 
Background Printing dialog box.

2. Send a print job to the printer.

3. Select EPSON MonitorIV from the Application menu at the 
right end of the menu bar. The EPSON MonitorIV dialog box 
appears.

Note:
You can also open EPSON MonitorIV by double-clicking the EPSON 
MonitorIV icon in the Extensions folder.
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Managing print jobs using EPSON MonitorIV

Using EPSON MonitorIV, you can manage print jobs as described 
below:

❏ Use the buttons below to hold, resume, and delete print jobs. 
Select the print job that you want to manage, then click the 
appropriate button.

❏ Click Stop Print Queue to stop printing. Click Start Print 
Queue to resume printing.

❏ Use the buttons below to start the printer utilities.

❏ Double-click a file in the list to preview it. (this function is 
disabled when you are printing the ESC/P command file.)

❏ Double-click Copies to change the number of copies of the 
selected print job that will be printed.

Hold Pauses printing and keeps the current 
print job at the top of the print queue.

Resume Resumes printing.

Delete Stops printing and deletes the print job 
from the print queue.

Print head 
cleaning

Starts the Print Head Cleaning utility.

StatusMonitor Starts EPSON Status Monitor, which 
displays the amount of ink remaining.
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❏ Click the Show details arrow to open an extension (similar to 
the one below) at the bottom of the EPSON MonitorIV dialog 
box. The extension displays detailed information on the 
selected document’s printer software settings.

Changing the priority of print jobs

To change the priority of print jobs in a print queue, follow the 
steps in this section.

Note:
You can also change the priority of print jobs whose print times were 
previously set in the printer software’s Background Printing dialog box.

1. In the Document Name column, select the print job for which 
you want to change the priority.



180

R4CD000_UK
html.bk Rev. E
CHECK.FM A5 size
6/10/03

L Proof Sign-off:
S.Kodama CRE Kawakami
M.Otsuka
editorname

2. Click the Show details arrow to open an extension (similar to 
the one below) at the bottom of the EPSON MonitorIV dialog 
box.

3. From the Priority list, select Urgent, Normal, Hold, or Print 
Time.

Note:
If you select Print Time, a dialog box appears, allowing you to 
specify the date and time when the document will be printed. Make 
sure that your printer and computer are turned on at the specified 
time.

Checking the Print Head Nozzles

If you find that the printout is unexpectedly faint or that dots are 
missing, you may be able to identify the problem by checking the 
print head nozzles.



181

R4CD000_UK
html.bk Rev. E
CHECK.FM A5 size
6/10/03

RProof Sign-off:
S.Kodama CRE Kawakami
M.Otsuka
editorname

You can check the print head nozzles from your computer using 
the Nozzle Check utility in the printer software or from the printer 
itself by using the printer’s control panel buttons.

Note:
If the H ink out light is flashing, you cannot clean the print head. Replace 
the appropriate ink cartridge first.

Using the Nozzle Check utility

Refer to the appropriate section below to use the Nozzle Check 
utility.

For Windows

Follow the steps below to use the Nozzle Check utility.

1. Make sure that A4 or Letter size paper is loaded in the sheet 
feeder.

2. Access the printer software.

“Accessing the Printer Software for Windows”

3. Click the Maintenance tab, then click the Nozzle Check 
button.

4. Follow the on-screen instructions.

For Mac OS 8.6 to 9.x

Follow the steps below to use the Nozzle Check utility.

1. Make sure that A4 or Letter size paper is loaded in the sheet 
feeder.

2. Access the Print or Page Setup dialog box.
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“Accessing the Printer Software for Mac OS 8.6 to 9.x”

3. Click the Utility icon button, then click the Nozzle Check 
button in the Utility dialog box.

4. Follow the on-screen instructions.

For Mac OS X

Follow the steps below to use the Nozzle Check utility.

1. Make sure that A4 or Letter size paper is loaded in the sheet 
feeder.

2. Access the EPSON Printer Utility dialog box.

“Accessing the Printer Software for Mac OS X”

3. Select your printer, then click OK in the Printer List window. 

4. Click the Nozzle Check button in the Utility dialog box.

5. Follow the on-screen instructions.

Using the control panel buttons

Follow the steps below to check the print head nozzles using the 
control panel buttons.

1. Turn off your printer.

2. Make sure that A4 or Letter size paper is loaded in the sheet 
feeder.
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3. Hold down the ) paper button and the P power button to 
turn on the printer.

4. Release only the P power button when the printer turns on. 
When the nozzle check starts, release the ) paper button 
also.

Below are two sample nozzle check patterns.

Good sample

Print head needs to be cleaned
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If the nozzle check page does not print satisfactorily, there is a 
problem with the printer. This could be a clogged ink nozzle or a 
misaligned print head.
& See “Cleaning the Print Head”
& See “Aligning the Print Head”

Cleaning the Print Head

If you find that the printout is unexpectedly faint or that dots are 
missing, you may be able to solve these problems by cleaning the 
print head, which ensures that the nozzles are delivering ink 
properly.

You can clean the print head from your computer using the Head 
Cleaning utility in the printer software or from the printer itself 
by using the printer’s control panel buttons.

Note:
❏ Print head cleaning consumes some ink. To avoid wasting ink, clean 

the print head only if print quality declines; for example, if the 
printout is blurry or the color is incorrect or missing.

❏ Use the Nozzle Check utility first to confirm that the print head 
needs to be cleaned. This saves ink.

❏ When the H ink out light is flashing or on, you cannot clean the print 
head. Replace the appropriate ink cartridge first.

Using the Head Cleaning utility

Refer to the appropriate section below to use the Head Cleaning 
utility.
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For Windows

Follow the steps below to clean the print head using the Head 
Cleaning utility.

1. Make sure that the printer is turned on and the H ink out light 
is off.

2. Access the printer software.

“Accessing the Printer Software for Windows”

3. Click the Maintenance tab, then click the Head Cleaning 
button.

4. Follow the on-screen instructions.

The P power light flashes while the printer performs the 
cleaning cycle.

c
Caution:
Never turn off the printer while the P power light is flashing. 
Doing so may damage the printer.

5. When the P power light stops flashing, load a few sheets of 
paper and click Print Nozzle Check Pattern in the Head 
Cleaning dialog box to confirm that the print head is clean.
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Below are two sample nozzle check patterns:

Good sample

Print head needs to be cleaned

If the nozzle check page does not print satisfactorily, you may 
need to repeat the head cleaning and print the nozzle check 
pattern again.
& See “Cleaning the Print Head”

Note:
❏ If print quality has not improved after repeating this procedure four 

or five times, turn the printer off and leave it alone overnight. Then, 
do the nozzle check again, and repeat the head cleaning if necessary.

❏ If the print quality still has not improved, at least one of your ink 
cartridges may be old or damaged and may need to be replaced.
& See “Replacing an Ink Cartridge” to replace an ink cartridge 
before it is empty.

❏ If print quality remains a problem after replacing the ink cartridges, 
contact your dealer.

❏ To maintain print quality, we recommend printing a few pages at 
least once every month.
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For Mac OS 8.6 to 9.x

Follow the steps below to clean the print head using the Head 
Cleaning utility.

1. Make sure that the printer is turned on and the H ink out light 
is off.

2. Access the Print or Page Setup dialog box.

“Accessing the Printer Software for Mac OS 8.6 to 9.x”

3. Click the Utility icon button, then click the Head 
Cleaning button.

4. Follow the on-screen instructions.

The P power light flashes while the printer performs the 
cleaning cycle.

c
Caution:
Never turn off the printer while the P power light is flashing. 
Doing so may damage the printer.

5. When the P power light stops flashing, click the 
Confirmation button in the Head Cleaning dialog box to 
print a nozzle check pattern. Use the check pattern to confirm 
that the print head is clean.
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Below are two sample nozzle check patterns.

Good sample

Print head needs to be cleaned

If the nozzle check page does not print satisfactorily, you may 
need to repeat the head cleaning and print the nozzle check 
pattern again.
& See “Cleaning the Print Head”

Note:
❏ If print quality has not improved after repeating this procedure four 

or five times, turn the printer off and leave it alone overnight. Then, 
do the nozzle check again, and repeat the head cleaning if necessary.

❏ If the print quality still has not improved, at least one of your ink 
cartridges may be old or damaged and may need to be replaced.
& See “Replacing an Ink Cartridge” to replace an ink cartridge 
before it is empty.

❏ If print quality remains a problem after replacing the ink cartridges, 
contact your dealer.

❏ To maintain print quality, we recommend printing a few pages at 
least once every month.
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For Mac OS X

Follow the steps below to clean the print head using the Head 
Cleaning utility.

1. Make sure that the printer is turned on and the H ink out light 
is off.

2. Access the EPSON Printer Utility dialog box.

“Accessing the Printer Software for Mac OS X”

3. Select your printer, then click OK in the Printer List window.

4. Click the Head Cleaning button in the Utility dialog box.

5. Follow the on-screen instructions.

The P power light flashes while the printer performs the 
cleaning cycle.

c
Caution:
Never turn off the printer while the P power light is flashing. 
Doing so may damage the printer.

6. When the P power light stops flashing, click the 
Confirmation button in the Head Cleaning dialog box to 
print a nozzle check pattern. Use the check pattern to confirm 
that the print head is clean.
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Below are two sample nozzle check patterns.

Good sample

Print head needs to be cleaned

If the nozzle check page does not print satisfactorily, you may 
need to repeat the head cleaning and print the nozzle check 
pattern again.
& See “Cleaning the Print Head”

Note:
❏ If print quality has not improved after repeating this procedure four 

or five times, turn the printer off and leave it alone overnight. Then, 
do the nozzle check again, and repeat the head cleaning if necessary.

❏ If the print quality still has not improved, at least one of your ink 
cartridges may be old or damaged and may need to be replaced.
& See “Replacing an Ink Cartridge” to replace an ink cartridge 
before it is empty.

❏ If print quality remains a problem after replacing the ink cartridges, 
contact your dealer.

❏ To maintain print quality, we recommend printing a few pages at 
least once every month.
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Using the control panel buttons

Follow the steps below to clean the print head using the control 
panel buttons.

1. Make sure that the P power light is on and the H ink out light 
is off. Then, hold down the H ink button for three seconds.

The printer starts cleaning the print head and the P power 
light begins flashing.

c
Caution:
Never turn off the printer while the P power light is flashing. 
Doing so may damage the printer.

2. When the P power light stops flashing, print a nozzle check 
pattern to confirm that the head is clean.
& See “Checking the Print Head Nozzles”

Note:
❏ If print quality has not improved after repeating this procedure four 

or five times, turn the printer off and leave it alone overnight. Then, 
do the nozzle check again, and repeat the head cleaning if necessary.

❏ If the print quality still has not improved, at least one of your ink 
cartridges may be old or damaged and may need to be replaced.
& See “Replacing an Ink Cartridge” to replace an ink cartridge 
before it is empty.
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❏ If print quality remains a problem after replacing the ink cartridges, 
contact your dealer.

❏ To maintain print quality, we recommend printing a few pages at 
least once every month.

Aligning the Print Head

If you notice a misalignment of vertical lines or horizontal 
banding, you may be able to solve this problem from your 
computer using the Print Head Alignment utility in your printer 
software. Refer to the appropriate section below.

Note:
Do not press the ) paper button to cancel printing while printing a test 
pattern with the Print Head Alignment utility.

For Windows

Follow the steps below to align the print head using the Print 
Head Alignment utility.

1. Make sure that A4 or Letter size plain paper is loaded in the 
sheet feeder.

2. Access the printer software.

“Accessing the Printer Software for Windows”

3. Click the Maintenance tab, then click the Print Head 
Alignment button.

4. Follow the on-screen instructions to align the print head.
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For Mac OS 8.6 to 9.x

Follow the steps below to align the print head using the Print 
Head Alignment utility.

1. Make sure that A4 or Letter size plain paper is loaded in the 
sheet feeder.

2. Access the Print or Page Setup dialog box.

“Accessing the Printer Software for Mac OS 8.6 to 9.x”

3. Click the Utility icon button, then click the Print Head 
Alignment button.

4. Follow the on-screen instructions to align the print head.

For Mac OS X

Follow the steps below to align the print head using the Print 
Head Alignment utility.

1. Make sure that A4 or Letter size plain paper is loaded in the 
sheet feeder.

2. Access the EPSON Printer Utility dialog box.

“Accessing the Printer Software for Mac OS X”

3. Select your printer, then click OK in the Printer List window.

4. Click the Print Head Alignment button in the Utility dialog 
box.

5. Follow the on-screen instructions to align the print head.
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Problem Solver

Diagnosing the Problem

Troubleshooting printer problems is best handled in two steps: 
first diagnose the problem, then apply likely solutions until the 
problem is fixed.

The information that you need to diagnose and solve most 
common problems is provided by online problem solving, the 
printer’s control panel, the EPSON Status Monitor utility, or by 
running a printer operation check. Refer to the appropriate 
section below.

If you have a specific problem relating to print quality, a printout 
problem not related to print quality, or a paper feeding problem, 
or if the printer does not print at all, refer to the appropriate 
section in this chapter.

To solve a problem, you may need to cancel printing. 
& See “Cancelling Printing”

Error indicators

You can identify many common printer problems using the lights 
on your printer’s control panel. If your printer stops working and 
the lights are on or flashing, use the following table of panel light 
patterns to diagnose the problem, then follow the recommended 
corrective measures. If the status of the power light is not shown, 
it is on or flashing.

Lights Problem and solution
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Paper out

No paper is loaded in the 
printer.

Load paper in the sheet feeder, 
and then press the ) paper 
button. The printer resumes 
printing and the light goes out.

Paper jam

Paper has jammed in the 
printer.

Press the ) paper button to eject 
the jammed paper. If the error 
does not clear, open the printer 
cover and remove all of the paper 
inside, including any torn pieces. 
Then, reload the paper in the sheet 
feeder and press the ) paper 
button to resume printing. 

Ink low

The black or color ink 
cartridge is nearly 
empty.

Obtain a replacement black or 
color ink cartridge. To determine 
which cartridge is nearly empty, 
check the ink levels using 
EPSON Status Monitor 3 (Windows) 
or EPSON Status Monitor 
(Macintosh).

Ink out

An ink cartridge is empty 
or not installed.

Replace the black or color ink 
cartridge with a new one. If the ink 
end error occurs after the print 
head has moved to the home 
position, the ink cartridge may not 
be installed properly. Reinstall the 
ink cartridge so that it clicks into 
place.
& See “Replacing an Empty Ink 
Cartridge”

Wrong cartridge

The currently installed ink 
cartridge cannot be 
used with this printer.

Replace the incompatible 
cartridge with an appropriate 
black or color ink cartridge.
& See “Replacing an Ink 
Cartridge”
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EPSON Status Monitor

If a problem occurs while printing, an error message will appear 
in the Progress Meter window.

When the ink is out, click the How To button in the EPSON Status 
Monitor or Progress Meter window, and EPSON Status Monitor 
will lead you step-by-step through the cartridge replacement 
procedure.

Incorrectly installed ink cartridge

An ink cartridge is not 
installed correctly.

If the print head is at the home 
position, press the H ink button to 
move the print head to the ink 
cartridge replacement position. 
Remove and reinsert the ink 
cartridge. Then, continue with the 
ink cartridge installation. 

If the print head is at the ink 
cartridge replacement position, 
remove and reinsert the ink 
cartridge. Then, continue with ink 
cartridge installation.

Carriage error

The print head carriage 
is obstructed by jammed 
paper or other foreign 
material and cannot 
return to the home 
position.

Turn off the printer. Open the 
printer cover and remove any 
paper or other obstructions from 
the paper path by hand. Then, turn 
the printer back on.

If the error does not clear, contact 
your dealer.

Unknown printer error

An unknown printer error 
has occurred.

Turn off the printer and contact 
your dealer.
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If an error message indicating that parts inside your printer are 
near the end of their service life appears, contact your dealer for 
replacement.

Running a printer operation check

If you are unable to determine the source of the problem, 
performing a printer operation check can help you determine 
whether the problem comes from the printer or the computer.

To print a printer operation check page, follow these steps.

1. Make sure both the printer and computer are turned off.

2. Disconnect the cable from the printer’s interface connector.

3. Make sure that A4 or Letter size paper is loaded in the sheet 
feeder.

4. Hold down the ) paper button and press the P power 
button to turn on the printer. Release only the P power 
button. After the printer starts the operation check, release the 
) paper button.
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Compare the quality of the printed check page with the sample 
shown below. If there are no print quality problems, such as gaps 
or missing segments in the test lines, the printer itself is fine and 
the problem probably lies with the printer software settings, the 
application settings, the interface cable (be sure to use a shielded 
cable), or the computer itself.

If the check page does not print satisfactorily as shown below, 
there is a problem with the printer. For example, if any segment 
of the printed lines is missing, this could mean a clogged ink 
nozzle or a misaligned print head.
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Print Quality Problems

If you are having print quality problems, first perform a 
“<As_test.htm>Test Printing”, then compare it with the 
illustrations below. Click the caption under the illustration that 
best resembles your printout.

Horizontal banding

❏ Make sure that the printable side of the paper is face up in the 
sheet feeder.

❏ Run the Head Cleaning utility to clear any clogged ink 
nozzles.
& See “Cleaning the Print Head”

“Horizontal banding” “Vertical misalignment or 
banding”

“Horizontal banding” “Vertical misalignment or 
banding”

“Incorrect or missing colors” “Blurry or smeared printout”
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❏ Run the Print Head Alignment utility.
& See “Aligning the Print Head”

❏ Use up ink cartridges within six months after opening their 
packages.

❏ Use the genuine EPSON ink cartridges.

❏ Clear all customized settings, and select Text settings as the 
Quality Type setting on your printer’s software (Windows). 
Clear all customized settings, and select Automatic as the 
Mode setting on your printer’s software (Macintosh).
& See “Making Settings on the Main Menu” (for Windows)
& See “Print Dialog Box” (Mac OS 8.6 to 9.x)
& See “Print Dialog Box” (Mac OS X)

❏ Check the H ink out light. If the light is flashing, replace the 
appropriate ink cartridge.
& See “Replacing an Empty Ink Cartridge”

❏ Make sure that the Media Type selected in the printer 
software is appropriate for the type of media loaded in the 
printer.

“Media Type Settings”

Vertical misalignment or banding

❏ Make sure that the printable side of the paper is face up in the 
sheet feeder.

❏ Run the Head Cleaning utility to clear any clogged ink 
nozzles.
& See “Cleaning the Print Head”

❏ Run the Print Head Alignment utility.
& See “Aligning the Print Head”
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❏ Clear the High Speed check box in your printer software’s 
Advanced dialog box.
& See “Making the Advanced settings” (Windows)
& See “Advanced settings” (Mac OS 8.6 to 9.x)
& See “Advanced mode” (Mac OS X)

❏ Make sure that the Media Type selected in the printer 
softwareis appropriate for the type of media loaded in the 
printer.

“Media Type Settings”

Incorrect or missing colors

❏ Clear the Black Ink Only setting in your printer software (for 
Windows). Change the Ink setting in your printer software to 
Color (For Macintosh).
& See “Making the Advanced settings” (Windows)
& See “Color” (Mac OS 8.6 to 9.x)
& See “Color” (Mac OS X)

❏ Adjust the color settings in your application or in your printer 
software’s Advanced dialog box.
& See “Making the Advanced settings” (Windows)
& See “Advanced settings” (Mac OS 8.6 to 9.x)
& See “Color Management” (Mac OS X)

❏ Run the Head Cleaning utility.
& See “Cleaning the Print Head”

If colors are still incorrect or missing, replace the color ink 
cartridge. If the problem persists, replace the black ink 
cartridge.
& See “Replacing an Ink Cartridge”
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❏ If you have just replaced an ink cartridge, make sure the date 
on the box has not expired. Also, if you have not used the 
printer for a long time, replace with new ink cartridges.
& See “Replacing an Ink Cartridge”

Blurry or smeared printout

❏ Make sure that you are using the appropriate printer driver 
for your printer.

❏ Use only paper recommended by EPSON.
& See “Paper”

❏ Use genuine EPSON ink cartridges.

❏ Make sure that the printer is on a flat, stable surface that 
extends beyond the printer base in all directions. The printer 
will not operate properly if it is tilted.

❏ Make sure that your paper is not damaged, dirty, or too old. 

❏ Make sure that your paper is dry and that the printable side 
is facing up.

❏ Clear all customized settings, and select Text settings as the 
Quality Type setting on your printer’s software (Windows). 
Clear all customized settings, and select Automatic as the 
Mode setting on your printer’s software (Macintosh).
& See “Making Settings on the Main Menu” (for Windows)
& See “Print Dialog Box” (Mac OS 8.6 to 9.x)
& See “Print Dialog Box” (Mac OS X)

❏ If the paper is curled toward the printable side, flatten it or 
curl it slightly in the opposite direction. 

❏ Make sure that the Media Type setting in your printer’s 
software is correct.
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❏ Remove each sheet from the output tray as it is printed, 
especially if you are using transparencies.

❏ If you are printing on glossy media or transparencies, place a 
support sheet (or a sheet of plain paper) beneath the stack, or 
load only one sheet at a time.

❏ Do not touch or allow any thing to come into contact with the 
printed side of transparencies or paper with a shiny finish. 
After printing documents on transparencies or glossy media, 
allow the ink to set for a few hours before handling them.

❏ Run the Head Cleaning utility.
& See “Cleaning the Print Head”

❏ Run the Print Head Alignment utility.
& See “Aligning the Print Head”

Printout Problems Not Related to Print Quality

Incorrect or garbled characters

❏ Make sure that your printer and printer driver are 
appropriately selected.

❏ Select your printer as the default printer (Windows).

❏ Clear any stalled print jobs from the Spool Manager 
(Windows Me/98/95).
& See “Using EPSON Spool Manager”

❏ Turn off the printer and computer. Make sure that the 
printer’s interface cable is securely plugged in.
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Incorrect margins

❏ Check the margin settings in your application. Make sure that 
the margins are within the printable area of the page.
& See “Paper”

❏ Check the settings on the Main menu (Windows) or in the 
Page Setup dialog box (Macintosh). Make sure the settings are 
appropriate for the paper size you are using.
& See “Making Settings on the Main Menu” (Windows)
& See “Page Setup Dialog Box” (Mac OS 8.6 to 9.x)
& See “Page Setup Dialog Box” (Mac OS X)

❏ If you try to print using the Borderless feature and the 
printout includes margins, check your original photo data. In 
addition, the digital camera (data transmission equipment) 
may automatically add margins in order for the aspect ratio 
of the image to be adjusted.

Inverted image

Clear the Mirror Image check box in the printer software, or turn 
off the “Mirror Image” setting in your application. For 
instructions, see online help for the printer software or for your 
application.
& See “Making Settings on the Page Layout Menu” (Windows)
& See “Advanced settings” (Mac OS 8.6 to 9.x)
& See “Advanced mode” (Mac OS X)

Blank pages print

❏ Make sure that your printer and printer driver are 
appropriately selected.

❏ Select your printer as the default printer (Windows).
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❏ Check the settings on the Main menu (Windows) or in the 
Page Setup dialog box (Macintosh). Make sure the settings are 
appropriate for the paper size you are using.
& See “Making Settings on the Main Menu” (Windows)
& See “Page Setup Dialog Box” (Mac OS 8.6 to 9.x)
& See “Page Setup Dialog Box” (Mac OS X)

❏ Run the Head Cleaning utility to clear any clogged nozzles.
& See “Cleaning the Print Head”

After trying one or more of these solutions, run a printer operation 
check to check your results.
& See “Running a printer operation check”

Printout has smears

❏ If the paper is curled toward the printable side, flatten it or 
curl it slightly in the opposite direction.

❏ Clear the High Speed check box in your printer software’s 
Advanced dialog box. The Advanced dialog box is accessible 
through the Main menu (Windows) or the Print dialog box 
(Macintosh) when Custom is selected as the Mode setting. To 
turn this option off, you may also need to change the Print 
Quality setting.

❏ Load and eject dry paper several times. If the problem 
persists, ink may have leaked inside the printer. In this case, 
wipe the inside of the printer with a soft, clean cloth.
& See “Cleaning the Printer”

Printing is too slow

❏ Make sure that the Media Type settingin your printer 
software is correct.
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“Media Type Settings”

❏ Select Text as the Print Quality setting on your printer’s 
software (Windows).
Select Automatic as the Mode setting in the Print dialog box, 
then move the slider to Speed (Macintosh).
& See “Quality Option” (Windows)
& See “Automatic mode” (Mac OS 8.6 to 9.x)
& See “Automatic mode” (Mac OS X)

❏ Close any unnecessary applications.

❏ If you upgraded from Windows 95 to Windows 98, uninstall 
the printer software using Add/Remove Programs on the 
Control Panel, then install the software again.

❏ For printer models that use the parallel port, you can enable 
DMA transfer if you computer supports ECP mode (Windows 
Me, 98, and 95).
& See “Enabling DMA transfer”

If you try all of the methods above and cannot solve the problem, 
see the following:
& “Increasing the Print Speed”

Paper Does Not Feed Correctly

Paper does not feed

Remove the stack of paper and make sure of the following:

❏ The paper is not curled or creased.

❏ The paper is not too old. See the instructions that came with 
the paper for more information.
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❏ The paper is not loaded higher than the arrow mark on the 
left edge guide.

❏ The paper stack fits under the tabs inside the edge guides.

❏ The number of sheets in the paper stack does not exceed the 
limit specified for the media.

“Loading capacities for EPSON special media”

❏ Paper is not jammed inside the printer. If it is, remove the 
jammed paper.
& See “The paper jams”

❏ The ink cartridges are not empty. If one is, replace the 
appropriate cartridge.
& See “Replacing an Empty Ink Cartridge”

❏ Special loading instructions that came with your paper have 
been followed. Load the paper again.

“Loading Single Sheets of Paper”

Multiple pages feed

❏ Make sure that the paper stack is flush with or lower than the 
triangular load-limit mark on the edge guide.

❏ Make sure that the paper stack fits under the tabs inside the 
edge guides.

❏ Make sure that the left edge guide is snug to the left edge of 
the paper.

❏ Make sure that the paper is not curled or folded. If so, flatten 
it or curl it slightly toward the opposite side before loading.
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❏ Remove the stack of paper and make sure that the paper is 
not too thin.
& See “Paper”

❏ Fan the edges of the stack to separate the sheets, then reload 
the paper.

❏ If too many copies of a document are being printed, check the 
Copies setting on the printer software’s Page Layout menu 
(Windows) or in the Print dialog box (Macintosh) and in your 
application.
& See “Copies” (Windows)
& See “Copies” (Macintosh)
& See “Copies & Pages” (Mac OS X)

The paper jams

Press the ) paper button to eject the jammed paper. If the error 
does not clear, turn the printer off and open the printer cover, then 
remove all of the paper inside, including any torn pieces. Then, 
reload the paper and press the ) paper button to resume 
printing. 

Note:
If you cannot remove a foreign object easily by yourself, do not use force 
and do not disassemble the printer. Call your dealer for assistance.

If your paper jams frequently, make sure of the following:

❏ The paper is smooth, not curled or wrinkled.

❏ The paper is of high quality.

❏ The printable side of the paper is face up in the sheet feeder.

❏ The paper stack was fanned before loading.



210

R4CD000_UK
html.bk Rev. E
TRBLE.FM A5 size
6/10/03

L Proof Sign-off:
S.Kodama CRE Kawakami
M.Otsuka
editorname

❏ The paper is not loaded above the arrow on the left edge 
guide.

❏ The paper stack fits under the tabs inside the edge guides.

❏ The number of sheets in the paper stack does not exceed the 
limit specified for that media.

“Loading capacities for EPSON special media”

❏ The left edge guide is adjusted to fit your paper.

❏ The printer is on a flat, stable surface that extends beyond the 
printer base in all directions. The printer will not operate 
properly if it is tilted.

Paper improperly loaded

If you have loaded the paper too far into the printer, the printer 
cannot feed the paper correctly. Turn the printer off and gently 
remove the paper. Then turn the printer on and reload the paper 
properly.

Paper is not ejected fully or is wrinkled

❏ If the paper does not eject fully, press the ) paper button, 
then open the printer cover and remove the paper. Also, check 
the Paper Size setting in your application or printer software.
& See “Making Settings on the Main Menu” (Windows)
& See “Page Setup Dialog Box” (Mac OS 8.6 to 9.x)
& See “Page Setup Dialog Box” (Mac OS X)

❏ If the paper is wrinkled when it comes out, it may be damp 
or too thin. Load a new stack.
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Note:
Store any unused paper in its original packaging in a dry area.

Printer Does Not Print

All lights are off

❏ Press the P power button to make sure that the printer is on.

❏ Turn off the printer and make sure that the power cord is 
securely plugged in.

❏ Make sure that your outlet works and is not controlled by a 
wall switch or timer.

Lights came on and then went out

The printer’s voltage may not match the outlet rating. Turn off the 
printer and unplug it immediately. Then, check the printer labels.

c
Caution:
If the voltage does not match, DO NOT PLUG YOUR PRINTER 
BACK IN. Contact your dealer.

Only the power light is on

❏ Turn off the printer and computer. Make sure that the 
printer’s interface cable is securely plugged in.

❏ Make sure that there is no packing material in the printer.
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❏ Turn off the printer and the computer, disconnect the printer’s 
interface cable, then print an operation check page.
& See “Running a printer operation check”

If the check page prints correctly, make sure that the printer 
software and your application are installed correctly.

❏ If you are trying to print a large image, your computer may 
not have enough memory to print. Try printing a smaller 
image.

❏ Users of Windows Me, 98, and 95 can clear any stalled print 
jobs from the spool manager.
& See “Using EPSON Spool Manager”

❏ If you are using Windows NT 4.0, try uninstalling the EPSON 
Printer Port. Click Start, point to Programs and then to 
EPSON Printers, then click EPSON Printer Port Uninstall. 
Follow the on-screen instructions.

❏ If the printer sounds like it is trying to print, but is unable to, 
run the Head Cleaning utility.
& See “Cleaning the Print Head”

If this does not work, replace the ink cartridges.
& See “Replacing an Ink Cartridge”

The error light is flashing or on

Check EPSON Status Monitor 3 (Windows) or 
EPSON StatusMonitor (Macintosh) to find the cause of the error, 
then try one or more of these solutions:

❏ If the ) paper out light is on and there is no paper in the 
printer, load paper into the sheet feeder.
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❏ If the H ink out light is flashing, the ink supply is low. Obtain 
a replacement cartridge of the appropriate type.
& See “Replacing an Empty Ink Cartridge”

❏ If the H ink out light is on and the ink cartridge is empty, 
replace the appropriate ink cartridge.
& See “Replacing an Empty Ink Cartridge”

Error light is on and power light is flashing

Follow the steps below.

1. Press the ) paper button, then remove any paper in the 
printer.

2. Turn the printer off. Check for and remove any foreign objects 
or pieces of paper from inside the printer. Also make sure that 
there is sufficient space around the vent on the back of the 
printer to allow proper ventilation. Remove any objects 
blocking the vent. Then, turn the printer back on.

Note:
If you cannot remove a foreign object easily by yourself, do not use 
force and do not disassemble the printer. Call your dealer for 
assistance.

3. If the error does not clear, contact your dealer.
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Print Head Carriage Problem

If the carriage cover does not close or the print head carriage does 
not move to its home position, open the carriage cover and push 
the ink cartridges down until they click into place.

Correcting USB Problems

USB connections

USB cables or connections can sometimes be the source of USB 
problems. Try one or both of these solutions:

❏ Use the USB cable (C83623✽) recommended.
& See “System Requirements”

❏ For best results, you should connect the printer directly to the 
computer’s USB port. If you must use multiple USB hubs, we 
recommend that you connect the printer to the first-tier hub.
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Windows operating systems

Your computer must be a model pre-installed with Windows Me, 
98, XP, or 2000, a model that was pre-installed with Windows 98 
and upgraded to Windows Me, or a model that was pre-installed 
with Windows Me, 98, or 2000 and upgraded to Windows XP. 
You may not be able to install or run the USB printer driver on a 
computer that does not meet these specifications or that is not 
equipped with a built-in USB port.

For details about your computer, contact your dealer.

Printer software installation

Incorrect or incomplete software installation can lead to USB 
problems. Take note of the following and perform the 
recommended checks to ensure proper installation.

Checking printer software installation for Windows XP and 
2000

When using Windows XP or 2000, you must follow the steps in 
the Setup sheet packed with the printer to install the printer 
software. Otherwise, Microsoft’s Universal driver may be 
installed instead. To check if the Universal driver has been 
installed follow the steps below.

1. Open the Printers folder and right-click the icon for your 
printer.

2. Click Printing Preference on the shortcut menu that appears, 
and then right-click anywhere in the driver.
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If About is displayed in the shortcut menu that appears, click 
it. If a message box with the words “Unidrv Printer Driver” 
appears, you must reinstall the printer software as described 
in the Setup sheet. If About is not displayed, the printer 
software has been installed correctly.

Note:
If the Digital Signature Not found dialog box (Windows 2000) or 
Software Installation dialog box (Windows XP) appears during the 
installation process, click Yes (Windows 2000) or Continue Anyway 
(Windows XP). If you click No (Windows 2000) or STOP Installation 
(Windows XP), you will have to install the printer software again.

Checking printer software in Windows Me and 98

If you canceled the plug-and-play driver installation in 
Windows Me or 98 before the procedure was complete, the USB 
printer device driver or the printer software may be incorrectly 
installed. Follow the directions below to ensure that the driver 
and printer software are installed correctly.

Note:
The screen captures shown in this section are taken from Windows 98. 
Windows Me screens may differ slightly.

1. Click the Start button, point to Settings, and then click 
Printers. Make sure that the icon for your printer appears in 
the Printers window.
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Select the icon for your printer, and then click Properties on 
the File menu.

2. Click the Details tab.
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If EPUSBX: (EPSON Stylus C84) is displayed in the Print to 
the following port list, then the USB printer device driver and 
printer software are installed correctly. If the correct port is 
not displayed, proceed to the next step.

3. Right-click the My Computer icon on your desktop, and then 
click Properties.

4. Click the Device Manager tab.

If your drivers are correctly installed, EPSON USB Printer 
Devices should appear on the Device Manager menu.
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If EPSON USB Printer Devices does not appear on the Device 
Manager menu, click the plus (+) sign beside Other devices 
to view the installed devices. 

If USB Printer or EPSON Stylus C84 appears under Other 
devices, the printer software is not installed correctly. Proceed 
to step 5.

If neither USB Printer nor EPSON Stylus C84 appears under 
Other devices, click Refresh or unplug the USB cable from the 
printer, then plug it into the printer again. Once you’ve 
confirmed that these items appear, proceed to step 5.

5. Under Other devices, select USB Printer or EPSON Stylus C84 
and click Remove. Then, click OK.
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When the following dialog box appears, click OK, and then click 
OK to close the System Properties dialog box.

6. Uninstall the printer software.
& See “Uninstalling the printer software”

7. Turn off the printer, restart your computer, and reinstall the 
printer software as explained in the Setup sheet packed with 
your printer.

Cancelling Printing

If you encounter problems while printing, you may need to cancel 
printing. To cancel printing, follow the instructions in the 
appropriate section below.

Using the control panel buttons

Press the ) paper button while printing to cancel the printing of 
a page or a print job.
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For Windows XP, 2000, and NT 4.0

When you send a print job to the printer, the Progress Meter will 
appear on your computer screen.

Click the Stop button to cancel printing.

For Windows Me, 98, and 95

It is possible to cancel printing using either the Progress Meter or 
EPSON Spool Manager. Refer to the appropriate section below.
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Using the Progress Meter

When you send a print job to the printer, the Progress Meter 
appears on your computer screen.

Click the Stop button to cancel printing.

Using EPSON Spool Manager

EPSON Spool Manager is similar to Windows Print Manager. If 
it receives two or more print jobs at one time, it holds them in the 
order that they were received (with printers on a network this 
may be called a print queue). When a print job reaches the top of 
the queue, the EPSON Spool Manager sends the job to the printer. 
You can cancel print jobs from the Spool Manager. You can also 
view print status information about the print jobs which have 
been sent to your printer, as well as pause and resume or restart 
selected print jobs.
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After you send a print job, an EPSON Stylus C84 button will 
appear in the icon tray. Click this button to open the EPSON Spool 
Manager.

To cancel a print job, select the job in the list, and then click 
Cancel.

For Macintosh

The procedure for canceling printing for Macintosh varies, 
depending on whether background printing is on or off. Refer to 
the appropriate section below.

For Mac OS 8.6 to 9.x

When background printing is on

Follow the steps below to cancel a print job.

1. Select EPSON MonitorIV from the application menu.
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2. Press the P power button to turn off the printer.

3. In the Document Name list, select the document which is 
printing, then click the Stop icon button to cancel the print 
job.

When background printing is off

Follow the steps below to cancel a print job.

1. Press the P power button to turn off the printer.

2. Hold down the J command key on your keyboard and press 
the period (.) key to cancel the print job.

For Mac OS X

Follow the steps below to cancel a print job.

1. Click the Print Center icon in Dock.
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2. Press the P power button to turn off the printer.

3. In the Document Name list, select the document which is 
printing, then click the Delete button to cancel the print job.
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Customer Support

Technical Support Web Site

EPSON's Technical Support Web Site provides help with 
problems that cannot be solved using the troubleshooting 
information in your printer documentation. If you have a Web 
browser and can connect to the Internet, access the site at:

http://support.epson.net/StylusC84/

Contacting Customer Support

If your EPSON product is not operating properly and you cannot 
solve the problem using the troubleshooting information in your 
product documentation, contact customer support services for 
assistance. If customer support for your area is not listed below, 
contact the dealer where you purchased your product.

Customer support will be able to help you much more quickly if 
you give them the following information:

❏ Product serial number
(The serial number label is usually on the back of the product.)

❏ Product model

❏ Product software version
(Click About, Version Info, or similar button in the product 
software.)

❏ Brand and model of your computer
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❏ Your computer operating system name and version

❏ Names and versions of the software applications you 
normally use with your product

Select your country:

Germany
EPSON Deutschland GmbH

Service & Support

“Germany” “Hungary” “France” “Norway”

“Yugoslavia” “Austria” “Slovac 
Republic”

“Spain”

“Sweden” “Greece” “Netherlands
”

“Czek. 
Republic”

“United 
Kingdom”

“Republic of 
Ireland”

“Italy” “Croatia”

“Belgium” “Poland” “Denmark” “Finland”

“Cyprus” “Luxemburg” “Bulgaria” “Romania”

“Macedonia
”

“Portugal” “Switzerland” “Lithuania”

“Slovenia” “Estonia” “Latvia” “Bosnia 
Herzgovina”

“Israel” “Middle East” “South 
Africa”

“Argentin
a”

“Chile” “Costa 
Rica”

“Peru” “USA 
(Latin 
America)
”

“Brazil” “Colombi
a”

“Mexico” “Venezue
la”

“USA”
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0180-5234110

Monday to Friday: 9 a.m. to 9 p.m.

Saturday to Sunday: 10 a.m. to 4 p.m. 

Public holidays: 10 a.m. to 4 p.m. 

(0,12 E per minute)

www.epson.de/support/

France
Support Technique EPSON France,

0 892 899 999 (0,34 E/minute) 

Ouvert du lundi au samedi de 9h00 à 20h00 sans interruption 

http://www.epson.fr/support/selfhelp/french.htm pour 
accéder à l'AIDE EN LIGNE.

http://www.epson.fr/support/services/index.shtml pour 
accéder aux SERVICES du support technique.

Centres de maintenance

AJACCIO CIM

Le Stiletto - Lot N° 5

20090 AJACCIO

Tél :  04.95.23.73.73

Fax : 04.95.23.73.70

AMIENS

FMA

13, rue Marc Sangnier 8000 AMIENS

Tél : 03.22.22.05.04

Fax : 03.22.22.05.01
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ANNECY (td)

MAINTRONIC

Parc des Glaisins

Immeuble Prosalp

14, rue Pré Paillard

74940 ANNECY Le Vieux

Tél : 04.50.10.21.30

Fax : 04.50.10.21.31

AVIGNON

MAINTRONIC

Anthéa, rue du Mourelet

ZI de Courtine III

84000 AVIGNON

Tél : 04.32.74.33.50

Fax : 04.32.74.05.89

BASTIA (td)

CIM

Immeuble Albitreccia

Avenue du Maichione

20200 LUPINO

Tél : 04.95.30.65.01

Fax : 04.95.30.65.01

BORDEAUX 

FMA 

Parc d'activités Chemin Long

Allée James Watt - Immeuble Space 3

33700 MERIGNAC

Tél : 05.56.34.85.16

Fax : 05.56.47.63.18

BORDEAUX 

MAINTRONIC 

11/19 rue Edmond Besse

Immeuble Rive Gauche

33300 BORDEAUX

Tél : 05.57.10.67.67 

Fax : 05.56.69.98.10 

BOURGES (td)

BEGELEC

18, avenue du 11 Novembre

18000 BOURGES

Tél : 02.48.67.00.38

Fax : 02.48.67.98.88

BREST

FMA 

8, rue Fernand Forest

29850 GOUESNOU

Tél : 02.98.42.01.29 

Fax : 02.98.02.17.24 
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CAEN

TMS

17, rue des Métiers

14123 CORMELLES LE ROYAL

Tél : 02.31.84.80.82

Fax : 02.31.84.80.83

CLERMONT

FMA 

14, rue Léonard de Vinci 

Bât H - ZI La Pardieu 

63000 CLERMONT FERRAND

Tél : 04.73.28.59.60 

Fax : 04.73.28.59.65 

CROISSY SUR SEINE

BEGELEC

ZA Claude Monet

5 rue Hans List

Bât F

78290 CROISSY SUR SEINE

Tél : 01 30 09 20 55

Fax : 01 34 80 17 24

DIJON

FMA

60, rue du 14 Juillet

Parc des Grands Crus

21300 CHENOVE

Tél : 03.80.51.17.17

Fax : 03.80.51.23.00

GRENOBLE (td)

FMA

2 rue Mayencin

38400 ST MARTIN D'HERES

Tél : 04.38.37.01.19

Fax : 04.76.44.78.92

GRENOBLE

MAINTRONIC

Les Akhesades Bât B.

Rue Irène Joliot Curie

38320 EYBENS

Tél : 04.76.25.87.87

Fax : 04.76.25.88.10

HEROUVILLE ST CLAIR

BEGELEC

ZI de la Sphère

558 rue Léon Foucault

14200 HEROUVILLE ST CLAIR

Tél : 02 31 53 66 83

Fax : 02 31 53 66 84
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LE HAVRE

FMA

33, bd de Lattre de Tassigny

76600 LE HAVRE

Tél : 02.32.74.27.44

Fax : 02.35.19.05.35

LE MANS 

BEGELEC 

117, rue de l'Angevinière

72000 LE MANS

Tél : 02.43.77.18.20 

Fax : 02.43.77.18.28 

LILLE

FMA

99 rue Parmentier - Bât A

59650 VILLENEUVE D’ASCQ

Tél : 03.20.71.47.30

Fax : 03.20.61.07.90

LILLE

MAINTRONIC 

Synergie Park

9, avenue Pierre et Marie Curie

59260 LEZENNES

Tél : 03.20.19.04.10 

Fax : 03.20.19.04.19

LIMOGES

MAINTRONIC

43 rue Cruveilher

87000 LIMOGES

Tél : 05.55.10.36.75

Fax : 05.55.77.44.00

LYON

FMA

136, chemin Moulin Carron

69130 ECULLY

Tél : 04.78.35.38.65

Fax : 04.78.35.24.99

LYON

MAINTRONIC

9, allée du Général Benoist

ZAC du Chêne

69500 BRON

Tél : 04.72.14.95.00

Fax : 04.78.41.81.96

LYON Centre

MAINTRONIC

4, quai Jules Courmont

69002 LYON

Tél : 04.72.56.94.85

Fax : 04.72.56.94.89
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MARSEILLE

FMA

305 ZA de Mourepiane

467, Chemin du Littoral

13322 MARSEILLE CX 13

Tél : 04.91.03.13.43

Fax : 04.91.03.13.72

MARSEILLE

MAINTRONIC

Bât D1 - Actiparc II

Chemin de St LAMBERT

13821 LA PENNE SUR HUVEAUNE

Tél : 04.91.87.83.93

Fax : 04.91.87.83.94

METZ

FMA

104 rue de Pont à Mousson

57950 MONTIGNY LES METZ

Tél : 03 87 66 92 00

Fax : 03 87 66 18 22

METZ

MAINTRONIC

TECHNOPOLE 2000

6, rue Thomas Edison

57070 METZ

Tél : 03.87.76.98.30

Fax : 03.87.76.31.15

MONTPELLIER

MAINTRONIC

Parc Ateliers Technologiques

2, avenue Einstein

34000 MONTPELLIER

Tél : 04.67.15.66.80

Fax : 04.67.22.50.91

MULHOUSE

FMA

106, rue des Bains

68390 SAUSHEIM

Tél : 03.89.61.77.88

Fax : 03.89.31.05.25

NANCY

FMA

3 rue du Bois Chêne le Loup

54500 VANDOEUVRE CEDEX

Tél : 03.83.44.44.00

Fax : 03.83.44.10.20
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NANTES

FMA

1105 avenue Jacques Cartier

Bât B4

44800 ST HERBLAIN

Tél : 02.28.03.10.73

Fax : 02.28.03.10.71

NANTES

MAINTRONIC

5 rue du Tertre

44470 CARQUEFOU

Tél : 02 51 85 22 70

Fax : 02 51 85 22 71

NICE

FMA

329, avenue des PUGETS

Bât A.2 - Le Réal

06700 ST LAURENT DU VAR

Tél : 04.93.14.01.70

Fax : 04.93.14.01.73

NICE

MAINTRONIC

Les terriers Nord

Immeuble Les Sporades

500, allée des Terriers

06600 ANTIBES

Tél : 04.92.91.90.90

Fax : 04.93.33.98.63

NIORT

MAINTRONIC 49 rue du Fief d'Amourettes

79000 NIORT

Tél : 05 49 24 18 71 

Fax : 05 49 24 15 85

ORLEANS

FMA

ZA des Vallées

45770 SARAN

Tél : 02 38 73 16 00

Fax : 02 38 43 85 77

PARIS 11ème

FMA

10 rue des Goncourt

75011 PARIS

Tél : 01 47 00 95 95

Fax : 01 47 00 95 96
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PARIS 12ème

BEGELEC

182, rue de Charenton

75012 PARIS

Tél : 01.44.68.83.01

Fax : 01.44.68.83.02

PARIS 13ème

MAINTRONIC

Immeuble Berlier

15, rue JB Berlier

75013 PARIS

Tél : 01.44.06.99.44

Fax : 01.44.24.05.06 

PARIS 14ème

FMA

63, rue de Gergovie

75014 PARIS

Tél : 01.45.45.57.65

Fax : 01.45.39.48.86

PARIS EST (td)

BEGELEC

3, allée Jean Image

77200 TORCY

Tél : 01.60.06.02.02

Fax : 01.60.06.02.60

PARIS NORD

FMA

30, av. du vieux Chemin de St Denis

92390 VILLENEUVE LA GARENNE

Tél : 01.40.85.98.08

Fax : 01.47.92.00.85

PARIS SUD

BEGELEC

Immeuble Femto

1, avenue de Norvège

91953 LES ULIS

Tél : 01.64.46.44.01

Fax : 01.69.28.83.22

PAU

MAINTRONIC

375, bd Cami Sallié

64000 PAU

Tél : 05.59.40.24.00

Fax : 05.59.40.24.25
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REIMS

FMA

Parc technologique H. Farman

12, allée Fonck

51100 REIMS

Tél : 03.26.97.80.07

Fax : 03.26.49.00.95

RENNES

FMA

59 bd d'Armorique

Square de la Mettrie

35700 RENNES

Tél : 02.23.20.25.25

Fax : 02.23.20.04.15

RENNES

MAINTRONIC

Parc d’affaires de la Bretèche

Bât 2

35760 RENNES ST GREGOIRE

Tél : 02.99.23.62.23

Fax : 02.99.23.62.20

ROUEN

BEGELEC

Technopole des Bocquets

Immeuble le Dulong

75 Allée Paul Langevin

76230 BOIS GUILLAUME

Tél : 02 35 12 41 66

Fax : 02 35 12 41 67

STRASBOURG

FMA

Parc d’activités Point Sud

3C rue du Fort

67118  GEISPOSHEIM

Tél : 03.88.55.38.18

Fax : 03.88.55.41.55

STRASBOURG

MAINTRONIC

ESPACE EUROPEEN DE L'ENTREPRISE

13 avenue de l'Europe

67300 SCHILTIGHEIM

Tél : 03 90 22 79 40

Fax : 03 90 20 89 14
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Spain
EPSON IBÉRICA, S.A.

Avda. Roma 18-26, 08290 Cerdanyola, Barcelona, España

Tel.: 34.93.5821500

TOULON (td)

FMA

64 route de Capelane

ZA la Capelane

Parc Burotel

83140 SIX FOURS

Tél : 04.94.63.02.87

Fax : 04.94.63.42.55

TOULOUSE

FMA

Buroplus - BP 365

31313 LABEGE CEDEX

Tél : 05.61.00.54.22

Fax : 05.61.00.52.01

TOULOUSE

MAINTRONIC

7, avenue de l’Europe

31520 RAMONVILLE ST AGNE

Tél : 05.61.73.11.41

Fax : 05.61.73.80.06

TOURS

BEGELEC

25, rue des Granges Galand

ZI des Granges Galand

37550 ST AVERTIN

Tél : 02.47.25.10.60

Fax : 02.47.25.10.72

TROYES (td)

BEGELEC

15, rue des Epingliers

10120 St ANDRE LES VERGERS

Tél : 03.25.49.78.96

Fax :03.25.49.78.97

VALENCIENNES 

BEGELEC (td)

14C rue Pierre Mathieu

59410 ANZIN

Tél : 03 27 19 19 05

Fax : 03 27 19 19 06
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Fax: 34.93.5821555

CENTRO DE ATENCIÓN AL CLIENTE

Tel.: 902 40 41 42

Fax: 93 582 15 16

E-mail: soporte@epson.es

www.epson.es

www.epson.es/support/

SERVICIOS OFICIALES DE ASISTENCIA TÉCNICA  EPSON

POBLACI
ON

PROVI
NCIA

EMPRESA TELEFONO FAX DIRECCION CP

ALBACE
TE

ALBAC
ETE

DEPARTAMENTO 
TÉCNICO 
INFORMÁTICO S.A.L.

967/50.69.
10

967/50.69.
09

C/ FRANCISCO 
PIZARRO, 13   BAJOS

02004

ALICANT
E

ALICA
NTE

RPEI 96/510.20.
53

96/511.41.
80

C/ EDUARDO 
LANGUCHA, 17 
BAJOS

03006

ALMERIA ALMERI
A

MASTER KIT S.A. 950/62.13.
77

950/62.13.
72

CAMINO LA 
GOLETA, 2ª 
TRAV.NAVE 4

04007

OVIEDO ASTURI
AS

COMERCIAL EPROM, 
S.A.

98/523.04.
59

98/527.30.
19

AV. DE LAS 
SEGADAS, 5 BAJOS

33006

OVIEDO ASTURI
AS

LABEL MICROHARD, 
S.L.

98/511.37.
53

98/511.37.
53

C/. FERNÁNDEZ DE 
OVIEDO, 38, BJO.

33012

BADAJO
Z

BADAJ
OZ

INFOMEC S.C. 924/24.19.
19

924/22.90.
36

C/ VICENTE 
DELGADO 
ALGABA, 10

06010

BADAJO
Z

BADAJ
OZ

PAITRON BADAJOZ 902/24.20.
24

924/24.18.
97

AV. Mª 
AUXILIADORA, 7

06011

MÉRIDA BADAJ
OZ

PAITRON MÉRIDA 924/37.16.
06

924/37.15.
91

C/ PUERTO RICO, 2 06800

PALMA 
DE M.

BALEA
RES

BALEAR DE 
INSTALACIONES Y 
MANT. S.L

971/24.64.
55

971/24.51.
02

C/ MANACOR, 82 A 
BAJOS

07006

MAHÓN BALEA
RES

INFORMÁTICA 
MAHÓN, S.L.

971/35.33.
23

971/35.12.
12

C/. SAN CLEMENTE, 
78 (SES VINYES)

07707
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BARCEL
ONA

BARCE
LONA

BS MICROTEC MANT.  
INFORMÁTIC S.L.

93/243.13.
23

93/340.38.
24

C/. PALENCIA, 45 08027

BARCEL
ONA

BARCE
LONA

MICROVIDEO 93/265.15.
75

93/265.44.
58

AVDA DIAGONAL, 
296

08013

CERDAN
YOLA

BARCE
LONA

OFYSAT S.L. 93/580.87.
87

93/580.89.
96

C/ FONTETES, 3-5, 
Local 1

08290

BARCEL
ONA

BARCE
LONA

RIFÉ ELECTRÓNICA, 
S.A.

93/453.12.
40

93/323.64.
70

C/ ARIBAU, 81 08036

SANT BOI BARCE
LONA

SELTRON S.L. 93/652.97.
70

93/630.81.
04

C/ INDUSTRIA, 44-46 08830

MANRES
A

BARCE
LONA

TELESERVICIO 93/873.56.
23

93/877.00.
34

AV. TUDELA, 44 08240

BURGOS BURGO
S

MANHARD, S.L. 947/22.11.
09

947/22.09.
19

AVDA 
CASTILLA-LEÓN, 46

09006

CÁCERE
S

CÁCER
ES

PAITRON CÁCERES 902/21.40.
21

927/21.39.
99

C/ GABINO MURIEL, 
1

10001

PTO.SAN
TA.Mª.

CÁDIZ ELSE INFORMÁTICA, 
S.L.

902/19.75.
63

956/56.05.
12

AV. RIO SAN 
PEDRO, 59, URB. 
VALDELAGRANA

11500

JEREZ CÁDIZ NEW SERVICE, S.L. 956/18.38.
38

956/18.55.
85

C/ ASTA, 18 11404

LAS 
PALMAS

CANA
RIAS

MEILAND 928/29.22.
30

928/23.38.
92

C/ NÉSTOR DE LA 
TORRE, 3 OFIC.1

35006

LAS 
PALMAS

CANA
RIAS

G.B. CANARIAS 
SERVICIOS, S.L.

902/11.47.
54

902/08.28.
38

C/. DR. JUAN 
DOMINGUEZ PEREZ, 
6 URB. SEBADAL

35008

SANTAN
DER

CANTA
BRIA

INFORTEC, S.C. 942/23.54.
99

942/23.98.
42

C/. JIMÉNEZ DÍAZ, 1 39007

CASTELL
ÓN

CASTEL
LÓN

INFORSAT, S.L. 964/22.94.
01

964/22.94.
05

C/ CRONISTA 
REVEST, 30 BAJOS

12005

ALCAZA
R

CIUDA
D REAL

GRUPO DINFOR 
ALCÁZAR

926/54.55.
62

926/54.57.
67

C/ DR. BONARDELL, 
37

13600

CIUDAD 
REAL

CIUDA
D REAL

GRUPO DINFOR C. 
REAL

926/25.42.
25

926/23.04.
94

C/. TOLEDO, 34 13003

CÓRDO
BA

CÓRD
OBA

SETESUR ANDALUCIA, 
S.L.

957/43.80.
09

957/43.92.
04

C/. ESCRITOR 
TOMÁS SÁNCHEZ, 3

14014

GIRONA GIRON
A

PROJECTES 
COM-TECH, S.L.

972/24.11.
35

972/40.11.
85

PLAZA DE LA 
ASUNCION, 35

17005

GRANA
DA

GRAN
ADA

INTELCO ASISTENCIA 
TÉCNICA, S.L.

958/13.21.
79

958/13.22.
09

C/ PRIMAVERA, 20 18008

SAN 
SEBASTIA
N

GUIPUZ
COA

ELECTRÓNICA 
GUIPUZCOANA

943/46.86.
40

943/45.57.
01

C/ BALLENEROS, 4 
BAJOS

20011
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HUELVA HUELV
A

INTERDATA 959/54.38.
82

959/54.37.
07

C/. CONDE DE 
LÓPEZ MUÑOZ, 32

21006

LA 
CORUÑ
A

LA 
CORU
ÑA

HARDTEC GALICIA 981/23.79.
54

981/16.83.
18

AV. LOS MALLOS, 
87, BJO. B

15007

LOGRO
ÑO

LA 
RIOJA

REYMAR, S.L. 941/24.26.
11

941/25.03.
12

C/. ALBIA DE 
CASTRO, 10

26003

LEÓN LEÓN MACOISAT, S.L. 987/26.25.
50

987/26.29.
52

AV. FERNÁNDEZ 
LADREDA, 27, BJO.

24005

LEÓN LEÓN PROSYSTEM 987/22.11.
97

987/24.88.
97

C/. JUAN DE LA 
COSA, 14

24009

LLEIDA LLEIDA OFYSAT, S.L. 973/23.40.
90

973/23.40.
90

C/. ENRIC 
GRANADOS, 
18,BJOS

25008

LUGO LUGO LABEL MICROHARD, 
S.L.

982/20.37.
15

982/20.37.
15

C/. ESCULTOR 
ASOREI, 1, BJOS.

27004

MADRID MADRI
D

GRUPO PENTA, S.A. 91/543.73.
03

91/543.53.
04

C/ BLASCO DE 
GARAY, 63

28015

MADRID MADRI
D

MICROMA, S.A. 91/304.68.
00

91/327.39.
72

C/ STA. LEONOR, 61 28037

MADRID MADRI
D

SETECMAN, S.L. 91/571.54.
06

91/572.22.
40

C/ INFANTA 
MERCEDES , 31  1º

28020

MADRID MADRI
D

BS MICROTEC 
MADRID, S.L.

91/713.07.
21

91/713.07.
23

C/. SANCHO 
DÁVILA, 21, LOCAL

28028

MADRID MADRI
D

TEDUIN, S.A. 91/327.53.
00

91/327.05.
00

C/ALBALÁ, 10 28037

MÁLAG
A

MÁLA
GA

COVITEL MÁLAGA 95/231.62.
50

95/233.98.
50

C/ CERAMISTAS, 
8. P. IND. SAN 
RAFAEL

29006

MÁLAG
A

MÁLA
GA

CENTRO DE 
REPARACIONES 
INFORMATICAS

95/236.35.
95

95/232.63.
25

C/. FLAUTA 
MÁGICA, S/N.N-6, 
P.ALAMEDA

29006

MELILLA MÁLA
GA

NODO INFORMÁTICA 95/267.53.
14

95/267.91.
37

C/. QUEROL, 22 52004

PAMPLO
NA

NAVAR
RA

INFORMÉTRICA 
IRUÑA , S.L.

948/27.98.
12

948/27.92.
89

ERMITAGAÑA, 1 
BAJOS

31008

VIGO PONTE
VEDRA

SERVICIOS 
INFORMÁTICOS DEL 
ATLÁNTICO, S.L

986/26.62.
80

986/26.77.
51

C/ PÁRROCO JOSÉ 
OTERO, 3

36206

VIGO PONTE
VEDRA

DUPLEX, S.L. 986/41.17.
72

986/41.17.
72

C/. CONDESA 
CASA BÁRCENA, 5

36204

SALAMA
NCA

SALAM
ANCA

EPROM-1 923/18.58.
28

923/18.69.
98

C/ COLOMBIA, 32 37003
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United Kingdom
EPSON (UK) Ltd.

Campus 100, Maylands Avenue,

Hemel Hempstead, Hertfordshire HP2 7TJ

United Kingdom

Tel.: +44 (0) 1442 261144

Fax: +44 (0) 1422 227227

www.epson.co.uk

Stylus Products Warranty & Support

08705 133 640

Scanner Products Warranty & Support

SEVILLA SEVILL
A

AMJ TECNOLAN, S.L. 95/491.57.
91

95/491.52.
14

AV. CJAL. ALBERTO 
JNEZ. BEC., 6, AC. D

41009

TARRAG
ONA

TARRA
GONA

TGI (TECNOLOGIA I 
GESTIÓ INFORM. S.L.)

977/23.56.
11

977/21.25.
12

AV. FRANCESC 
MACIÀ, 8 D BAIXOS

43002

VALENCI
A

VALEN
CIA

ATRON INGENIEROS, 
S.A.

96/385.00.
00

96/384.92.
07

C/ HÉROE ROMEU, 8 
B

46008

VALENCI
A

VALEN
CIA

GINSA 
INFORMÁTICA, S.A.

96/362.21.
15

96/393.26.
96

C/ ERNESTO FERRER, 
16 B

46021

VALLAD
OLID

VALLA
DOLID

ARAQUE PRINT, S.L. 983/20.76.
12

983/30.95.
05

BAILARÍN VICENTE 
ESCUDERO, 2

47005

BILBAO VIZCAY
A

DATA SERVICE, S.L. 94/446.79.
86

94/446.79.
87

C/ MATICO, 29 48007

BILBAO VIZCAY
A

TECNIMAC 94/410.63.
00

94/470.24.
23

C/. MONTE 
INCHORTA, 1

48003

ZARAG
OZA

ZARAG
OZA

OFYSAT, S.L. 976/30.40.
10

976/32.03.
73

C/ ANTONIO 
SANGENÍS, 16

50050

ZARAG
OZA

ZARAG
OZA

INSTRUMENTACIÓN Y 
COMPONENTES, S.A.

976/01.33.
00

976/01.09.
77

ED. EXPO 
ZARAGOZA,CRTA.
MADRID, S/N  KM. 
315, N-3, PTA. 1

50014
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08702 413 453

Sales

0800 220 546

Republic of Ireland
Stylus Products Warranty & Support

01 679 9016

Other Products Warranty & Support

01 679 9015

Sales

1 800 409 132

www.epson.co.uk

Italy
EPSON Italia S.p.a. 

Via M. Viganò de Vizzi, 93/95

20092 Cinisello Balsamo (MI)

Tel. 02.660.321

Fax. 02.612.36.22

Assistenza e Servizio Clienti 

TECHNICAL HELPDESK
02.268.300.58 

www.epson.it
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ELENCO CENTRI ASSISTENZA AUTORIZZATI EPSON

AEM SERVICE  S.R.L.

Via Verolengo, 20

00167 ROMA

Tel : 06-66018020 

Fax : 06-66018052

ELECTRONIC 
ASSISTANCE CENTRE

Via Bazzini, 17

20131 MILANO

Tel : 02-70631407

Fax : 02-70631301

QUAIZ  S.N.C.

Via San Paolo, 5/h   
Loc. Badia a Settimo

50018 SCANDICCI  
(FI)

Tel : 055-720561

Fax : 055-720180

A.T.E.S.  
ELETTRONICA   S.R.L.

Via Lulli, 28/b

10148 TORINO

Tel : 011-2202525

Fax : 011-2204280

ELETTRONICA 
CAROLINA ALOISIO 
& C.  S.A.S.

Via Generale 
Arimondi, 99

90143 PALERMO

Tel : 091-308118

Fax : 091-6263484

QUICK COMPUTER 
SERVICE

Viale Louise Pasteur, 
23 a/b/c

70124 BARI

Tel : 080-5044351

Fax : 080-5618810 

A.T.S.  S.N.C.

Via della 
Repubblica, 35 
a/b/c

40127 BOLOGNA

Tel : 051-515313

Fax : 051-513241

GSE S.R.L.

Via Rimassa, 183r

13129 GENOVA

Tel : 010-5536076

Fax : 010-5536113

QUICK COMPUTER 
SERVICE

Via P. Manerba, 12

71100  FOGGIA

Tel : 0881-331123

Fax : 0881-339133

A.T.S. S.N.C.

Via dell'Artigianato, 
4

09125  CAGLIARI

Tel: 070-2110244

Fax: 070-2110260

HARD SERVICE  S.R.L.

Z.A.3  Via del 
progresso, 2

35010 PERAGA DI 
VIGONZA  (PD)

Tel : 049-8933951

Fax : 049-8933948

RAVEZZI ANGELO 
HARDWARE SERVICE

Via Avogadro, 6/10

47037 RIMINI

Tel  : 0541-373686

Fax : 0541-374844

C.A.M.U.  S.N.C.

Via Grandi, 4

33170 PORDENONE

Tel : 0434-572949

Fax : 0434-573005

INFORMAINT S.N.C.

Via Prunizzedda, 94

07100 SASSARI

Tel / Fax: 079-290953

REGA ELETTRONICA  
S.N.C.

Via Gentileschi, 
25/27

56123 PISA

Tel : 050-560151

Fax : 050-560135
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COMPUTER 
ASSISTANCE S.A.S.

1a Traversa Via del 
Gallitello

85100 POTENZA

Tel: 0971-489973

Fax: 0971-476892 

INFORMAINT S.N.C.

Filiale di Olbia

Via Monte Pasubio, 
22

07026 OLBIA 

Tel: 0789-23786

Fax: 0789-203891

S.T.E.  S.N.C. di 
Ciarrocchi A.& C.

Via Settimo Torinese, 
5

65016 
MONTESILVANO (PE)

Tel : 085-4453664

Fax : 085-4456860

COMPUTER LAB  
S.N.C.

Via Quaranta, 29

20141 MILANO

Tel : 02-5391224

Fax : 02-5695198

JAM S.R.L.

Piazza Principale, 9 

39040 ORA* AUER 
(BOLZANO)

Tel : 0471-810502

Fax : 0471-811051

TECMATICA  S.R.L.

Via S. Bargellini, 4

00157 ROMA

Tel : 06-4395264

Fax : 06-43534628

COMPUTER LAB  
S.N.C.

Via Pelizza da 
Volpedo, 1

20092 CINISELLO 
BALSAMO  (MI)

Tel : 02-6174175

Fax : 02-6127926

LYAN S.N.C.

Via Vercelli, 35 S.S. 
230

13030  VERCELLI  Loc. 
Caresanablot

Tel : 0161/235254

Fax : 0161/235255

TECNOASSIST S.N.C.

Via Roma, 44/d

22046 MERONE  
(CO)

Tel : 031-618605

Fax : 031-618606

COMPUTER LAB  
S.N.C.

Via F.lli Calvi, 4

24122 BERGAMO

Tel : 035-4243216

Fax : 035-238424

LYAN S.N.C.

Via Camillo Riccio, 
72

10135 TORINO

Tel: 011-3471161

Fax: 011-3470338 

TECNOASSIST  S.N.C.

Via C. Cattaneo, 9

21013 GALLARATE  
(VA)

Tel : 0331-791560

Fax : 0331-793882

COMPUTER SERVICE 
2   S.N.C.

Via Divisione Acqui, 
70

25127 BRESCIA

Tel : 030-3733325

Fax: 030-3733130

MEDIEL S.N.C. 

Via Ugo Bassi, 34

98123 MESSINA

Tel : 090-695962 / 
695988

Fax : 090-694546

TECNOASSIST  S.N.C.

Via F.lli Rosselli 20

20016 PERO - Loc. 
Cerchiate  (MI)

Tel : 02-33913363

Fax : 02-33913364
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COMPUTER SERVICE 
2  S.N.C.

Via V.Guindani, 10 

26100 CREMONA

Tel/Fax : 0372-435861

MEDIEL S.N.C. filiale 
di Catania

Via Novara, 9

95125 CATANIA (CT)

Tel : 095-7169125

Fax : 095-7160889

TECNO STAFF  S.R.L.

Via Vivaldi, 19 

00199 ROMA

Tel : 06-8606173

Fax : 06-86200117

COMPUTER SERVICE 
2  S.N.C.

Via P. Savani, 12/C

43100 PARMA

Tel : 0521-941887

Fax : 0521-940757

MEDIEL S.R.L.

Via S. Caterina, 14

89121 REGGIO 
CALABRIA

Tel : 0965-654711

Fax: 0965-654996 

TECNO STAFF  S.R.L.

Via A.Manzoni, 
263/265

06087 PONTE 
S.GIOVANNI (PG)

Tel : 075-5997381

Fax : 075-5999623

COMPUTER SERVICE 
2 S.N.C.

Via Mantovana, 
127/D

37137 VERONA

Tel : 045/8622929

Fax : 045/8625007

MICROTECNICA  
S.N.C.

Via Lepanto, 83 

80125  NAPOLI

Tel : 081-2394460

Fax : 081-5935521

TUSCIA TECNO STAFF 
S.R.L.

Via Cardarelli, 14

01100 VITERBO

Tel : 0761-270603

Fax : 0761-274594

CONERO DATA  
S.A.S.

Via della 
Repubblica, 7

60020 SIROLO  (AN)

Tel/Fax : 
071-9331175

PRINTER SERVICE 
S.R.L.

Fil. Cosenza

Via Londra, 3

87036 RENDE (CS)

Tel: 0984-837872

Fax: 0984-830348 

DATA SERVICE  S.R.L.

Via S. Allende, 22a

50018 SCANDICCI  
(FI)

Tel : 055-250752

Fax : 055-254111

PRINTER SERVICE 
S.R.L.

Via U. Boccioni, 
25/27

88048 S.Eufemia  
LAMEZIA TERME (CZ)

Tel : 0968-419276

Fax : 0968-419109
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Portugal
EPSON Portugal, S.A.

Rua Gregório Lopes Lote 1514 Restelo

1400 - 197 Lisboa

Tel.: 21 303 54 00

Fax: 21 303 54 90

Serviço de Apoio a Clientes
707 222 000

www.epson.pt

Austria
EPSON Deutschland GmbH

Service & Support

0810-200113

Monday to Friday: 9 a.m. to 9 p.m.

Saturday to Sunday: 10 a.m. to 4 p.m. 

Public holidays: 10 a.m. to 4 p.m.

(0,7 E per minute)

www.epson.at/support/

Netherlands
EPSON Deutschland GmbH

Service & Support

043-3515762
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Monday to Friday: 9 a.m. to 9 p.m.

Saturday to Sunday: 10 a.m. to 4 p.m.

Public holidays: 10 a.m. to 4 p.m.

www.epson.nl/support/

Belgium
EPSON Deutschland GmbH

Service & Support

070-222082

Monday to Friday: 9 a.m. to 9 p.m.

Saturday to Sunday: 10 a.m. to 4 p.m.

Public holidays: 10 a.m. to 4 p.m.

(9 a.m. to 6 p.m.: 0,1735 E per minute, 

remaining time: 0,0868 E per minute)

www.epson.be/support/

www.epson.be/nl/support/

Denmark
Warranty & Support

80 88 11 27

Sales

38 48 71 37

www.epson.dk
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Finland
Warranty & Support

0800 523 010

Sales

(09) 8171 0083

www.epson.fi

Croatia
RECRO d.d.

Trg Sportova 11

10000 Zagreb

Tel.: 00385 1 3091090

Fax: 00385 1 3091095

Email: servis@recro.hr

www.epson@recro.hr

Macedonia
DIGIT COMPUTER ENGINEERING

3 Makedonska brigada b.b

upravna zgrada R. Konkar - 

91000 Skopje

Tel.: 00389 91 463896 oppure

00389 91 463740
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Fax: 00389 91 465294

E-mail: digits@unet.com.mk

REMA COMPUTERS

Str. Kozara, 64-B-11-

1000 Skopje

Tel.: 00389 91 118 159 oppure

00389 91 113 637

Fax: 00389 91 214 338

E-mail: slatanas@unet.com.mk oppure

www.rema@unet.com.mk

Slovenia
REPRO LJUBLJANA d.o.o.

Smartinska 106

1000 Ljubljana

Tel.: 00386 1 5853417

Fax: 00386 1 5400130

E-mail: bojan.zabnikar@repro.si

Luxemburg
EPSON Deutschland GmbH

Service & Support

0352-26483302
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Monday to Friday: 9 a.m. to 9 p.m.

Saturday to Sunday: 10 a.m. to 4 p.m. 

Public holidays: 10 a.m. to 4 p.m.

(9 a.m. to 6 p.m.: 0,1435 E per minute, 

remaining time: 0,0716 E per minute)

http://www.epson.de/eng/support/

Switzerland
EPSON Deutschland GmbH

Service & Support

0848-448820

Monday to Friday: 9 a.m. to 9 p.m.

Saturday to Sunday: 10 a.m. to 4 p.m. 

Public holidays: 10 a.m. to 4 p.m.

(CH local tariff)

www.epson.ch/support/

www.epson.ch/fr/support/

Hungary
EPSON Deutschland GmbH

Service & Support

0680014-783

Monday to Friday: 9 a.m. to 5.30 p.m



251

R4CD000_UK
html.bk Rev. E
CUSTO.FM A5 size
6/10/03

RProof Sign-off:
S.Kodama CRE Kawakami
M.Otsuka
editorname

www.epson.hu/support/

Slovac Republic
EPSON Deutschland GmbH

Service & Support

++421 02 52625241

Monday to Friday: 8.30 a.m. to 5 p.m.

http://www.epson.sk/support/

Czek. Republic
EPSON Deutschland GmbH

Service & Support

00420-800142052

Monday to Friday: 9 a.m. to 5.30 p.m

www.epson.cz/support/

Norway
Warranty & Support

800 11 828

Sales

23 16 21 24

www.epson.no

Sweden
Warranty & Support
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08 445 12 58

Sales

08 519 92 082

www.epson.se

Yugoslavia
BS PPROCESOR d.o.o.

Hazdi Nikole Zivkovica 2

Beograd-F.R.

Tel.: 00381 11 328 44 88

Fax: 00381 11 328 18 70

E-mail: vule@bsprocesor.com;

www.goran@bsprocesor.com

www.gorangalic@sezampro.yu

Greece
Pouliadis Associates Corp.

142 Sygrou Avenue 17671 Kalithea, Athens - GREECE 

Tel.: +30 210 9242072

Fax: +30 210 9241066

E-mail: info@pouliadis.gr

www.pouliadis.gr

Info-Quest SA
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25-27 Pantou Street 17671 Kalithea, Athens - GREECE

Tel: +30 210 9299300

Fax: +30 210 9299399

E-mail: sales@info.quest.gr

www.quest.gr

Informatics SA

117 Ionias Avenue 13671 Aharnes, Athens - GREECE

Tel: +30 210 2370300

Fax: +30 210 2389801

E-mail: postmaster@informatics.gr

www.informatics.gr

Iason Pliroforiki SA

4 Naxou Street 12242 Aegaleo, Athens - GREECE

Tel: +30 210 3484900

Fax: +30 210 3484929

E-mail:  info@iasonhellas.gr

www.e-iason.gr

Despec Hellas SA

8 Arhimidus Street 17778 Tavros, Athens - GREECE 

Tel: +30 210 4899000
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Fax: +30 210 4836849

E-mail: sales@despec.gr

www.despec.gr

ISTANBUL 
Bilgisayar Hastanesi 

Inönü Cad. No:72 Teknik Han Kat:3 80090 
Gümüssuyu-Taksim/Istanbul

Tel : 0 212 252 17 67

Fax : 0 212 244 54 79

E-Mail : epson@bilgisayarhastanesi.com

www.bilgisayarhastanesi.com.tr

Datapro

Alemdag cad. Bayir Sok. No:5/3 Kisikli/Istanbul

Tel : 0 216 461 77 75

Fax : 0 216 344 77 35

E-Mail : epson@datapro.com.tr

www.datapro.com.tr

Romar

Rihtim Cad. 201 Tahir Han Karaköy 80030 Istanbul

Tel : 0 212 252 08 09 

Fax : 0 212 252 08 04
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E-Mail : romar@romar.com.tr

www.romar.com.tr

Ufotek

Sehit Ahmet Sk.4/17 Mecidiyeköy/IST

Tel: 0 212 336 61 45 

Fax: 0 212 336 61 12

E-mail: destek@ufotek.com.tr

www.ufotek.com.tr

Ufotek

Rasimpasa Mah. Nakil Sk. No:19 Kadiköy /IST

Tel: 0 216 418 58 42

Fax: 0 216 418 58 80

E-mail: destek@ufotek.com.tr

ADANA
Datapro

Baraj yolu 2 , 5 durak yeniçeri apt. 615 .sok 2 /b Adana   

Tel : 0 322 459 30 16

Fax : 0 322 459 94 93

E-Mail : epson@datapro.com.tr

Bilgisayar Hastanesi (Türkah)

Toros Cd. Doktorlar Sitesi Asma Kat No:39 Seyhan/Adana   
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Tel : 0 322 459 87 27

Fax : 0 322 459 87 28  

E-Mail : adana@bhtemsilcilik.net

ADIYAMAN
Bilgisayar Hastanesi (U-Com)

Atatürk Bulvari No:217/D Adiyaman

Tel: 0 416 214 40 13 

Fax: 0 416 214 48 58

E-mail: adiyaman@bhtemsilcilik.net

ANKARA
Bilgisayar Hastanesi (EST)

Akay Caddesi No: 22/22 Kavaklidere / Ankara

Tel : 0 312 417 16 40

Fax : 0 312 417 50 88

E-Mail : ankara@bhtemsilcilik.net

Datapro

Çetin Emeç Bulvari - 2.Cad. 28/1 Asagiöveçler/Ankara

Tel : 0 312 482 03 28

Fax : 0 312 4823754

E-Mail : epson@datapro.com.tr

Romar
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Osmanli Caddesi  No:29  Balgat /Ankara 

Tel: 0 312 2874676 (PBX)

Fax: 0 312 2874588

E-Mail : romar@romar.com.tr

Ufotek

Tunus Cad. 54/4 Kavaklidere/Ankara

Tel: 0 312 468 43 80

Fax: 0 312 468 44 12

E-mail: destek@ufotek.com.tr

ANTALYA 
Bilgisayar Hastanesi (Eksen)

Y.Ulusoy Bulvari-86.Sok. No:24/33 Antalya 

Tel: 0 242 248 50 10

Fax: 0 242 248 50 09

E-Mail : antalya@bhtemsilcilik.net

Ufotek

Demirci Kara Mah. 1429 Sok. M.Zeybek Apt. No:4 Antalya

Tel: 0 242 321 54 16

Fax : 0 242 321 54 16

E-mail: destek@ufotek.com.tr
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BURSA
Bilgisayar Hastanesi (ProSistem)

Nalbantoglu Taskapi Sk. Genç Osman 2 Is Hani K:3 D:4 Bursa 

Tel: 0 224 225 36 44

Fax: 0 224 224 66 93

E-Mail : bursa@bhtemsilcilik.net

Bilgisayar Hastanesi (Gözde)

Uluyol Sakarya Mah. Yildiz sok. Demirci is hani Kat:3 D:9 Bursa

Tel: 0 224 271 15 79

Fax : 0 224 271 15 79

E-mail: bursa2@bhtemsilcilik.net

Datapro

Fevzi Çakmak Caddesi Burçin III. Is merkezi No: 54 Kat: 4 Daire: 
412 Fomara / BURSA 

Tel: 0 224 225 29 47

Fax : 0 224 225 29 48

E-Mail : epson@datapro.com.tr

DENIZLI 
Bilgisayar Hastanesi (Aybil)

Murat dede mahellesi, 357. sokak No 8/b 4 Çesme mevkii Denizli

Tel : 0 258 241 97 41

Fax : 0 258 242 1148 
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E-Mail : denizli@bhtemsilcilik.net

DIYARBAKIR 
Bilgisayar Hastanesi (Tmt)

Ekinciler Cad. Azc Plaza K:3 No:7 Diyarbakir

Tel : 0 412 223 60 60 

Fax : 0 412 222 50 96 

E-Mail : diyarbakir@bhtemsilcilik.net

ERZURUM 
Bilgisayar Hastanesi (Atilay)

Çaykara Cad. Sümbül Sok. Fatih Apt No:1 Erzurum

Tel : 0 442 235 46 50

Fax : 0 442 230 31 44   

E-Mail : erzurum@bhtemsilcilik.net

HATAY
Bilgisayar Hastanesi (Data-Bim)

Atatürk Cad.4.Sokak No:2 Antakya-Hatay

Tel: 0 326 213 74 38

Fax : 0 326 215 21 37

E-mail: hatay@bhtemsilcilik.net

IZMIR 
Bilgisayar Hastanesi (Gen)
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1372 Sok. No:24 K:3 D:4-5-6 Çankaya/ Izmir 

Tel: 0 232 445 80 79

Fax: 0 232 445 80 79

E-Mail : izmir2@bhtemsilcilik.net

Datapro

Sair Esref Bulvari No: Kat 5 Daire 503 

Ragip Sanli Is Merkezi

Izmir

Tel : 0 232 4413244

Fax : 0 232 4413245

E-Mail : epson@datapro.com.tr

Romar

Isçiler Cad. Key Plaza No:147/D Alsancak 35220 Izmir

Tel : 0 232 463 39 74

Fax: 0 232 463 39 75

E-Mail : romar@romar.com.tr

Ufotek

1592 Sok. No:42 Depo No:18 Bayrakli/Izmir

Tel: 0 232 435 56 72

Fax : 0 232 486 00 84

E-mail: destek@ufotek.com.tr
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KOCAELI 
Bilgisayar Hastanesi (Gistas)

Güzeller Mahellesi, Bagdat Caddesi No 195 Gebze/Kocaeli

Tel : 0 262 643 65 66

Fax : 0 262 643 65 67

E-Mail : kocaeli@bhtemsilcilik.net

KONYA 
Bilgisayar Hastanesi (Baran)

Nisantasi Mah. Tamer Sk. Bulus Sit. C Blok 9/A 42060 
Selçuklu/Konya

Tel : 0 332 238 91 31

Fax : 0 332 238 91 32

E-Mail : konya@bhtemsilcilik.net

MERSIN 
Bilgisayar Hastanesi (Teknotas)

Istiklal Cad. 33 Sok. Bina:8 D:1 33000 Mersin

Tel : 0324 237 84 01

Fax : 0324 237 86 99

E-Mail : mersin@bhtemsilcilik.net

SAKARYA
Bilgisayar Hastanesi (Elit)

Semerciler Mh.Çark Cd.Aldinç Pasaji No:54/14 Sakarya
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Tel: 0 264 277 56 08

Fax: 0 264 277 03 72

E-Mail: sakarya@bhtemsilcilik.net

SAMSUN
Bilgisayar Hastanesi (Intelsan)

Çiftlik Mah Sefa Sok. Ayazoglu Apt. 17/1 Samsun

Tel : 0 362 231 77 12

Fax : 0 362 234 46 74

E-Mail : samsun@bhtemsilcilik.net

Ufotek

Bahçelievler Mah. 100.yil Bulvari No:284/A

Tel: 0 362 231 67 26

Fax : 0 362 230 52 75

E-mail: destek@ufotek.com.tr

TEKIRDAG
Bilgisayar Hastanesi (Uzay)

Omurtak Cad. Ist. Kismi Peksoy Apt. No:58/8 Çorlu/Tekirdag

Tel : 0 282 651 71 81

Fax : 0 282 652 28 35

E-Mail : tekirdag@bhtemsilcilik.net
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TRABZON
Bilgisayar Hastanesi (Prokom)

Kahramanmaras Cad. Ticaret Mektep Sok. No:7/A Trabzon

Tel : 0 462 326 6642

Fax : 0 462 321 7014

E-Mail : trabzon@bhtemsilcilik.net

ZONGULDAK
Bilgisayar Hastanesi (Ebil)

Erdemir Cad.Abdi Ipekçi Sk.No:4/F K.Eregli/Zonguldak

Tel: 0 372 323 38 64

Fax: 0 372 323 38 64

E-mail: zonguldak@bhtemsilcilik.net

Cyprus
INFOTEL LTD.

Stavrou Avenue

Marlen Cart

Office 101-102

Stovolos

2035 Nicosia

Tel.: 00357 2 368000

Fax: 00357 2 518250
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E-mail: yannis.k@infotel.com.cy;

george.p@infotel.com.cy

Pouliadis Associated Cyprus Ltd

75, Limassol Avenue

2121 Nicosia

Tel. +357 2  490209

Fax +357 2  490240

Poland
EPSON Deutschland GmbH

Service & Support

00800-4911299

Monday to Friday: 9 a.m. to 5.30 p.m

www.epson.pl/support/

Bulgaria
EPSON Deutschland GmbH

Service & Support

www.epson.bg/support/

Romania
EPSON Deutschland GmbH

Service & Support

+40 212305384115
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Monday to Friday: 8.30 a.m. to 5.30 p.m.

www.epson.ro/support/

Estonia
EPSON Deutschland GmbH

Service & Support

+372 6 718 166

Monday to Friday: 9 a.m. to 6 p.m.

http://www.epson.ee/support/

Latvia
EPSON Deutschland GmbH

Service & Support

+371 7286496 

Monday to Friday: 9 a.m. to 6 p.m.

http://www.epson.lv/support/

Lithuania
EPSON Deutschland GmbH

Service & Support

8-37-400088

Monday to Friday: 8.30 a.m. to 5.30 p.m.

http://www.epson.lt/support/
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Israel
Warranty & Support

04 8 560 380

www.epson.com

Middle East
Warranty & Support

+ 971 (0) 4 352 44 88 or 351 77 77

www.epson.com

Email Warranty & Support:

epson-support@compubase.co.ae

South Africa
Warranty & Support

(011) 444 8278 / 91 or 0800 600 578

For details of EPSON Express centres and Service Repair centres 
http://www.epson.co.za/support/index.htm

Sales

(011) 262 9200 or 0800 00 5956

www.epson.co.za/

Bosnia Herzgovina
RECOS d.o.o.

Vilsonovo setaliste 10  

71000  Sarajevo



267

R4CD000_UK
html.bk Rev. E
CUSTO.FM A5 size
6/10/03

RProof Sign-off:
S.Kodama CRE Kawakami
M.Otsuka
editorname

Tel.: 00387 33 657 389

Fax: 00387 33 659 461

E-mail: recos@bih.net.ba oppure

www.edin@recos.ba

Argentina
EPSON ARGENTINA S.A.

Avenida Belgrano 964/970

(1092), Buenos Aires

Tel.: (54 11) 4346-0300

Fax: (54 11) 4346-0333

www.epson.com.ar

Brazil
EPSON DO BRASIL LTDA.

Av. Tucunaré, 720 Tamboré Barueri,

São Paulo, SP 06460-020

Tel.: (55 11) 7296-6100

Fax: (55 11) 7295-5624

www.epson.com.br

Chile
EPSON CHILE, S.A.

La Concepción 322



268

R4CD000_UK
html.bk Rev. E
CUSTO.FM A5 size
6/10/03

L Proof Sign-off:
S.Kodama CRE Kawakami
M.Otsuka
editorname

Providencia, Santiago

Tel.: (56 2) 236-2453

Fax: (56 2) 236-6524

www.epson.cl

Colombia
EPSON COLOMBIA, LTDA.

Diagonal 109 No. 15-49

Bogotá, Colombia

Tel.: (57 1) 523-5000

Fax: (57 1) 523-4180

www.epson.com.co

Costa Rica
EPSON COSTA RICA, S.A

Embajada Americana, 200 Sur y 300 Oeste

San José, Costa Rica

Tel.: (50 6) 296-6222

Fax: (50 6) 296-6046

www.epsoncr.com

Mexico
EPSON MÉXICO, S.A. de C.V.

Av. Sonora #150
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México, 06100, DF

Tel.: (52 5) 211-1736

Fax: (52 5) 533-1177

www.epson.com.mx

Peru
EPSON PERÚ, S.A.

Av. Del Parque Sur #400

San Isidro, Lima, Perú

Tel.: (51 1) 224-2336

Fax: (51 1) 476-4049

www.epson.com

Venezuela
EPSON VENEZUELA, S.A.

Calle 4 con Calle 11-1

La Urbina Sur Caracas, Venezuela

Tel.: (58 2) 240-1111

Fax: (58 2) 240-1128

www.epson.com.ve

USA (Latin America)
EPSON LATIN AMERICA

6303 Blue Lagoon Dr., Ste. 390
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Miami, FL 33126

Tel.: (1 305) 265-0092

Fax: (1 305) 265-0097

USA
EPSON AMERICA, INC

3840 Kilroy Airport Way

Long Beach, CA 90806

Tel.: (1 562) 981-3840

Fax: (1 562) 290-5051

www.epson.com
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Other Information

Setting Up Your Printer on a Network

For Windows XP, 2000, and NT 4.0

This section tells you how to set up your printer so that other 
computers on the network can use it.

Note:
❏ This section is written for small network users only. If you are on a 

large network and would like to share your printer, consult your 
network administrator.

❏ To install software programs in Windows XP, it is necessary to log 
on with a Computer Administrator account. You cannot install 
software programs if you log on as a Limited account user.
After you install Windows XP, the user account is set as a Computer 
Administrator account.

❏ To install software programs in Windows 2000 or NT 4.0, it is 
necessary to log on as a user with administrative privileges (a user 
who belongs to the Administrators group.)

❏ The figures that are provided in the following section pertain to 
Windows 2000.

First, set up the printer as a shared printer on the computer 
connected directly to the printer. Then, add the printer to each 
computer that will access it through the network.
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Setting up your printer as a shared printer

To share a printer with other computers on a network, follow the 
steps below to configure the computer connected directly to the 
printer.

Note:
The figures provided in the following section pertain to Windows XP.

1. For Windows XP, click Start, Control Panel, then 
double-click Printers and Faxes. (If the Control Panel is in 
Category View, click Printers and Other Hardware, then 
click Printers and Faxes.)
For Windows 2000 and NT 4.0, click Start, point to Settings, 
then click Printers.

2. Right-click the icon for your printer, then click Sharing.

3. For Windows XP and 2000, select Shared as, then type a name 
for the shared printer.
For Windows NT 4.0, select Shared, and then type a name for 
the shared printer.
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Note:
Do not use spaces or hyphens in the printer name.

If you want Windows XP, 2000 or NT 4.0 to automatically 
download printer drivers for computers that are running 
different versions of Windows, click Additional Drivers and 
select the environment and the operating systems for the 
other computers. Click OK, then insert the printer software 
CD into the CD-ROM drive. Select WINNT40 for Windows 
NT 4.0.

4. Click OK, or click Close if you installed additional drivers.

Accessing the printer through a network

To use your printer from other computers on a network, you must 
first add the printer to each computer that will access it. Follow 
the steps below.
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Note:
Your printer must be set up as a shared resource on the computer to 
which it is directly connected before you can access it from another 
computer.
& See “Setting up your printer as a shared printer”

1. For Windows XP, click Start, Control Panel, then 
double-click Printers and Faxes. (If the Control Panel is in 
Category View, click Printers and Other Hardware, then 
click Printers and Faxes.)
For Windows 2000 and NT 4.0, Click Start, point to Settings, 
then click Printers.

2. Double-click the Add Printer icon. The Add Printer Wizard 
appears.

3. Click Next.

4. Select Network printer, then click Next.

5. On the next screen, click Next.



275

R4CD000_UK
html.bk Rev. E
NETWK.FM A5 size
6/10/03

RProof Sign-off:
S.Kodama CRE Kawakami
M.Otsuka
editorname

6. Double-click the icon of the computer that is directly 
connected to the printer. Then, click the icon for the 
appropriate printer.

7. Click Next and follow the on-screen instructions.

Note:
❏ Depending on the operating system and the configuration of the 

computer to which the printer is connected, the Add Printer Wizard 
may prompt you to install the printer driver from the printer 
software CD-ROM. In this case, click the Have Disk button and 
follow the on-screen instructions.

❏ To monitor the status of a shared printer, EPSON Status Monitor 3 
must be installed on each computer. EPSON Status Monitor 3 is 
automatically installed when you install the printer software for the 
first time.

For Windows Me, 98, and 95

This section tells you how to set up your printer so that other 
computers on a network can use it.
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First, set up the printer as a shared printer on the computer 
connected directly to the printer. Then, install the printer software 
on each computer that will access the printer through the 
network.

Note:
This section describes how to use your printer as a shared printer on a 
network. To connect your printer directly to a network without setting 
it up as a shared printer, consult your network administrator.

Setting up your printer as a shared printer

To share a printer with other computers on a network, follow the 
steps below to configure the computer connected directly to the 
printer.

1. Click Start, point to Settings, then click Control Panel.

2. Double-click the Network icon.

3. Click File and Print Sharing.

4. Select the I want to be able to allow others to print to my 
printer(s) check box and click OK.

5. In the Network dialog box, click OK.

6. In the Control Panel, double-click the Printers icon.



277

R4CD000_UK
html.bk Rev. E
NETWK.FM A5 size
6/10/03

RProof Sign-off:
S.Kodama CRE Kawakami
M.Otsuka
editorname

Note:
❏ If a dialog box appears requesting that you insert the 

Windows Me, 98, or 95 CD-ROM, insert the CD into the 
CD-ROM drive, then follow the on-screen instructions.

❏ If a dialog box appears requesting that you restart your 
computer, do so, open the Printers folder, then continue with 
step 7.

7. Select the icon for your printer in the Printers folder, then click 
Sharing on the File menu.

8. Select Shared As, type the printer information as required, 
then click OK.

Accessing the printer through a network

To use your printer from other computers on a network, first add 
the printer to each computer that will access it. Follow the steps 
below.
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Note:
Your printer must be set up as a shared resource on the computer to 
which it is directly connected before you can access it from another 
computer.
& See “Setting up your printer as a shared printer”

1. Click Start, point to Settings, then click Printers.

2. Double-click the Add Printer icon. The Add Printer Wizard 
appears.

3. Click Next.

4. Select Network printer, then click Next.

5. On the next screen, click Browse.
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6. Double-click the icon of the computer that is directly 
connected to the printer. Then, click the icon for the 
appropriate printer.

7. Click OK and follow the on-screen instructions.

Note:
To monitor the status of a shared printer, EPSON Status Monitor 3 
must be installed on each computer. EPSON Status Monitor 3 is 
automatically installed when you install the printer software for the 
first time.

For Mac OS 8.6 to 9.x

This section tells you how to set up the printer so that you can use 
it on an AppleTalk network. By setting up your printer as a shared 
printer, your local printer is connected to the network and can be 
used by other computers.

First, set up the printer as a shared printer on the computer 
connected directly to the printer. Next, specify the network path 
to the printer from each computer that will use it, and install the 
printer software on those computers.
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Setting up your printer as a shared printer

To share a printer with other computers on an AppleTalk 
network, follow the steps below to configure the computer 
connected directly to the printer.

1. Turn on the printer.

2. Choose Chooser from the Apple menu, click the icon for your 
printer, then select the port the printer is connected to.

3. Click the Setup button. The Printer Sharing Setup dialog box 
opens.
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4. Select the Share this Printer check box, then type the printer 
name and password information as necessary.

5. Click OK. The name of the shared printer will appear in the 
port list in the Chooser.

6. Close the Chooser.

Accessing the printer through a network

To access your printer from other computers on a network, follow 
the steps in this section for each computer that will access the 
printer.

1. Turn on your printer.

2. Install the printer software from the printer software 
CD-ROM.

3. Choose Chooser from the Apple menu. Click the appropriate 
printer icon and select the printer port that you want to use 
from the Select a printer port list.
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Note:
Only printers that are connected to your current AppleTalk zone 
are available.

If the following dialog box appears, enter the password for 
the printer, then click OK.

4. Select the appropriate Background Printing radio button to 
turn background printing on or off.

5. Close the Chooser.

For Mac OS X

Use the Printer Sharing setting, which is a standard feature of Mac 
OS X 10.2 or later. This feature is not available with Mac OS X 10.1.
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See your operating system’s documentation for details.
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Increasing the Print Speed

Follow the instructions in this section to increase the print speed 
of your printer.

General tips

Just as printing at a high resolution requires more processing time 
than printing at a low resolution, printing in color takes longer 
than printing in black-and-white because the volume of data in a 
color document is much greater. For this reason, it is important 
to be selective in your use of color printing if you also require a 
fast print speed.

However, even if your document requires the highest resolution 
and extensive use of color—for example, when you are printing 
a camera-ready composite that includes color photographs—it 
may still be possible to optimize the print speed by adjusting other 
printing conditions. Keep in mind that changing some conditions 
to increase the print speed may also lower print quality.

The following table shows the factors that inversely affect print 
speed and print quality (increasing one will decrease the other).

Print quality
Print speed

Lower
Faster

Higher
Slower

Printer 
software 
menu

Printer 
software 
settings

Paper & 
Quality Options
(Windows),
Print Quality
(Macintosh)

Economy
, Normal

Photo Advanced 
dialog box

High Speed On Off

Data 
characteristics

Image size Small Large -

Resolution Low High
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The table below shows the factors related to print speed only.

Print speed Faster Slower Printer 
software 
menu

Printer 
software 
settings

Orientation Portrait Landsca
pe

Main menu 
(Windows), 
Page Setup 
dialog box 
(Macintosh)

Color** Black Color Advanced 
dialog box, 
Main menu 
(Windows), 
Print dialog 
box 
(Macintosh)

Mirror Image* Off On Advanced 
dialog box

Edge 
smoothing*

Off On Advanced 
dialog box

Fast Feed* On Off Advanced 
dialog box

Photo 
Enhance

Off On Advanced 
dialog box, 
Main menu 
(Windows), 
Print dialog 
box 
(Macintosh)

Collate* Off On Page 
Layout 
menu 
(Windows), 
Layout 
dialog box 
(Macintosh)

Reverse 
Order*

Off On
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* Varies depending on the printer software and application being used.

** Varies depending on the media type printed on.

Using the Speed & Progress dialog box (Windows 
only)

You can make certain print speed settings in the Speed & Progress 
dialog box. Click the Speed & Progress button on your printer 
software’s Utility menu. The following dialog box appears.

The available settings that are related to print speed are as follows:

Hardware 
resources

System speed Faster Slower -

Free hard disk 
space

Large Small

Available 
memory

Large Small

Software 
status

Running 
applications

One Many -
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High Speed Copies

To print multiple copies of your document faster, select High 
Speed Copies. This speeds up printing by using your hard disk 
space as a cache when printing multiple copies of your document.

EPSON Printer Port (Windows Me, 98,and 95)

For printer models that use the parallel port, select this check box 
to enable the EPSON printer port optimized for EPSON printers, 
instead of the default Windows printer port. This speeds up the 
data transfer rate to EPSON printers. Parallel port users can 
further increase print speed by enabling DMA transfer, as 
explained below.

Enabling DMA transfer

If your computer has a parallel port that supports ECP mode, you 
can enable DMA transfer to speed up printing. See your computer 
manual to determine if it supports ECP mode and DMA transfer.

To determine whether you need to enable DMA transfer, compare 
the message below the EPSON Printer Port check box to this table, 
and take the recommended action.

Message Action

High Speed (DMA) 
Transfer enabled.

DMA transfer is already enabled. Click OK to 
close the dialog box.

For higher data transfer 
rates, use DMA Transfer.

Follow the steps below this table to enable 
DMA transfer.



289

R4CD000_UK
html.bk Rev. E
SPEED.FM A5 size
6/10/03

RProof Sign-off:
S.Kodama CRE Kawakami
M.Otsuka
editorname

If you want to enable DMA transfer, follow the steps below.

1. Double-click the My Computer icon on your desktop, then 
Control Panel.

2. Double-click the System icon, and then click the Device 
Manager tab.

3. Double-click the Ports (COM & LPT) icon, then the LPT1 icon. 
If your printer is connected to a port other than LPT1, 
double-click the appropriate port icon.

(No message) Your system's parallel port setting does not 
allow DMA transfer. However, if you change 
the parallel port setting to ECP or Enhanced 
using your computer's BIOS Setup program, 
you may be able to use DMA transfer. Consult 
your computer manual or computer 
manufacturer for instructions. Once you 
change the parallel port setting, follow the 
steps below this table to enable DMA transfer.

Note:
Before you run the BIOS Setup program, 
uninstall the printer software using 
Add/Remove Programs in the Control Panel. 
After running the BIOS Setup program, reinstall 
the printer software.

Message Action
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4. Click the Resources tab, and then clear the Use automatic 
settings check box. Write down the Input/Output Range 
settings shown in the resource settings box.

5. From the Setting based on list, select a basic configuration 
setting that uses the same Input/Output Range settings as 
those you wrote down in Step 4, and make sure that the Direct 
Memory Access channel and Interrupt Request numbers are 
allocated and displayed. Confirm also that the Conflicting 
device list text box shows No conflicts.

6. Click OK to save the settings.

7. Reopen the Speed & Progress dialog box to verify whether 
DMA transfer has been enabled.

Note:
You may not be able to use DMA transfer on some computers even 
after you make the settings explained above. Consult your computer 
maker for information on the DMA transfer capability of your 
computer.
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Using Port Configuration (Windows NT 4.0 only)

Note:
Port settings are complicated and should only be made by an experienced 
user with administrative privileges.

If your computer has a parallel port that supports ECP mode, you 
can make certain print speed settings in the Port Configuration 
dialog box. Before making settings, make sure that ECP mode has 
been selected in your computer settings. For details about ECP 
mode, see your computer manual. 

To access the Port Configuration dialog box, click the Start button, 
point to Settings, and click Printers. Then, select your printer and 
click Properties on the File menu. The printer driver opens. Click 
the Ports tab, then click Configure Port. The following dialog box 
appears. 

Click the LPT port tab for the port to which your printer is 
connected, then click the Port Configuration button. 
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Note:
If your printer is connected to LPT1, only the LPT1 tab is available.

The available settings are as follows:

Resource settings (IRQ and DMA)

If you have connected your printer to LPT2 or LPT3, making IRQ 
and DMA settings here may speed up printing. Click Change 
setting and input the same configuration numbers for IRQ and 
DMA which you have made with your expansion board. See your 
computer documentation to determine the settings for IRQ and 
DMA.

Use DMA transfer

Using DMA transfer to send print data to the computer may help 
speed up printing. If the Use DMA Transfer check box is not 
enabled, you must first enable DMA transfer in your computer 
settings. For details, see your computer documentation.
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Updating and Uninstalling Software

Follow the directions in this section if you have updated your 
computer’s operating system, if you want to update your printer 
software from a previous version, or if you need to uninstall the 
printer software.

Updating to Windows Me or 98

If you have upgraded your computer’s operating system from 
Windows 95 to Windows Me or 98, you must uninstall your 
printer software, and then install it again.
& See “Uninstalling the printer software”

Updating the printer software in Windows Me, XP, 
2000, or NT 4.0

When you update the printer software in Windows Me, XP, and 
2000, be sure to uninstall the previous printer software before you 
install the new software. Installing over the existing printer 
software results in a failure to update.
& See “Uninstalling the printer software”

Uninstalling the printer software

For Windows

Note:
❏ To uninstall applications in Windows 2000 or NT 4.0, it is 

necessary to log on as a user with administrative privileges 
(a user who belongs to the Administrators group).
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❏ To uninstall applications in Windows XP, it is necessary to log on 
with a Computer Administrator account. You cannot uninstall 
applications if you log on as a Limited account user.

1. Turn off the printer and disconnect the cable from the printer.

2. For Windows Me, 98, 95, 2000, and NT 4.0, click the Start 
button, point to Settings, then select Control Panel.
For Windows XP, click the Start button, then select Control 
Panel.

3. Double-click the Add/Remove Programs icon and select 
EPSON Printer Software from the list. Then, click 
Add/Remove (or Change/Remove in Windows XP and 
2000).

4. Select the EPSON Stylus C84 icon, then click OK.

5. Click OK.

Note:
If you are using the USB port to connect the printer in Windows Me or 
98, you need to uninstall an additional USB component. Select EPSON 
USB Printer Devices from the list in the Add/Remove Programs 
utility, click Add/Remove, then click OK when a message prompts 
you to restart the computer. If EPSON USB Printer Devices does not 
appear in the Add/Remove Programs list, double-click EPUSBUN.EXE 
on the printer software CD-ROM, then follow the on-screen 
instructions.

For Macintosh

Note:
You cannot uninstall the printer driver in Mac OS X.

1. Turn on your Macintosh and insert the software CD into the 
CD-ROM drive. The EPSON printer software disk will open 
automatically.
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2. If separate folders containing installer icons for several 
languages appear, double-click the folder for your preferred 
language, then double-click the Installer icon in the Disk 1 
folder inside the Disk Package folder.

3. After the initial screen, click Continue.

4. Select Uninstall from the pull-down menu at the top left, and 
then click Uninstall.

Uninstalling the Reference Guide

For Windows

Note:
❏ To uninstall applications in Windows 2000 or NT 4.0, it is 

necessary to log on as a user with administrative privileges 
(a user who belongs to the Administrators group).

❏ To uninstall applications in Windows XP, it is necessary to log on 
with a Computer Administrator account. You cannot uninstall 
applications if you log on as a Limited account user.

In Windows XP, you cannot uninstall applications if you log on 
as a Limited-account user.
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1. Turn off the printer and disconnect the cable between the 
printer and the computer.

2. In Windows XP, click the Start button, then select Control 
Panel. In Windows Me, 98, 95, or 2000, click the Start button, 
point to Settings, then select Control Panel.

3. Double-click the Add or Remove Programs icon, then select 
ESC84 Reference Guide from the list. Click 
Change/Remove in Windows XP or 2000, or 
Add/Remove in Windows Me, 98, or 95.

4. Click OK.

Note:
If you are using a USB port to connect the printer in a Windows 
Me or 98 environment, you also need to uninstall a USB component. 
Select EPSON USB Printer Devices from the list in the Add or 
Remove Programs utility, click Change/Remove or 
Add/Remove, then click OK when a message prompts you to 
restart the computer. If EPSON USB Printer Devices does not 
appear in the Add or Remove Programs list, double-click 
EPUSBUN.EXE on the printer software CD-ROM, then follow the 
on-screen instructions.

For Macintosh

Drag the Reference Guide folder, located in the EPSON Stylus C84 
folder, from the hard disk to the Trash. Then, drag the ESC84 
Reference Guide icon from the desktop to the Trash.

Cleaning the Printer

To keep your printer operating at its best, clean it thoroughly 
several times a year as follows.

1. Unplug the printer’s power cord.
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2. Remove any paper from the sheet feeder.

3. Use a soft brush to carefully clean away all dust and dirt from 
the sheet feeder.

4. If the outer case or the inside of the sheet feeder is dirty, wipe 
it with a soft, clean cloth dampened with mild detergent. Keep 
the printer cover closed to prevent water from getting inside.

5. If the inside of the printer accidentally gets soiled with ink, 
wipe it off with a damp cloth.

6. If ink have leaked inside the printer, wipe the inside of the 
printer with a soft, clean cloth.

w
Warning:
Be careful not to touch the gears or rollers inside the printer.
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c
Caution:
❏ Do not apply grease to the metal parts under the print head 

carriage.

❏ Never use alcohol or thinner to clean the printer, as these 
chemicals can damage the components as well as the case.

❏ Be careful not to get water on the printer mechanism or 
electronic components.

❏ Do not use a hard or abrasive brush.

❏ Do not spray the inside of the printer with lubricants. 
Unsuitable oils can damage the mechanism. Contact your 
dealer or a qualified service person if lubrication is needed.

Transporting the Printer

If you need to transport your printer, carefully prepare and repack 
it as described below using the original box (or a similar box that 
the printer fits snugly into) and packing materials. Follow the 
steps below.

w
Warning:
Be careful when you handle the used ink cartridges, as there may 
be some ink around the ink supply port. If ink gets on your skin, 
wash the area thoroughly with soap and water. If ink gets into 
your eyes, flush them immediately with water. If discomfort or 
vision problems continue after a thorough flushing, see a doctor 
immediately.
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c
Caution:
❏ When storing or transporting the printer, do not tilt it, stand 

it up vertically, or turn it upside down. Otherwise, ink may 
leak because of shock or vibration.

❏ When you transport the printer, remove all ink cartridges 
from the printer. Otherwise, ink may leak because of shock or 
vibration.

1. Plug in the printer, then turn on the printer.

2. Press the H ink button. The print head moves to the ink 
cartridge replacement position, and the P power light begins 
to flash.

c
Caution:
Do not move or force the print head by hand, as this may 
damage the printer. Always press the H ink button to move 
the print head.

Note:
Do not press the H ink button over three seconds; otherwise, the 
printer starts cleaning the print head.

3. Open the printer cover, then open the cartridge cover.

4. To remove all ink cartridges, pinch the sides of each ink 
cartridge, then lift each cartridge out of the printer.

5. Close the cartridge cover, then close the printer cover.

6. Press the H ink button. The print head returns to the home 
position.

7. Turn off the printer, then unplug the printer.

8. Disconnect the interface cable from the printer.
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9. Remove the paper from the sheet feeder and remove the paper 
support.

10. Open the printer cover again. Secure the ink cartridge holder 
to the printer with tape as shown below, then close the printer 
cover.

11. Raise the output tray.

12. Attach the protective materials to both sides of the printer.

13. Repack the printer and power cord in the original box.

14. Keep the printer level during transport.

15. Be sure to remove the tape from the printer before using it 
again.
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Printer Parts and Control Panel Functions

Printer Parts

a. Paper support: Supports the paper loaded in the sheet feeder.

b. Sheet feeder: Holds blank paper and automatically feeds the 
paper during printing.

c. Printer cover: Covers the printing mechanism. Open only when 
installing or replacing ink cartridges.

d. Output tray: Receives the ejected paper.

e. Output tray extension: Supports the ejected paper.
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f. Edge guides: Help load the paper straight. Adjust the left edge 
guide to fit the width of your paper.

a. Cartridge cover: Hold the ink cartridges in place. Open only 
when installing or replacing ink cartridges.

b. Print head: Delivers ink to the page.

c. Control panel: Controls various printer functions. See the next 
section for details.

Control panel

Buttons

Button Function

power

Turns the printer on and off.
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Lights

paper

Loads or ejects paper. 

Resumes printing if pressed after a paper out error or 
double feed error.

If pressed while printing, cancels the printing of a page 
or a print job.

ink

Moves the print head to the ink check position when an 
empty ink cartridge is detected.

Moves the print head to the ink cartridge replacement 
position.

Returns the print head to its home position after ink 
cartridge replacement.

Performs print head cleaning if held down for three 
seconds when the H ink out light is off.

Light Description

power

On when the printer is on.

Flashing when the printer is receiving data, printing, 
having an ink cartridge replaced, charging ink, or 
cleaning the print head.

paper out

On when the printer is out of paper or when a double 
feed Error is detected. Load paper into the sheet feeder, 
then press the ) paper button to resume printing. 

Flashing when the paper is jammed. Take all of the paper 
out of the feeder, then reload the paper. If the light 
continues to flash, turn off the printer and gently pull all 
of the paper out of the printer.

ink out

Flashing when the ink cartridge is nearly empty.

On when the ink cartridge is empty. Replace the ink 
cartridge.
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Options and Consumable Products

Options

The options below are available for your printer.

Interface cables

EPSON offers the interface cable listed below for use with your 
printer. However, you can use any interface cable that meets these 
specifications. See your computer manual for any additional 
requirements.

❏ USB Interface Cable (shielded) C83623✽ from Series A 
4-pin (computer) to series B 4-pin (printer).

❏ Parallel Interface Cable (shielded) C83602✽ from D-SUB 
25-pin (computer) to 36-pin Amphenol 57 Series (printer)

Note:
❏ The asterisk (✽) is a substitute for the last digit of the product 

number, which varies by location.

❏ Depending on your geographic location, this cable may not be 
supplied.

c
Caution:
Use only the interface cables which meet the specifications listed 
above. Using other cables not covered by EPSON warranties may 
cause the printer to malfunction.

Consumable products

The following ink cartridges and EPSON special media are 
available for your printer.
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Ink cartridges

You can use the following cartridges with your printer.

Note:
The product numbers of ink cartridges may vary by location.

Media Types

EPSON offers specially designed media for ink jet printers to meet 
most high-quality printing needs.
& See “Media Type Settings”

Note:
❏ The availability of special media varies by location.

❏ For the latest information on media available in your area, contact 
EPSON customer support web site.
& See “Contacting Customer Support”

Black Ink cartridge T0431, T0441

Color ink cartridge
Cyan
Magenta
Yellow

T0442, T0452
T0443, T0453
T0444, T0454
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Exif Print

Exif Version 2.2 (also called Exif Print, an international standard 
for digital cameras) allows you to print fine-quality photographs 
using, in combination, a digital camera and printer that support 
this feature.

Note:
You need to install EPSON PhotoQuicker before you can use the Exif 
Print function. EPSON PhotoQuicker is not available for Windows NT 
4.0 or Mac OS X.

Effectiveness

Exif Print

When taking photographs using an Exif Print compatible digital 
camera, information about camera settings and scene conditions 
when the photograph was taken is embedded in the photo data. 
Such information includes exposure mode, white balance, gain 
control, contrast, saturation, and sharpness, among other 
attributes. The printer then corrects and enhances the photo data 
using this information and prints an image that reflects the 
original scene captured by the digital camera.
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Printout without Exif Print

Printout with Exif Print

When Exif Print data is embedded in the photo data, the printer 
interprets how to adjust and print the image.

Note:
The images above are samples. Print results depend on the printer.



309

R4CD000_UK
html.bk Rev. E
EXIF.FM A5 size
6/10/03

RProof Sign-off:
S.Kodama CRE Kawakami
M.Otsuka
editorname

How to use

Take pictures using Exif Print compatible digital cameras, then 
use EPSON PhotoQuicker to print them. EPSON PhotoQuicker is 
included on the software CD-ROM.

Exif Print is compatible with the media listed below.

Select from these media types when printing.

Plain Paper/EPSON Bright White Ink Jet Paper/
EPSON Photo Paper/
EPSON Matte Paper-Heavyweight/
EPSON Premium Semigloss Photo Paper/
EPSON DURABrite Photo Paper/
EPSON DURABrite Ink Glossy Photo Paper

Note:
Refer to the digital camera's documentation to find out whether the 
camera is Exif Print compatible.

Refer to the EPSON PhotoQuicker User's Guide included on the 
software for instructions.
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Printer Specifications

Printing

Paper

Note:
Since the quality of any particular brand or type of paper may be changed 
by the manufacturer at any time, EPSON cannot attest to the quality of 
any non-EPSON brand or type of paper. Always test samples of paper 
stock before purchasing large quantities or printing large jobs.

Printing method On-demand ink jet

Nozzle configuration Monochrome (black) 180 nozzles

Color (cyan, magenta, yellow) 177 nozzles 
(59 × 3 colors)
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Paper specifications

Single sheets:

Envelopes:

Size A4 (210 × 297 mm)

A5 (148 × 210 mm)

Letter (216 × 279 mm)

Half letter (139.7 × 215.9 mm)

Legal (216 × 356 mm)

Executive (184.2 × 266.7 mm)

100 × 150 mm

5 × 7" (127 × 178 mm)

3.5 × 5" (89 × 127 mm)

Paper types Plain bond paper, special paper distributed by 
EPSON

Thickness
(for plain 
bond paper)

0.08 to 0.11 mm (0.003 to 0.004 inch)

Weight
(for plain 
bond paper)

64 g/m² (17 lb) to 90 g/m² (24 lb)

Size No. 10 (104.8 × 241 mm) 

DL (110 × 220 mm) 

C6 (114 × 162 mm)

132 × 220 mm

Paper types Plain bond paper, air mail

Thickness 0.16 to 0.52 mm (0.006 to 0.02 inch)

Weight 45 g/m² (12 lb) to 75 g/m² (20 lb)
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Premium Ink Jet Plain Paper:

Bright White Ink Jet Paper: 

Matte Paper-Heavyweight: 

Double Sided Matte Paper: 

Archival Matte Paper: 

Photo Quality Ink Jet Paper: 

Size A4 (210 mm × 297 mm) 

Paper types Special paper distributed by EPSON

Size A4 (210 mm × 297 mm)

Paper types Special paper distributed by EPSON

Size Letter (216 mm × 279 mm) 

A4 (210 mm × 297 mm) 

8 × 10" (203 mm × 254 mm)

Paper types Special paper distributed by EPSON

Size Letter (216 mm × 279 mm) 

A4 (210 mm × 297 mm)

Paper types Special paper distributed by EPSON

Size A4 (210 mm × 297 mm)

Paper types Special paper distributed by EPSON

Size Letter (216 mm × 279 mm) 

A6 (105 mm × 148 mm) 

5 × 8" (127 mm × 203 mm) 

8 × 10" (203 mm × 254 mm)
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DURABrite Photo Paper:

DURABrite Ink Glossy Photo Paper:

Photo Paper: 

Glossy Photo Paper: 

Premium Semigloss Photo Paper: 

Paper types Special paper distributed by EPSON

Size A4 (210 mm × 297 mm) 

100 mm × 150 mm

Paper types Special paper distributed by EPSON

Size Letter (216 mm × 279 mm)

4 × 6" (113.6 mm × 175.4 mm)

Paper types Special paper distributed by EPSON

Size A4 (210 mm × 297 mm) 

100 mm × 150 mm 

4 × 6" (113.6 mm × 175.4 mm)

Paper types Special paper distributed by EPSON

Size Letter (216 mm × 279 mm) 

4 × 6" (113.6 mm × 175.4 mm)

Paper types Special paper distributed by EPSON

Size Letter (216 mm × 279 mm) 

A4 (210 mm × 297 mm)

Paper types Special paper distributed by EPSON
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Transparencies: 

Note:
❏ Poor quality paper may reduce print quality and cause paper jams 

or other problems. If you encounter problems, switch to a higher 
grade of paper.

❏ Do not load curled or folded paper.

❏ Use paper under normal conditions:
Temperature 15 to 25° C (59 to 77° F)
Humidity 40 to 60% RH

Printable area

Single sheets (including panoramic size) and index cards

Size A4 (210 mm × 297 mm) 

Letter (216 mm × 279 mm)

Paper types Special paper distributed by EPSON

Normal Borderless

A

C

B-L B-R
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Envelopes

Note:
Depending on the type of media being used, print quality may decline 
in the top and bottom areas of the printout, or these areas may be smeared.

Diagonal lines show printable area.

A: The minimum top margin is 3.0 mm (0.12").

B-L: The minimum left margin is 3.0 mm (0.12").

B-R: The minimum right margin is 3.0 mm (0.12").

C: The minimum bottom margin is 3.0 mm (0.12") for 
single sheets (including panoramic size) and index 
cards.

D: The minimum bottom margin is 20 mm (0.78”) for 
envelopes.
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Ink Cartridges

Black ink cartridge

Color Black

Cartridge life Within 6 months after opening package, at 25°C [77°F]

Temperature Storage:
-20 to 40°C (-4 to 104°F)

1 month at 40°C (104°F)

Transit:
-30 to 50°C (-22 to 122°F)

10 days at 50°C (122°F)

Freezing:*
-16°C (3.2°F)

Dimensions 12.7 mm (W) × 73.5 mm (D) × 55.3 mm (H)
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Color ink cartridge

* Ink thaws and is usable after approximately 3 hours at 25°C (77°F).

c
Caution:
❏ EPSON recommends the use of original EPSON ink 

cartridges only. Products not manufactured by EPSON may 
cause damage to your printer and will not be covered by 
EPSON's warranties.

❏ Do not use an ink cartridge if the date on the package has 
expired.

❏ Do not refill the ink cartridge. The printer calculates the 
amount of ink remaining using an IC chip on the ink 
cartridge, so even if the cartridge is refilled, the IC chip will 
report that it is empty.

Color Cyan, magenta, and yellow

Cartridge life Within 6 months of opening the package, at 25°C [77°F]

Temperature Storage:
-20 to 40°C (-4 to 104°F) 

1 month at 40°C (104°F)

Transit:
-30 to 50°C (-22 to 122°F)

10 days at 50°C (122°F)

Freezing:*
-16°C (3.2°F)

Dimensions 12.7 mm (W) × 73.5 mm (D) × 55.3 mm (H)
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Mechanical

Electrical

Paper path Sheet feeder, rear entry

Sheet feeder 
capacity

About 120 sheets at 90 g/m² (24 lb) paper

Dimensions Storage

Width: 460 mm (18.1 inches) 

Depth: 242 mm (9.5 inches) 

Height: 198 mm (7.8 inches)

Printing

Width: 460 mm (18.1 inches) 

Depth: 437 mm (17.2 inches)

Height: 308 mm (12.1 inches)

Weight 4.2 kg (9.3 lb) without the ink cartridges

Input voltage range 90 to 264 V

Rated frequency range 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0.4 to 0.2 A

Power consumption Approx. 19 W (ISO10561 Letter Pattern)
Approx. 4.5 W in Sleep mode
0.8 W in power-off mode
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Note:
Check the label on the back of the printer for the voltage of your printer.

Environmental

* Stored in a shipping container

** Without condensation

Standards and Approvals

UP model:

Temperature Operation: 
10 to 35°C (50 to 95°F)

Storage: 
-20 to 60°C (-4 to 140°F)

1 month at 40°C (104°F)

Transit:*
-20 to 60°C (-4 to 140°F)

120 hours at 60°C (140°F)

Humidity Operation: 
20 to 80% RH

Storage:*,** 
5 to 85% RH

Safety UL 60950
CSA No. 60950

EMC FCC part 15 subpart B class B
CSA C108.8 class B
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European model:

Australian model:

System Requirements

Using the printer

Refer to the appropriate section below for the minimum and 
recommended computer system requirements necessary to use 
this printer.

For Windows

To use your printer, you need to have Microsoft® Windows® XP, 
Me, 98, 95, 2000, or Windows NT® 4.0 installed.

USB connection:
To connect your printer via a standard, shielded USB 1.1 cable, 
you need a Windows XP, 98, or 2000 pre-installed PC equipped 
with a USB port. For Windows Me users, your PC must be a 
Windows Me pre-installed model or upgraded from a 
Windows 98 pre-installed model.

Parallel connection:
When connecting to a parallel port, use a shielded, twisted-pair 
parallel cable.

Low Voltage Directive 73/23/EEC EN 60950

EMC Directive 89/336/EEC EN 55022 class B
EN 55024
EN 61000-3-2
EN 61000-3-3

EMC AS/NZS 3548 Class B
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Your computer should also meet the following system 
requirements.

Your computer dealer can help you update your system if it does 
not meet these requirements.

For Macintosh

To connect this printer to Apple® Macintosh® computers, you 
must use a USB cable.

Minimum System Requirements Recommended System

Pentium 150 MHz processor for 
Windows Me

Pentium processor for Windows 98, 
95, and NT 4.0

Pentium 233 MHz processor for 
Windows XP

Pentium 133 MHz processor for 
Windows 2000

Pentium 150 MHz or higher 
processor for Windows Me

Pentium or higher processor for 
Windows 98, 95, and NT 4.0

Pentium 300 MHz or higher for 
Windows XP

Pentium 133 MHz or higher for 
Windows 2000

32 MB RAM for Windows Me

16 MB RAM for Windows 98, 95, and 
NT 4.0

64 MB RAM for Windows XP and 
2000

64 MB RAM or more for 
Windows Me, 98, 95, 2000, and 
NT 4.0

128 MB RAM or more for 
Windows XP

20 MB hard disk space for 
Windows Me, 98, and 95

50 MB hard disk space for 
Windows XP

40 MB hard disk space for 
Windows 2000 and NT 4.0

50 MB hard disk space or more for 
Windows Me, 98, and 95

100 MB hard disk space or more for 
Windows XP, 2000, and NT 4.0

SVGA monitor for Windows XP, Me, 
98, 95, 2000, and NT 4.0

SVGA monitor or better for Windows 
XP, Me, 98, 95, 2000, and NT 4.0
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Your Macintosh must also meet the following system 
requirements.

Note:
❏ For Mac OS 8.6 to 9.x, the amount of available memory varies 

according to the number and kind of applications that are open. To 
see how much memory is available, choose About This Computer 
from the Apple menu, and refer to the memory size (listed in 
kilobytes) under “Largest Unused Block” (1,024K=1 MB).

❏ For Mac OS X, to see how much memory is available, choose About 
This Mac from the Apple menu.

❏ For Mac OS 8.6 to 9.x, the memory requirements above are for 
printing on Letter size paper. These requirements may vary 
depending on the size of the paper, the type of application you are 
using, and the complexity of the document that you want to print.

In addition to these system and memory requirements, you need 
20 MB of free hard disk space to install your printer software. To 
print, you also need extra hard disk space amounting to about 
twice the size of the file that you want to print.

Minimum System Requirements Recommended System

Mac OS 8.6 Mac OS 9.1 or later

15 MB of available memory

18 MB of available memory when 
background printing is turned on.

53 MB of available memory or more

87 MB of available memory or more 
when background printing is turned 
on.

Minimum System Requirements Recommended System

Mac OS X 10.1.3 Mac OS X 10.1.3 or later

128 MB RAM 256 MB RAM or more
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Using the Reference Guide and Photo Print 
Software Setup

Refer to the appropriate section below for the minimum system 
requirements necessary to use the Reference Guide and Photo Print 
Software Setup.

For Windows

For Macintosh

System Microsoft Windows® Millennium Edition, 98, 95, XP, 
2000, or Windows NT® 4.0

CPU Pentium 150 MHz processor for Windows Me

Pentium processor for Windows 98, 95, and NT 4.0

Pentium 233 MHz processor for Windows XP

Pentium 133 MHz processor for Windows 2000

Memory 32 MB RAM for Windows Me

16 MB RAM for Windows  98, 95, and NT 4.0

64 MB RAM for Windows XP and 2000

Hard disk space 7 MB to install the Reference Guide and Photo Print 
Software Setup

CD-ROM drive Double-speed
(quad-speed or faster recommended)

Display 640 × 480 pixel or 800 × 600 pixel resolution, with 
High Color (16 bit) or True Color (32 bit) setting

Browser Web browser 
(Microsoft Internet Explorer 4.0 or later 
recommended)

System Mac OS 8.6 to 9.x, Mac OS X 10.1.3 or later
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Memory 18 MB RAM (32 MB RAM or more recommended)

Hard disk space 7 MB to install the Reference Guide and Photo Print 
Software Setup

CD-ROM drive Double-speed
(quad-speed or faster recommended)

Display 640 × 480 pixel or 800 × 600 pixel resolution, with 
High Color (16 bit) or True Color (32 bit) setting

Browser Web browser 
(Microsoft Internet Explorer 4.0 or later 
recommended)
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Loading Single Sheets of Paper

Follow the steps below to load paper into the printer.

1. Lower the output tray and slide out the extension. Next, hold 
down the tab on the left edge guide and slide the guide so that 
the distance between the edge guides is slightly wider than 
the width of your paper.

2. Fan a stack of paper, then tap it on a flat surface to even the 
edges.

3. Load the stack of paper in the sheet feeder with the printable 
side up and the right edge of the paper resting against the 
right edge guide. Then, slide the left edge guide against the 
left edge of the paper. Make sure that the paper stack is loaded 
under the tabs inside the edge guides.

Note:
❏ Leave enough space in front of the printer for the paper to be 

fully ejected.

❏ Always load paper into the sheet feeder short edge first.

❏ Make sure that the paper stack is flush with or lower than the 
triangular load-limit mark on the edge guide.
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❏ Make sure that the paper is loaded under the tabs inside the edge 
guides.

Using Special Media

You can achieve good results with most types of plain bond paper. 
However, coated paper and glossy film provide superior 
printouts because they absorb less ink.

EPSON provides special media that are formulated for the ink 
used in EPSON ink jet printers. EPSON recommends using media 
distributed by EPSON to ensure high-quality results.

When loading special media distributed by EPSON, read the 
instruction sheets packed with the media first and keep the 
following points in mind.

c
Caution:
Cleaning sheets packaged with EPSON special media should not 
be used with this printer. The cleaning function performed by 
these sheets is not necessary with this type of printer, and the 
sheets could jam in the printer.
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Note:
❏ Load the media into the sheet feeder printable side up. See the 

instruction sheets packed with the media to determine which side is 
the printable side. Some types of media have cut corners to help 
identify the correct loading direction.

❏ If the paper is curled, flatten it or curl it slightly in the opposite 
direction before loading. Printing on curled paper may cause ink to 
smear on your printout.

Loading capacities for EPSON special media

Refer to the chart below to find the loading capacities for EPSON 
special media.

Media type Loading capacity

Premium Ink Jet Plain Paper Up to 120 sheets
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Storing EPSON Photo Paper

Return unused paper to the original package as soon as you finish 
printing. EPSON recommends storing your printouts in a 
resealable plastic bag. Keep them away from high temperature, 
humidity, and direct sunlight.

Loading Envelopes

Follow the steps below to load envelopes into the printer.

1. Lower the output tray and slide out the extension.

Bright White Ink Jet Paper Up to 120 sheets

Matte Paper-Heavy Weight Up to 20 sheets

Double Sided Matte Paper One sheet at a time

Archival Matte Paper Up to 20 sheets

DURABrite Photo Paper/
DURABrite Ink Glossy Photo 
Paper

Up to 20 sheets

Photo Paper Up to 20 sheets

Glossy Photo Paper Up to 20 sheets

Photo Quality Ink Jet Paper Up to 80 sheets

Photo Quality Ink Jet Cards Up to 30 cards

Premium Semigloss Photo Paper Up to 20 sheets

Ink Jet Transparencies Up to 20 sheets
Always place a sheet of plain paper 
under the stack of transparencies for 
support
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2. Hold down the tab on the left edge guide and position the 
guide so that the distance between the two edge guides is 
slightly wider than the width of your envelope.

3. Load envelopes short edge first with the flap side to the left, 
as shown in the illustration.

Note:
❏ The thickness of envelopes and their ability to fold vary widely. 

If the total thickness of the stack of envelopes exceeds 10 mm, 
press down on the envelopes to flatten them before loading. If 
print quality declines when a stack of envelopes is loaded, load 
one envelope at a time.

❏ You can load up to 10 envelopes at a time in the sheet feeder.

❏ Do not use envelopes that are curled or folded.

❏ Flatten the envelope flaps before loading.

❏ Flatten the loading edge of the envelope before loading.

❏ Avoid using envelopes that are too thin as they may curl during 
printing.
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Accessing the Printer Software for Windows

You can access the printer software from most Windows 
applications, from the Windows Start menu, or the taskbar.

When you access the printer software from a Windows 
application, the settings that you make apply only to the 
application you are using.

When you access the printer software from the Start menu or the 
taskbar, the settings that you make apply to all of your Windows 
applications.

Refer to the appropriate section below.

From Windows applications

Follow the steps below to access the printer software.

1. Click Print or Print Setup on the File menu.

2. In the dialog box that appears, click Printer, Setup, Options, 
Preferences, or Properties. (Depending on your application, 
you may need to click any one or a combination of these 
buttons.) The printer software starts.

From the Start menu

Follow the steps below to access the printer software.

1. For Windows XP, click start, Control Panel, then click 
Printers and Faxes. (If the Control Panel is in Category View, 
click Printers and Other Hardware, then click Printers and 
Faxes.)

For Windows Me, 98, 95, 2000, and NT 4.0, click Start, point 
to Settings, then click Printers.
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2. For Windows XP and 2000, select your printer, then click 
Printing Preferences on the File menu.

For Windows Me, 98, and 95, select your printer, then click 
Properties on the File menu.

For Windows NT 4.0, select your printer, then click 
Document Defaults on the File menu.

The printer software starts.

From the taskbar (For Windows XP, Me, 98, 95, and 2000)

Right-click the printer icon on the taskbar, then select Printer 
Settings.

Accessing the Printer Software for Mac OS 8.6 
to 9.x

These dialog boxes can be accessed as described below.

In addition, the dialog boxes below are accessed from the Print 
dialog box.

Dialog Box How to Access It

Print Click Print on the File menu of your application or click 
Options in the Page Setup dialog box.

Page Setup Click Page Setup on the File menu of your application.

Layout Click the  Layout icon button in the Print dialog box.

Utility Click the  Utility icon button in the Print or Page Setup 
dialog box.

Dialog Box How to Access It
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Accessing the Printer Software for Mac OS X

These dialog boxes can be accessed as described below.

Media Type Settings

The Media Type setting determines what other settings are 
available, so you should always make this setting first.

Refer to the corresponding media type under which it is grouped 
(shown in bold). For some media, there are several Media Type 
settings from which to choose.

Background 
Printing

Click the  Background Printing icon button in the Print 
dialog box.

Preview Click the  Preview icon button in the Print dialog box 
and then click Preview.

Save File Click the  Preview icon button in the Print dialog box 
until the Print button changes into the Save File button, 
then click the Save File button.

Dialog Box How to Access

Page Setup Click Page Setup on the File menu of your application.

Print Click Print on the File menu of your application.

EPSON Printer 
Utility

Double-click the EPSON Printer Utility icon in the 
Applications folder in Macintosh HD. Select your 
printer from the Printer List, then click OK.

For Mac OS X 10.3 or later, open the Applications folder 
on your hard drive, then open the Utilities folder and 
double-click the Print Center icon. Select any one of 
this printer’s drivers from the list, then click the 
Configure button. Select your printer from the Printer 
List that appears, then click OK.
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Plain Paper/Bright White Paper

Matte Paper - Heavyweight

DURABrite Photo Paper

Plain paper

Envelopes

EPSON Premium Ink Jet Plain Paper (A4) S041214

EPSON Bright White Ink Jet Paper (A4) S041442

EPSON Matte Paper-Heavyweight (A4) S041256
S041258
S041259

EPSON Matte Paper-Heavyweight (Letter) S041257

EPSON Matte Paper-Heavyweight (8 × 10”) S041467

EPSON Double Sided Matte Paper (A4) S041569
S041570

EPSON Double Sided Matte Paper (Letter)

EPSON Archival Matte Paper (A4)

S041568

S041342

EPSON Photo Quality Ink Jet Paper (Letter) S041062

EPSON Photo Quality Ink Jet Card (A6) S041054

EPSON Photo Quality Ink Jet Card (5 × 8") S041121

EPSON Photo Quality Ink Jet Card (8 × 10") S041122

DURABrite Photo Paper (A4) S041732
S041733

DURABrite Photo Paper (100 × 150 mm) S041735
S041736

DURABrite Ink Glossy Photo Paper (Letter) S041731

DURABrite Ink Glossy Photo Paper (4 × 6”) S041734
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Photo Papers or Generic Photo Paper

Ink Jet Transparencies 

Note:
The availability of special media varies by location. For the latest 
information on media available in your area, contact EPSON customer 
support web site.

Making User Defined Paper Sizes for Windows

Defining a custom paper size

You can define a custom paper size and add it to the list. 

EPSON Photo Paper (A4) S041140

EPSON Photo Paper (4 × 6") S041134

EPSON Photo Paper (100 × 150 mm) S041255

EPSON Glossy Photo Paper (Letter) S041141
S041649
S041271
S041272

EPSON Glossy Photo Paper (4 × 6") S041134
S041671

EPSON Premium Semigloss Photo Paper (A4) S041332

EPSON Premium Semigloss Photo Paper (Letter) S041331

EPSON Ink Jet Transparencies (A4)

EPSON Ink Jet Transparencies (Letter)

S041063

S041064
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1. Select User Defined as the Size setting. The User Defined 
Paper Size dialog appears.

2. Type a name for your paper size in the Paper Size Name box.

3. Choose either cm or inch as the Unit setting.

4. Specify the width and height for your paper size. The range 
of available size is shown under the each text box.
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5. Click Save, then click OK to return to the Main menu.Your 
new user-defined paper size name appears as the Size setting.

To delete a custom paper size from the list, open the User Defined 
Paper Size dialog and select the user-defined paper size name you 
want to delete. Then, click Delete.

Making User Defined Paper Sizes for Mac OS 
8.6 to 9.x

Defining a custom paper size

You can define a custom paper size. To do so, you can either create 
a new paper size, or base your custom paper size on a pre-existing 
paper size. Refer to the appropriate section below.
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Creating a new paper size

If the appropriate paper size is not included in the Paper Size list 
in the Page Setup dialog box, follow the steps below to define a 
new custom paper size.

1. In the Page Setup dialog box, click Customize. The following 
dialog box appears.

2. To define a new paper size, click New. The dialog box now 
allows you to enter a name for the new size.

3. Type a unique name for the paper size in the Paper Size list.

4. Choose either cm or inch as the Unit setting.
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5. Enter the width and the height of your paper by typing the 
values in the appropriate text boxes.

6. Specify the margins by typing in the Margin text boxes or by 
manipulating the margins in the preview image.

7. Click OK to return to the Page Setup dialog box.

You can define up to 100 paper sizes. The paper size names you 
create will appear in the Paper Size list.

To delete a custom paper size, click Customize, select the paper 
size from the list in the Custom Paper dialog box, then click 
Delete.

Copying a pre-existing paper size to use as a template

Follow the steps below to copy an existing paper size to use as a 
template.

1. Select the existing paper size to be copied and click Copy.

2. Choose either cm or inch as the Unit setting.

3. Specify the margins by typing in the Margin text boxes or by 
manipulating the margins in the preview image.

4. Click OK.
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Glossary

How to Print

Introduction
Printing Text and Web Pages

Handling single sheets of paper
Driver settings for Windows
Driver settings for Mac OS 8.6 to 9.x
Driver settings for Mac OS X

Printing Photos
Handling single sheets of paper
Driver settings for Windows
Driver settings for Mac OS 8.6 to 9.x
Driver settings for Mac OS X

Printing on Envelopes
Handling envelopes
Driver settings for Windows
Driver settings for Mac OS 8.6 to 9.x
Driver settings for Mac OS X

Various Printing Options

Introduction to Various Printing Options
Borderless Printing

Compatible media
Preparing the print data
Loading paper
Driver settings for Windows
Driver settings for Mac OS 8.6 to 9.x
Driver settings for Mac OS X

Double-Sided Printing
Standard double-sided printing for Windows
Standard double-sided printing for Macintosh
Folded Booklet double-sided printing for Windows
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Folded Booklet double-sided printing for Macintosh
Fit to Page Printing

Loading paper
Driver settings for Windows
Driver settings for Mac OS 8.6 to 9.x

Pages Per Sheet Printing
Loading paper
Driver settings for Windows
Driver settings for Mac OS 8.6 to 9.x
Driver settings for Mac OS X

Poster Printing
Loading paper
Driver settings for Windows
Driver settings for Mac OS 8.6 to 9.x
How to make a poster from your printouts

Watermark Printing
Loading paper
Printing the watermark for Windows
Printing the watermark for Mac OS 8.6 to 9.x
Creating your own watermark for Windows
Creating your own watermark for Mac OS 8.6 to 9.x

Printer Software Settings

For Windows

Printer Software Introduction
Making Settings on the Main Menu

Making the Basic settings
Making the Advanced settings

Making Settings on the Page Layout Menu
Making Settings on the Maintenance Menu

EPSON Status Monitor 3
Nozzle Check
Head Cleaning
Print Head Alignment
Ink Cartridge Replacement
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Speed & Progress
Getting Information Through Online Help

Accessing help from your application
Accessing help from the Windows Start menu

For Mac OS 8.6 to 9.x

Printer Software Introduction
Page Setup Dialog Box
Print Dialog Box

Basic settings
Advanced settings
Setting the print time
Previewing your printout
Saving spool data as a file

Layout Dialog Box
Printer Utilities
Getting Information Through Online Help

For Mac OS X

Printer Software Introduction
Page Setup Dialog Box

Page Setup dialog box settings
Print Dialog Box

Print dialog box settings
EPSON Printer Utility

EPSON printer utility functions

Replacing Ink Cartridges

Replacing an Empty Ink Cartridge
Using the printer's control panel buttons
Using the EPSON Status Monitor

Replacing an Ink Cartridge
Using the printer’s control panel buttons
Using the Printer Utilities (for Windows)

Checking the Ink Supply
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For Windows
For Macintosh

Improving Print Quality

Checking the Printer Status
For Windows
For Macintosh

Checking the Print Head Nozzles
Using the Nozzle Check utility
Using the control panel buttons

Cleaning the Print Head
Using the Head Cleaning utility
Using the control panel buttons

Aligning the Print Head
For Windows
For Mac OS 8.6 to 9.x
For Mac OS X

Problem Solver

Diagnosing the Problem
Error indicators
EPSON Status Monitor
Running a printer operation check

Print Quality Problems
Horizontal banding
Vertical misalignment or banding
Incorrect or missing colors
Blurry or smeared printout

Printout Problems Not Related to Print Quality
Incorrect or garbled characters
Incorrect margins
Inverted image
Blank pages print
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Printout has smears
Printing is too slow

Paper Does Not Feed Correctly
Paper does not feed
Multiple pages feed
The paper jams
Paper improperly loaded
Paper is not ejected fully or is wrinkled

Printer Does Not Print
All lights are off
Lights came on and then went out
Only the power light is on
The error light is flashing or on
Error light is on and power light is flashing

Print Head Carriage Problem
Correcting USB Problems

USB connections
Windows operating systems
Printer software installation

Cancelling Printing
Using the control panel buttons
For Windows XP, 2000, and NT 4.0
For Windows Me, 98, and 95
For Macintosh

Customer Support

Technical Support Web Site
Contacting Customer Support

Other Information

Setting Up Your Printer on a Network
For Windows XP, 2000, and NT 4.0
For Windows Me, 98, and 95
For Mac OS 8.6 to 9.x
For Mac OS X
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Increasing the Print Speed
General tips
Using the Speed & Progress dialog box (Windows only)
Using Port Configuration (Windows NT 4.0 only)

Updating and Uninstalling Software
Updating to Windows Me or 98
Updating the printer software in Windows Me, XP, 2000, or 

NT 4.0
Uninstalling the printer software
Uninstalling the Reference Guide

Cleaning the Printer
Transporting the Printer
Printer Parts and Control Panel Functions

Printer Parts
Control panel

Options and Consumable Products
Options
Consumable products

Exif Print
Effectiveness
How to use

Printer Specifications

Printing
Paper

Paper specifications
Printable area

Ink Cartridges
Black ink cartridge
Color ink cartridge

Mechanical
Electrical
Environmental
Standards and Approvals
System Requirements

Using the printer
Using the Reference Guide and Photo Print Software Setup

Loading Single Sheets of Paper
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Using Special Media
Loading capacities for EPSON special media
Storing EPSON Photo Paper

Loading Envelopes
Accessing the Printer Software for Windows
Accessing the Printer Software for Mac OS 8.6 to 9.x
Accessing the Printer Software for Mac OS X
Media Type Settings
Making User Defined Paper Sizes for Windows

Defining a custom paper size
Making User Defined Paper Sizes for Mac OS 8.6 to 9.x

Defining a custom paper size
Index
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Index

A

Additional Drivers, 273
Advanced settings

Macintosh, 121
Windows, 96

Automatic setting
Macintosh, 119

B

Background printing, 128, 177
Borderless printing, 32
Buttons, 302

C

Cables, 305
Cleaning

printer, 296
print head, 184

Color Controls
Macintosh, 124
Windows, 99

Color Management
Macintosh, 124
Windows, 99

Consumables, 305
Contacting EPSON, 227
Control panel, 302
Customer support, 227
Custom paper size, 336
Custom Settings dialog box

Macintosh, 127
Windows, 101

D

DMA transfer, 288
Double-Sided printing, 40
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E

Edge guides, 302
Envelopes, 316
EPSON MonitorIV, 177
EPSON Spool Manager, 171
EPSON StatusMonitor (Macintosh), 135
EPSON Status Monitor 3 (Windows), 107
Error Indicators, 195
Error notification

Windows, 111
Exif Print, 307

F

Fit to page printing, 57

G

Gamma
Macintosh, 124
Windows, 99

Glossary, 1

H

Head Cleaning, 184

I

Ink cartridge clamps, 302
Ink cartridges, 305

Replacing, 149
Specifications, 317

Interface cables, 305

L

Layout dialog box (Macintosh), 133
Lights, 303

M

Main menu (Windows), 90
Maintenance Menu (Windows), 106
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Media
Media type settings, 334
Using special media, 328

Monitoring preferences, 111
Multi-page printing

Macintosh, 134
Windows, 104

N

Network printing
Mac OS 8.6 to 9.x, 279
Mac OS X, 282
Windows Me, 98, and 95, 275
Windows XP and 2000, 271

Nozzle checking, 180

O

Online help
Macintosh, 136
Windows, 112

Options, 305
Output tray, 301
Output tray extension, 301

P

Page Layout Menu (Windows), 103
Page Setup dialog box (Macintosh), 116
Page Setup dialog box (Mac OS X), 138
Pages per sheet printing, 61
Paper, 327

Specifications, 311
Paper jam, 209
Paper support, 301
PhotoEnhance settings

Macintosh, 120, 124
Windows, 100

Poster printing, 69
Power button, 302
Preview feature

Macintosh, 129
Windows, 92

Printable area specifications, 315



352

R4CD000_UK
html.bk Rev. E
HTML.IX A5 size
6/10/03

L Proof Sign-off:
S.Kodama CRE Kawakami
M.Otsuka
editorname

Print dialog box (Macintosh), 118
Print dialog box (Mac OS X), 139
Printer

cleaning, 296
transporting, 298

Printer cover, 301
Printer parts, 301
Print head, 302

alignment, 192
cleaning, 184
nozzle checking, 180

Print Head Alignment utility, 192
Printing tips, 169, 170
Print speed, increasing, 285
Print time setting, 128
Progress meter, 169

R

Reduce/Enlarge setting
Macintosh, 117
Windows, 104

Roll paper button, 302

S

Saving settings
Macintosh, 127
Windows, 101

Sheet feeder, 301
Specifications, 311

electrical, 319
ink cartridges, 317
mechanical, 319
paper, 311
printing, 311
standards and approvals, 320, 321

Speed & Progress settings
Windows, 287

Spool Manager, 171
Status Monitor

Windows, 171
System Requirements, 321, 322, 324
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T

Technical support, 227

U

Uninstalling the driver, 293
Updating the driver, 293
Utilities

Macintosh, 134, 147
Windows, 105

W

Watermark printing, 79
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Welcome to the EPSON Reference Guide

This software Reference Guide is your on-screen guide to your 
EPSON STYLUS C84 Series printer. By clicking the links on the 
left side of this screen, you can get information on the following 
topics.

How to Print

Guides you through the basic procedures for different kinds of 
everyday printing

Various Printing Options

Guides you through procedures for using various printing 
options

Printer Software Settings

Introduces the printer software

Replacing Ink Cartridges

Explains how to replace the ink cartridges

Improving Print Quality

Explains ways of achieving better print quality

Problem Solver 

Provides solutions to problems you may encounter while printing

Other Information

Contains detailed information about your printer

Copyrights and Trademarks
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Reference Guide Help

Finding your way around

This Reference Guide employs links to make navigation simpler. 
When you move the cursor over a link, it changes to a hand icon. 
You can then click the link to access a related topic or more 
detailed information.

Links in the body of this guide appear as colored or underlined 
text. In addition, the following navigational aids are included 
throughout the guide.

Table of contents Use the table of contents on the left side of your 
screen to access all the topics in this guide. Click a 
main entry to view the topics under it, and click a 
topic to go to that page.

Home Click to return to the opening page.

Index Click to go to the Index.

Search Click to view the Search window, where you can 
locate topics by entering key words.

Glossary Click to go to the Glossary.

Safety Click to go to the Safety Instructions.

Back Click to return to the last page viewed.

Top Click to return to the top of the page you are 
currently on.

Previous Click to view the previous topic in the series.

Next Click to view the next topic in the series.
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Printing a topic

To print the page you are currently on, click Print on the File menu 
in your browser.

Solving display problems

If the screen displays incorrectly, try clicking the Refresh button 
(or the Reload button) in your browser.
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Copyrights and Trademarks

All rights reserved. No part of this publication may be 
reproduced, stored in a retrieval system, or transmitted in any 
form or by any means, electronic, mechanical, photocopying, 
recording, or otherwise, without the prior written permission of 
SEIKO EPSON CORPORATION. The information contained 
herein is designed only for use with this EPSON printer. EPSON 
is not responsible for any use of this information as applied to 
other printers.

Neither SEIKO EPSON CORPORATION nor its affiliates shall be 
liable to the purchaser of this product or third parties for damages, 
losses, costs, or expenses incurred by the purchaser or third 
parties as a result of accident, misuse, or abuse of this product or 
unauthorized modifications, repairs, or alterations to this 
product, or (excluding the U.S.) failure to strictly comply with 
SEIKO EPSON CORPORATION's operating and maintenance 
instructions.

SEIKO EPSON CORPORATION shall not be liable for any 
damages or problems arising from the use of any options or any 
consumable products other than those designated as Original 
EPSON Products or EPSON Approved Products by SEIKO 
EPSON CORPORATION.

SEIKO EPSON CORPORATION shall not be held liable for any 
damage resulting from electromagnetic interference that occurs 
from the use of any interface cables other than those designated 
as EPSON Approved Products by SEIKO EPSON 
CORPORATION.

EPSON® is a registered trademark and EPSON Stylus™ is a 
trademark of SEIKO EPSON CORPORATION.

Microsoft® and Windows® are registered trademarks of 
Microsoft Corporation.
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Apple® and Macintosh® are registered trademarks of Apple 
Computer, Inc.

General Notice: Other product names used herein are for 
identification purposes only and may be trademarks of their 
respective owners. EPSON disclaims any and all rights in those 
marks.

Copyright © 2003 by SEIKO EPSON CORPORATION, Nagano, 
Japan.
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1. Home

2. Help

3. Glossary

4. Index

5. Top

6. Previous

7. Next

8. Back

9. Search

10. Enter a keyword and click Search:

11. This searches the index and returns a list of hits. The keyword 
is not case sensitive.

12. Search Results

13. Click the text in the right column to go to that section, or click 
the Back button for a new search.

14. Search results for keyword:

15. Reference Guide

16. Error: This function is not available on Macintosh.

17. NPD0101-00

18. Close

19. Safety
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This is a special product name for use with the printer driver. Please 
do not translate.

<EPAS.EID>

EPSON Stylus C84 Series

</EPAS.EID>
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This appears in the title bar of the main installer screen. This string is 
limited to 42 characters or less.

Reference Guide Setup

Manual name used in registry. Do not translate. 

The  string below is limited to a total of 30 characters or less, including 
spaces.

ESC84 Reference Guide

Product name used in registry.(Conforms to driver.) Do not translate.

EPSON Stylus C84 Series

This appears on the Start menu and in the Install/Uninstall list in 
Add/Remove Programs in the Windows Control Panel. 

The  string below is limited to a total of 30 characters or less, including 
spaces.

ESC84 Reference Guide

Default installation path for Windows (the path below follows 
Program Files). Do not translate.

EPSON\ESC84\REF_G

Default installation path for Macintosh. Do not translate.

EPSON STYLUS C84 Series:Reference Guide

Path of installation source file. Do not translate.

REF_G
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This is the first line of the message in the "installation folder" dialog 
box. This string is limited to 49 characters or less.

Setup will install the Reference Guide.

This is the second line of the message in the "installation folder" 
dialog box. This string is limited to 49 characters or less.

To install to the following folder, click OK. 

This is the label of the group box surrounding the folder path and 
Browse button in the "installation folder" dialog box. This string is 
limited to 42 characters or less.

Folder:

"Browse" button text. This string is limited to 9 characters or less.

Browse...

"OK" button text. This string is limited to 9 characters or less.

OK

"Cancel" button text. This string is limited to 9 characters or less.

Cancel

"Yes" button text. This string is limited to 9 characters or less.

Yes

"No" button text. This string is limited to 9 characters or less.

No



       3

RSupported guides:
Windows & Macintosh

Installer
Rev. 1.1
A5 size H_SETUP.mif
7/24/03

This message appears in the "folder selection" dialog box that 
appears if the user clicks the "Browse" button in the "installation 
folder" dialog box. This string is limited to 38 characters or less.

Enter or select a destination folder.

This is the first line of the message in the "progress indicator" box that 
appears during installation. This string is limited to 47 characters or 
less.

Installing the Reference Guide.

This is the second line of the message in the "progress indicator" box 
that appears during installation. This string is limited to 47 characters 
or less.

Please wait.

This appears on the progress indicator while installing (Mac OS Only). 
This string is limited to 47 characters or less.

Remaining files:

This appears on the progress indicator while installing (Mac OS Only). 
This string is limited to 47 characters or less.

Installing:

This message is displayed when installation is complete. This string 
is limited to 41 characters or less.

Reference Guide Setup is complete.

This message appears when confirming that the user wants to create 
a folder.

The folder does not exist. Do you want to create the folder?
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This appears in the title bar of the "uninstall" dialog box. This string is 
limited to 32 characters or less.

Uninstall Reference Guide

This message appears in the "uninstall" dialog box.

Are you sure you want to completely remove the Reference Guide 
and all of its components?

"OK" button in the "uninstall" dialog box. This string is limited to 9 
characters or less.

OK

"Cancel" button in the "uninstall" dialog box. This string is limited to 
9 characters or less.

Cancel

This is the first line of the message in the message box that appears 
while uninstalling. This string is limited to 41 characters or less.

Uninstalling the Reference Guide.

This is the second line of the message in the message box that 
appears while uninstalling. This string is limited to 41 characters or 
less.

Please wait.

This message appears when uninstall is complete. This string is 
limited to 31 characters or less.

Uninstall is complete.
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This is the first line of the error message that appears when there is 
not enough free space on the hard disk.

There is not enough free space on the disk.

This is the second line of the error message that appears when there 
is not enough free space on the hard disk. 

Increase the amount of free space or install to a folder on another 
disk.

This is the first line of the error message that appears when not able 
to write to the folder.

Unable to write to the folder.

This is the second line of the error message that appears when not 
able to write to the folder.

Make sure that you have write access to the folder.

This error message appears when not able to copy files.

Unable to copy files.

This error message appears when invalid characters are used in the 
folder name.

The folder name is invalid.

This message appears when the user cancels installation.

Setup canceled.

This message appears when other errors occur.

An error has occurred.
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This error message appears when a file required for installation does 
not exist.

Cannot find a file required for installation.

This message appears when uninstall is canceled.

Uninstall canceled.
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Safety Instructions

Read all of the instructions in this section before using your 
printer. Also, be sure to follow all warnings and instructions 
marked on the printer.

When setting up your printer

Observe the following when setting up the printer:

❏ Do not block or cover the vents and openings in the printer.

❏ Use only the type of power source indicated on the printer’s 
label.

❏ Use only the power cord that comes with this product. Use of 
another cord may result in fire or electric shock.

❏ This product’s power cord is for use with this product only. 
Use with other equipment may result in fire or electric shock.

❏ Be sure your AC power cord meets the relevant local safety 
standards.

❏ Connect all equipment to properly grounded power outlets. 
Avoid using outlets on the same circuit as photocopiers or air 
control systems that regularly switch on and off.

❏ Avoid electrical outlets controlled by wall switches or 
automatic timers.

❏ Keep the entire computer system away from potential sources 
of electromagnetic interference, such as loudspeakers or the 
base units of cordless telephones.

❏ Do not use a damaged or frayed power cord.
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❏ If you use an extension cord with the printer, make sure that 
the total ampere rating of the devices plugged into the 
extension cord does not exceed the cord’s ampere rating. Also, 
make sure that the total ampere rating of all devices plugged 
into the wall outlet does not exceed the wall outlet’s ampere 
rating.

❏ Do not attempt to service the printer yourself.

❏ Unplug the printer and refer servicing to qualified service 
personnel under the following conditions:

The power cord or plug is damaged; liquid has entered the 
printer; the printer has been dropped or the cabinet damaged; 
the printer does not operate normally or exhibits a distinct 
change in performance.

❏ If you plan to use the printer in Germany, the building 
installation must be protected by a10 or 16 amp circuit breaker 
to provide adequate short-circuit protection and over-current 
protection for this printer.

Note for German-speaking users:
Bei Anschluss des Druckers an die Stromversorgung muss 
sichergestellt werden, dass die Gebäudeinstallation mit einer 10 A- 
oder 16 A-Sicherung abgesichert ist.

When choosing a place for the printer

Observe the following when choosing a place for the printer:

❏ Place the printer on a flat, stable surface that extends beyond 
the base of the printer in all directions. If you place the printer 
by the wall, leave more than 10 cm between the back of the 
printer and the wall. The printer will not operate properly if 
it is tilted at an angle.
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❏ When storing or transporting the printer, do not tilt it, stand 
it on its side, or turn it upside down. Otherwise, ink may leak 
from the cartridges.

❏ Leave enough space in front of the printer for the paper to be 
fully ejected.

❏ Avoid places subject to rapid changes in temperature and 
humidity. Also, keep the printer away from direct sunlight, 
strong light, or heat sources.

❏ Avoid places subject to dust, shock, or vibration.

❏ Leave enough room around the printer to allow for sufficient 
ventilation.

❏ Place the printer near a wall outlet where the plug can be 
easily unplugged.

Note for French-speaking users:
Placez l’imprimante près d’une prise de contacte où la fiche peut être 
débranchée facilement.

When using the printer

Observe the following when using the printer:

❏ Do not insert objects through the slots in the printer.

❏ Take care not to spill liquid on the printer.

❏ Do not put your hand inside the printer or touch the ink 
cartridges during printing.

❏ Do not move the print head by hand; otherwise, you may 
damage the printer.



4

(EPL-4000, etc.)
(Guide Name Variable)Rev. 
1.0
H_SAFE.mif A5 size
7/24/03

L Proof Sign-off:
tantoname
leadername
editorname

❏ Always turn the printer off using the P power button. Do not 
unplug the printer or turn off the power to the outlet until the 
P power light goes out.

❏ Before transporting the printer, make sure that the print head 
is in the home (far right) position and the ink cartridges are 
in place.

❏ Leave the ink cartridges installed. Removing the cartridges 
can dehydrate the print head and may prevent the printer 
from printing.

When handling the ink cartridges

Observe the following when handling the ink cartridges:

❏ Keep ink cartridges out of the reach of children. Do not allow 
children to drink from or otherwise handle the cartridges.

❏ Shake the new ink cartridge four or five times before opening 
the packages.

❏ Do not shake the ink cartridge after opening the package; this 
can cause leakage.

❏ Be careful when you handle used ink cartridges, as there may 
be some ink remaining around the ink supply port. If ink gets 
onto your skin, wash the area thoroughly with soap and 
water. If ink gets into your eyes, flush them immediately with 
water. If discomfort or vision problems remain after a 
thorough flushing, see a doctor immediately.

❏ Do not remove or tear the label on the cartridge; this can cause 
leakage.

❏ Install the ink cartridge immediately after you remove it from 
its package. If you leave a cartridge unpacked for a long time 
before using it, normal printing may not be possible. 
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❏ Do not use an ink cartridge beyond the date printed on the 
cartridge carton: otherwise, it may result in reduced print 
quality. For best results, use up the ink cartridges within six 
months of first installing them.

❏ Do not dismantle the ink cartridges or try to refill them. This 
could damage the print head.

❏ After bringing an ink cartridge inside from a cold storage site, 
allow it to warm up at room temperature for at least three 
hours before using it.

❏ Store ink cartridges in a cool, dark place.

❏ Do not touch the green IC chip on the back of the cartridge. 
Doing so may prevent normal operation and printing.

❏ The IC chip on this ink cartridge retains a variety of cartridge-
related information, such as the amount of ink remaining, so 
that the cartridge may be removed and reinstalled freely. 
However, each time the cartridge is inserted, some ink is 
consumed because the printer automatically performs a 
reliability check.

❏ If you remove an ink cartridge for later use, protect the ink 
supply area from dirt and dust and store it in the same 
environment as the printer. A valve in the ink supply port 
makes covers or plugs unnecessary, but the ink may stain 
items that come into contact with this area of the cartridge. 
Do not touch the ink supply port or the surrounding area.

❏ Store ink cartridge with its label facing upward. Do not store 
cartridge upside down.

ENERGY STAR® Compliance

As an ENERGY STAR® Partner, EPSON has determined that this 
product meets the ENERGY STAR® guidelines for energy 
efficiency.
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The International ENERGY STAR® Office Equipment Program is 
a voluntary partnership with the computer and office equipment 
industry to promote the introduction of energy-efficient personal 
computers, monitors, printers, fax machines, copiers, and 
scanners in an effort to reduce air pollution caused by power 
generation.

Information for United Kingdom Users

Use of options

EPSON (UK) Limited shall not be liable against any damages or 
problems arising from the use of any options or consumable 
products other than those designated as Original EPSON 
Products or EPSON Approved Products by EPSON (UK) Limited.

Safety information

w
Warning:
Refer to the rating plate for the voltage and check that the 
appliance voltage corresponds to the supply voltage.

Important: The wires in the mains lead fitted to this appliance 
are coloured in accordance with the following code:

Blue — Neutral
Brown — Live

If you have to fit a plug:
As the colours of the mains lead of this appliance may not match 
the coloured markings used to identify the terminals in a plug, 
please observe the following:
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❏ The blue wire must be connected to the terminal in the plug 
marked with the letter N.

❏ The brown wire must be connected to the terminal in the plug 
marked with the letter L.

❏ If the plug is damaged, replace the cord set or consult a 
qualified electrician.

❏ Replace fuses only with fuses of the correct size and rating.

Warnings, Cautions, and Notes

w
Warnings
must be followed carefully to avoid bodily injury.

c
Cautions
must be observed to avoid damage to your equipment.

Notes
contain important information and useful tips on the operation of your 
printer.
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<As_test.htm>Test Printing

Make a test print of this page to compare the printout of the two 
images below with the images on the previous page. Before 
printing, make sure paper is loaded and the printer is on.

Follow the steps below to print a test page:

1. Click Print on the File menu of the browser you are currently 
using.

2. Make sure that your printer is selected as the default printer, 
and click OK or Print.

3. Make sure the test print illustration on the printout prints 
properly.

4. Click Back to go back to the previous page.

</As_test.htm>


